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Read This First

This Maintenance Information (MI) is intended for use only by trained, IBM service personnel.

About This Information

* Go to the Maintenance Starting Point on page 1-1 to begin all service procedures.
» Examples of screens that are depicted in this Ml may appear differently for you.

* The glossary, beginning on page , provides terms and abbreviations that are used throughout this
M.

What's New In This 29th Edition (November 2012)

Revision bars (1), like the one to the left of this text, appear next to information that has been added or
changed since the previous edition.

Changes in this 29th Edition:

* In Chapter 2, added new Security Settings and LDAP policy information and figures.

» In Chapter 2, Figure 2-94, Console Settings to display the new Security Settings menu
* In Chapter 3, AOS relay server list was changed. Updated Table 3-5

* In Chapter 3, New subtopics added under "Fix Acquisition"

Send Us Your Feedback

Send us your comments about this Ml by e-mail to starpubs @us.ibm.com. When sending your comments,

be sure to include:

» Exact publication title

* Form number, or part number and EC level (located on the back cover)
* Page numbers to which you are referring

© Copyright IBM Corp. 2002, 2012
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Preface

This manual is for use by service personnel who intend to install, remove, diagnose, repair, or test the IBM
TS3000 System Console.

Related Information

Additional information related to the system console is available in the following publications:
* IBM Virtualization Engine TS7700 Information Center

* IBM Virtualization Engine TS7700 Installation Roadmap for use with IBM System Storage TS3500, IBM
3584 Tape Library

» Systems Safety Notices (formerly known as "eServer Safety Notices"), G229-9054

IBM 3584 Information

Additional information related to the IBM 3584 Automated Tape Library is available in the following
publications:

» IBM System Storage TS3500 Tape Library with ALMS Introduction and Planning Guide, GA32-0593
» IBM System Storage TS3500 Tape Library with ALMS Operator Guide, GA32-0594

» IBM System Storage TS3500 Tape Library SCSI Reference, GA32-0561

* IBM System Storage TS3500 Tape Library (35684) Maintenance Information

IBM 3494 Automated Tape Library Information

Additional information related to the IBM 3494 Automated Tape Library is available in the following
publications:

* IBM 3494 Tape Library Operator's Guide, GA32-0449

* IBM 3494 Tape Library Operator's Quick Reference, GX35-5049

* IBM 3494 Tape Library Operator's Introduction and Planning Guide, GA32-0448
» IBM 3494 Tape Library Maintenance Information

IBM 3953 Information

Additional information related to the IBM 3953 is available in the following publications:

* |IBM System Storage 3953 Tape System Introduction and Planning Guide, GA32-0557
* IBM System Storage 3953 Library Manager L0O5 Operator Guide, GA32-0558

* IBM 3953 Installation Road Map

IBM 3592 Tape Controller

Additional information related to the IBM 3592 Tape Controller is available in the following publications:
* IBM TotalStorage 3592-C07 Installation Roadmap Guide

* http://publib.boulder.ibm.com/infocenter/etc/serv/index.jsp

* http://publib.boulder.ibm.com/infocenter/etc/cust/index.jsp

IBM 3592-C06 Tape Controller

Additional information related to the IBM 3592 Tape Controller is available in the following publications:

* IBM System Storage TS1120 Tape Controller,3592 C06 Maintenance Information,IBM 3592 Model C06
(M)

* IBM System Storage 3592 Tape Drives and TS1120 Controller Operator Guide 3592 Models J1A, E05,
E06, EU6, E07, J70 and C06 (Op Guide)
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* |IBM System Storage 3592 Tape Drives and TS1120 Controller Introduction and Planning Guide 3592
Models J1A, E05, E06, EU6, E07, J70 and C06 (IPG)

IBM System Storage TS1120, TS1130, and TS1140 Tape drives

Additional information related to the IBM System Storage TS1120. TS1130, and TS1140 is available in the
following publications:

* |IBM System Storage 3592 Tape Drives and TS1120 Controller Introduction and Planning Guide 3592
Models J1A, E05, E06, EU6, E07, J70 and C06 (IPG)

IBM System p (AIX) Information

See ['Web Site Information’|for access to the latest System p information and publications.

IBM 7133 SSA Disk Subsystem Information

Additional information related to the 7133 SSA Disk Subsystem and software is available in the following
publications:

» 7133 SSA Disk Subsystem: Operator Guide, GA33-3259

» 7133 SSA Disk Subsystem: Service Guide, SY33-0185

» 7133 Models D40 and T40 Serial Disk Systems: Service Guide, GY33-0192

» 7133 Models D40 and T40 Serial Disk Systems: D40 Installation Guide, GA33-3279

» 7133 Models 010 and 020 SSA Disk Subsystem Installation Guide, GA33-3260

* Adapters, Devices, and Cable Information for Micro Channel Bus Systems, SA23-2764
» SSA Adapters: User's Guide and Maintenance Information, SA33-3272

Device Drivers Information
* IBM Tape Device Drivers Installation and User's Guide, GC27-2130

Web Site Information

Table 1. Information Web Site URLs
IBM® RMSS product manuals http://www.storage.ibm.com/hardsoft/tape/pubs/pubs3592.html
Minimum microcode requirements http://www-03.ibm.com/servers/storage/tape/drives/

FIPS PUB 140-2, Security Requirements http://www.itl.nist.gov/fipspubs/
for Cryptographic Modules

RMSS PFE home page http://snjint02.sanjose.ibm.com/tape/tapetec.nsf

Fix Central http://www.ibm.com/support/fixcentral

Device drivers ftp:/ftp.software.ibm.com/storage/devdrvr/Doc/

Terms not found in Glossary www-01.ibm.com/software/globalization/terminology/index.jsp
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Chapter 1. Maintenance Starting Point

Complete this task before starting any maintenance activity.

Attention: Some system console keyboards include an integral USB port. Do not use this USB port
while using the system console.

Before beginning any maintenance activity using the IBM TS3000 System Console (System Console or
TSSC, for short), you must determine the proper microcode (code) level of the System Console.

1. Go to the TS3000 System Console Screen Login screen and determine the code level.
2. Refer to the TSSC documentation for your symptom or reason.

TS3000 System Console

Code Level
Listed

I1BM TS3000 System Console V4.0.0

Login: |[

Password: |

D Copyright IEM Corporation 2004. All Fights Resarved. 18M ks a registered Trademark of 1BM Corporation in e United States or
Ussrs Restrictad Rights - Use, duplication, or disclosuras restricted by GS& ADP Schadule with the IEM Corporation.

a140r303

Figure 1-1. System Console Login Screen. - Code Level Listed

Quick Reference Table

Table 1-1. Maintenance Starting Point - Quick Reference Table. For Code Level V3.0.0 and Above

If you are here to ... . . . then go to this section:
Install new System Console [‘Performing Installation” on page 2-7]
Configure remote system “Tape System Call Home Setup for VTS, VTC, and Tape Controllers” on page 2-21|

“Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise Library|
Controller” on page 2-26)|

Configure System Console [“Configuration” on page 2-36|

Authenticate login (password  |[‘Login Options” on page 2-37]

broadcast)

Load code [‘Code Load/Hard Drive Rebuild” on page 3-60|
Rebuild hard drive [‘Code Load/Hard Drive Rebuild” on page 3-60|
Repair the System Console [‘System Console Repair” on page 4-1|
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Table 1-1. Maintenance Starting Point - Quick Reference Table (continued). For Code Level V3.0.0 and Above

If you are hereto ...

. . . then go to this section:

Restore configuration data

[‘Restoring Configuration Data” on page 2-83|

Setup for remote data
monitoring

|“Setup for Remote Data Monitoring (VTS, VTC, A60, J70, C06)” on page 2-92|

——OR--

“Setup for Remote Data Monitoring (3494 ATL or 3953 Enterprise Library Controller)}

on page 2-9(_3]

Telnet to an attached tape
system

[‘Telnet to Attached Tape System” on page 3-1|

Access system remotely

FRemote Access Using NetTerm” on page 3-19|

Broadcast control unit code

[‘Remote Code Broadcast By Using the Web Interface” on page 3-8|

Broadcast tape drive code

[‘Tape Drive Code Broadcast From Web Interface” on page 3-16|

Set date and time

[‘Setting Console Date and Time” on page 2-85

Notes:

» If you are here to isolate or repair a PC problem, refer to the Maintenance Information (MI) for your PC. A softcopy
of the IBM Ml for the PC may be found on the Documents CD which shipped with the System Console.

» For the latest System Console information, go to the PFE website at:
http://snjint02.sanjose.ibm.com/tape/tapetec.nsf/pages/TSSCinfo

Console Configuration Utility Screen Menu Tree
provides a graphic view of the relationship of Console Configuration Utility screen menu items.

These items appear on the screen shown in |Figure 2-54 on page 2-40

Table 1-2. Console Configuration Utility Screen Menu Items

Function Name

Screen Selection and Location

Attached Systems

[Figure 2-55 on page 2-41|

Backup/Restore
» Backup Console Configuration Data  |Figure 2-113 on page 2-81
* Restore Console Configuration Data » |Figure 2-115 on page 2-84

Call Home Queue

[Figure 3-28 on page 3-23|

Call Home Settings

* General Settings

* Location Settings

* Phone Settings

* Machine Settings

» Disposition Settings

« [Figure 2-102 on page 2-71
» [Figure 2-104 on page 2-74
 |Figure 2-105 on page 2-74
 |Figure 2-106 on page 2-75
 |Figure 2-107 on page 2-76

Console Settings
* |IP Settings
» Custom Firewall Settings

« |Figure 2-94 on page 2-61|
« |Figure 2-101 on page 2-70|

Console Status

» Console Message File

* Test RETAIN Connection
¢ Console VPD

» Test ECC Connectivity

« |Figure 3-73 on page 3-54|
« |Figure 2-120 on page 2-88|
« |Figure 3-77 on page 3-56)|
« |Figure 2-122 on page 2-89

Console Time

[Figure 2-117 on page 2-86|

Fix Acquisition

[‘Fix Acquisition” on page 3-86|

Modem Transmission

Query Modem Transmission (not shown)

Network Information

(Not shown)
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Table 1-2. Console Configuration Utility Screen Menu ltems (continued)

Function Name

Screen Selection and Location

Offload User Files

[Figure 3-38 on page 3-31|

PE Packages
« System Console PE Package
» Subsystem Log Retrieval

* |Figure 3-65 on page 3-49

 |Figure 3-67 on page 3-50

System Interfaces

[Figure 3-94 on page 3-74|

System tools

* [‘Remote Code Broadcast By Using the Web Interface” on page 3-§

* [‘Tape Drive Code Broadcast From Web Interface” on page 3-16

« [‘Managing InfoCenter From Web Interface” on page 3-74|
« [‘Adding PFE Execs From Web Interface” on page 3-80|

Chapter 1. Maintenance Starting Point
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Chapter 2. Installation

Introduction

The System Console can provide remote support for as many as forty-three attached tape systems.
Remote support capabilities of the System Console, in conjunction with tape systems, include:

» Call Home problem reporting capability with staged, error-specific Data Gathering for support

» Call-in capability with authenticated access (via modem) including file transfer and multiple connections
with attached systems

» Simultaneous call home and call-in capability using dual modems (not available with IBM 3953 models)
» Automatic wellness checking for attached systems

+ Ability to defer certain types of call home activity to specific business hours

» Automatic archival of log files for most attached tape systems for subsequent support reference

» Automatic download and storage of new tape drive code images via modem connection with IBM
Remote Technical Assistance Information Network (RETAIN)

Additionally, the System Console provides a convenient focal point for local service activities within the
data center. The System Console is attached via 100 Mbps ethernet to each tape system. Many tape
system service functions may actually be performed at the console. The System Console provides the
following local service tool applications:

» Ability to telnet to multiple tape systems and simultaneously perform multiple service tasks from the
System Console

» Graphic user interface for tape system and tape drive service diagnostic utilities

» Ability to broadcast control unit and tape drive code images to tape systems for subsequent activation
from the System Console

» Diagnostic tools for verifying communications with IBM RETAIN
» Graphic user interface for configuring, backing up, and restoring System Console settings

The System Console is available as Feature Code 2724 for use with 3592 C07, 3952 F05, 3584 L23/L53,
and 3958 AP1/DD5.

The data gathered during the call home process is available for IBM support personnel on the RMSS Call
Home Database at:

https://callhomedata.tucson.ibm.com

Overview

Use [Figure 2-1 on page 2-2| with [Table 2-1 on page 2-2|as a representation of a potential connection
scheme for the System Console.
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(TSSC)

System Console

NIC/LAN
Ethernet

H—

Figure 2-1. System Console Connection Diagram. Use with|Table 2-1

Table 2-1. System Console Components. Use with [Figure 2-1
6 Ethernet expansion FC 2714

1 Serial connector

2 Ethernet Switch FC 2722/2732

3 Cable supplied with FC 2722/2732
4 Cable supplied with FC 2715

5 Cable supplied with FC 2714

Tape System

Tape System

TS7700

7 Cable supplied with FC 2714
8 Second modem FC 2716 (not on all RMSS products)
9 Customer supplied Ethernet connection FC 2722/2732

Note: Outbound modems can be replaced with high-speed internet connections.

a69i0354

Feature Codes

Feature Code 2715 (Cable Attachment / Console Attachment)

» This Cable Attachment (console attachment) feature drives a single 15.2-m (50-ft) ethernet cable for
downstream-attached tape systems.

* For an IBM 7588, you will be shipped a four-port card and an ethernet cable.

Table 2-2. Current TSSC Feature Codes

3958 DD5 3958 AP1 3592 C07 3952 F05 3584 L23/D53
FC2704 26 Port FC2702 16 Port FC2704 26 Port FC2704 26 Port FC2704 26 Port
switch swtich switch switch switch

FC2724 TSSC M4
server

FC2724 TSSC M4
server

FC2724 TSSC M4
server

FC2724 TSSC M4
server

FC2724 TSSC M4
server

FC2734 External USB
Modem

FC2734 External USB
Modem

FC2734 External USB
Modem

FC2734 External USB
Modem

FC2734 External USB
Modem

FC5512 FC5512 FC5512 FC5512 FC5512
Monitor/Keybd/Mouse | Monitor/Keybd/Mouse | Monitor/Keybd/Mouse | Monitor/Keybd/Mouse | Monitor/Keybd/Mouse
2-2 |BM TS3000 System Console Maintenance Information — 29th Edition November 2012




The server you received may be one of the following types as shown below.

Internal
Power Serial 172.31.1.x  External ECC/Call Grid AOTM
connector connector Connection Home Connection Connection

©

S

\ . /L _— /
E 6@ E\E&gzaa © EEEIEEE@EEE?QEEEE

EEEEE:I=niliEEz]m[a] e m]r:])

AN

Video USB Modem USB Keyboard/Mouse

connector (or from optional KVM Switch)
(or from optional KVM Switch)

=l

a14or589

|
| Figure 2-2. Network Connection Diagram — x3250 M4, Type 2583 (FC 2704, FC 2734)

External ECC/Call
Home Connection

Internal
Serial 172.31.1.x Grid AOTM
connector Connection Connection  Modem

ay:

O‘EEEE © SE0SCEEEEEE (@ 65005080888 @ 5800
EEEEERIS I EEEmS=i[mvE]v]= =] apn S]=]= === S ) ]

al4orb44

connector connector

Figure 2-3. Network Connection Diagram — x3250 M3, Type 4252 Model PCJ (FC 2722, FC 2732)

Video
connector  Modem

H

= =
Grid AOTM Internal External ECC/Call  Serial Power §
Connection 172.31.1.x Home Connection connector connector w

Connection

Figure 2-4. Network Connection Diagram — 7946-PAR (FC 2722, FC 2732)

Grid AOTM Video
Connection connector Modem

[
Il
7 ﬁﬁ@ i
[Te]
; ¥
Internal 172.31.1.x  External Ecc/Call Home Serial Power E
Connection Connection connector connector

Figure 2-5. Network Connection Diagram — 7946-PAR (FC 2722, FC 2732)

Feature Code 2733 (TS3000 System Console Internal Modem)

This feature provides an internal modem and customer phone line (wall) adapter based on country order.

Chapter 2. Installation ~ 2-3



** Feature Codes (Withdrawn) **

Feature Code 2732 (Rack Mount TS3000 System Console. Available via Factory or MES)

This feature provides the enhanced rack-mountable TS3000 System Console, an Ethernet switch, an
Ethernet cable, KVM cables, console kit, and connectors for connection of one machine to an IBM
supplied internal or USB modem to enable remote enhanced service. This feature is an enhanced
replacement of the IBM TS3000 System Console for Service (#2730). It includes console upgrade
previously provided as FC #2719 (Memory upgrade to 4 GB total RAM and a second Ethernet card for the
Service Console to allow redundant connections into the service network). This feature applies to 3958,
3593, and 3592 machine types.

Feature Code 2714 (LAN Attachment Expansion / Console Expansion)

* The LAN Attachment Expansion (Console Expansion) feature is required when additional LAN ports are
required. Uplink ports are used to connect the network switches.

Note: This feature code also can be used on a 3953 Enterprise Library Controller, so you can use an
existing feature code 2720 as the System Console.

Feature Code 2722 (Rack Mount TS3000 System Console. Available via Factory or MES)

This feature provides the enhanced rack-mountable TS3000 System Console, an Ethernet switch, an
Ethernet cable, KVM cable, and connectors for connection of one machine to an IBM supplied internal
modem to enable remote enhanced service. This feature is an enhanced replacement of the IBM TS3000
System Console for Service (#2721). Includes console upgrade previously provided as FC #2719 (Memory
upgrade to 4 GB total RAM and a second Ethernet card for the Service Console to allow redundant
connections into the service network). This feature applies to 3958, 3593, and 3592 machine types.

Feature Code 2716 (Second Modem) (not available for 3953)

* The Second Modem feature enables simultaneous, inbound and outbound communication (when two
analog lines are provided) with the System Console. The feature includes an MT5600 BA external
modem and a serial cable.

Notes:

— The Second Modem feature requires two analog telephone lines for simultaneous inbound
and outbound communication. The system can be configured to operate with one modem.

— When two modems are installed, the modem on COM1 can be configured to be the inbound
modem, and the modem on COM2 can be configured to be the outbound modem. If only
one modem is installed, it must be installed on COM1. It will be used for inbound and
outbound communication.

Feature Code 2717 (3592 A60 Attachment)

* This feature code enables the System Console to be attached to one or more A60s via a Net Interface
Card added to the A60.

Note: The A60 must be at code level 1.16.x.xx or above in order to attach to the System Console.

Feature Code 2718
* This feature code has been replaced by feature code 2721.

Feature Code 2719 (Console Upgrade)
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» This feature provides a memory upgrade to 2.14GB (2GiB) of total RAM and a second ethernet card
for the System Console to allow redundant connections into the service network, and to allow
broadband call home capability. This feature only applies to System Consoles shipped with feature
codes 2718, 2720, and 2721.

Note: This feature code is required for TS7700 attachment.
Feature Code 2720 (System Console)

This feature includes the listed hardware that is required to support the System Console (see feature code
2721 for 3953 Enterprise Library Controller).

Note: An existing feature code 2720 can be used with the 3953 Enterprise Library Controller, if you select
feature code 2714 for the 3953.

* IBM System Console

— A PC, complete with an Ethernet port. One MT5600 BA external modem, serial cables, and a color
monitor are packaged separately. The System Console is preloaded with software, and it is tested
prior to shipment.

e LAN Switch Attachment

— This is a 16-port unit. One switch is included with feature code 2720, and as many as two additional
switches can be attached downstream, with cascading, using uplink ports. This allows a maximum of
forty-three connections to each System Console.

* LAN Cabling

— Two 15.2-m (50-ft) ethernet cables are supplied with feature code 2720. One cable is used to
connect the System Console controller to the internal port on the ethernet switch. The second cable
is used to connect the external port to the first downstream tape system. Additional cables are
supplied with feature code 2714 or feature code 2715, depending on expansion port requirements.

» System Console Product Recovery CD-ROM

— Feature code 2720 includes a Product Recovery CD-ROM that will serve as the basis for rebuilding
the hard disk in the event of a failure. The code image CD is boot-able and is self-extracting. The
CD-ROM includes:

- Factory default hard drive image
- System Console dynamic update capability

- IBM PC Hardware Maintenance Information in PDF format, which may be viewed by placing the
CD in a computer with Adobe Acrobat Reader (Version 4.0 or later)

— IBM Enhanced Diagnostics CD-ROM

Feature Code 2721 (System Console - for 3953 Enterprise Library Controller only)

» This feature code is similar to feature code 2720, but is for the 3953 Enterprise Library Controller. Use
the ethernet port that is identified as 'Internal Ethernet Connector' in the following figures.

Internal Ethernet Connection Grid Ethernet Connection

/

Too o0 oo o0

a14or336

External Ethernet Connection

Figure 2-6. Network Connection Diagram — 8836 (3953 Only) (FC 2718, FC 2719)
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Grid Ethernet Connection

)]

)

a140r335

Internal Ethernet Connection External Ethernet Connection

Figure 2-7. Network Connection Diagram — 8849 (FC 2719, FC 2721)

Grid AOTM Connection

Internal 172.31.1.x Connection External ECC/Call Home Connection

al4or351

Figure 2-8. Network Connection Diagram — 7978 (FC 2719, FC 2721)

COM!1

Internal
Ethernet
Connection \

© g

COM2\

T e i
External T e
Ethernet

Connection \

Grid
Ethernet
Connection

al4or350

Figure 2-9. Network Connection Diagram — 8482, 8485 (FC 2719, FC 2720)
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Figure 2-10. Network Connection Diagram — 4362 (FC 2719, FC 2720)

Performing Installation
Ensure that the prerequisites in have been met before you begin the installation.

Notes:
» This connection will be used for high speed call home functionality. This connection is not
required if a modem is being used.
+ See|[Feature Codes” on page 2-2| for details about feature code content.

Table 2-3. Installation Prerequisites

Prerequisites Notes

Analog telephone lines - two preferred, one | Note the modem telephone numbers for the Console Configuration
minimum (3953 only allows one) Sheet

One Ethernet connection This connection will be used for high-speed, call home functionality,
and is not required if a modem exists

One floppy diskette, a USB storage device, For activities such as, backing up configuration files, offloading user

or a CD (model dependent) files (recommended, but not required)

Completed Console Configuration Sheet See [Table 2-5 on page 2-9|

Accessible area for installation and Adequate space and location for installation, access, and operation
placement

Here is a summary of the steps you will take in this section to install the System Console.
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Note: If you are performing an MES for feature code FC 2724 and FC 2734, or if you are installing the FC
2724 and FC 2734 into a customer's rack, see the Installation Instructions provided with the TSSC
server.

Note: If the TSSC server FC 2724 and the TSSC model FC 2734 are provided with the 3952 F0O5 frame,
the TSSC server is already installed in the FO5 and the modem needs to be installed on the cable
routing bracket as shown in [Figure 2-12 on page 2-12

System Console Setup

1. Unpack and assemble System Console.

2. Install ethernet switch and connect to System Console.
3. Power on the System Console.

Tape System Setup and Configuration.
1. Complete network connection to tape system for System Console attachment.
2. Perform software configuration on tape systems for System Console attachment.

System Console Configuration

Login to System Console.

Add information for attached systems.

Configure call home settings.

Backup configuration settings (recommended, but not required).
Set console date and time.

Test network connection to tape systems.

Test modem connection to RETAIN.

Log out of System Console.

© N oA N~

Test Tape System Configuration
1. Perform test call home notification.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Completing Installation

1. Proceed with the physical layout and installation of the System Console unit in a central location at
the customer's site. Power cords are supplied in the ship group with the feature to satisfy the various
country power requirements. Ensure that power feeds are available for the following components
(basic, wall-outlet power is sufficient). One of each of these items is provided:

* System Console unit
e Monitor *

* Modem1 *

* Modem2

* LAN Switch 1

* LAN Switch 2

* LAN Switch 3

Note: * These items are integrated into the 3953 Enterprise Library Controller.

2. Before you configure any attached systems at the System Console, ensure that you have:
e Chosen subsystem IP addresses
+ Completed a Console Configuration Sheet (see [Table 2-5 on page 2-9)
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Keep the completed Console Configuration Sheet near the System Console. [Table 2-4|provides a
sample of a completed Console Configuration Sheet.

Table 2-4. Console Configuration Sheet — Sample

IP Address Att_zla_;;:/dmi)ésetlem Serial No. Host Name Modem Tel. No.
172.31.1.1 System Console N/A tssneti 202-555—-1111
172.31.1.2 3494 B20 13AAA10 VTSH 202-555—-1111
172.31.1.3 3494 B20 13ABC11 VTS2 202-555-1112
172.31.1.45 3592 J70 13ABC12 3592CU40 202-555-1113

IP addresses in the form 172.31.1.x (where 'X' is 2 through 253) may be assigned to tape
subsystems. The IP address choice must conform to the following guidelines:

Assign |IP addresses by using the subnet 172.31.1.x; otherwise TCP/IP communication with the
console will not work.

IP addresses must be unique and must not be duplicated between subsystems. Entry fields on
subsystems may be pre-filled with suggested, default values. You must change these values when
more than one library complex is connected to the System Console.

When connecting multiple subsystems with default IP address settings to the System Console
network, connect and configure the systems one-at-a-time to prevent the possibility of duplicating
IP addresses, which would create network errors. Refer to the maintenance information for each
tape system for specific recommendations.

The System Console supports attachment of as many as forty-three systems using as many as
three ethernet hubs or switches for attachment. Note: The Ethernet Hubs restrict the network traffic
to 10MB. Suggest replacing all Ethernet HUBs with Ethernet Switches.

The maximum, total (cumulative), cable length for connection between the System Console and
any subsystem is 100 m (300 ft).

Use the Console Configuration Sheet in|Table 2-5/to choose and pre-assign IP address for attached
tape systems. Consider making a photocopy of this blank configuration sheet, then filling-in the fields.

Note: Keep a current copy of the filled-in Console Configuration Sheet (Table 2-5) in an accessible

location for future reference and modification. You can use this to retrieve subsystem
information following a system failure.

Table 2-5. Console Configuration Sheet — Actual. Copy this table, and use that copy to fill in this information.

IP Address

Attached System

Type/Model Serial No. Host Name Modem Tel. No.

172.31.11 System Console tssnet1 Modem?2

Modem1

172.31.1.___

172311

172.31.1.___

172311

172.31.1.___

172311
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Table 2-5. Console Configuration Sheet — Actual (continued). Copy this table, and use that copy to fill in this

information.

IP Address

Attached System
Type/Model

Serial No.

Host Name

Modem Tel. No.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

172.31.1.

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

172.31.1.
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

172.31.1.
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3. Unpack the System Console.
4. Attach the keyboard, the mouse, and the main power cord.

5. Unpack the monitor, and attach the appropriate power cord. The monitor VGA cable should be
attached to the video card connector.

Attention: Do not attach the monitor cable to the planar video connector, if one is present (for
NetVista models, only).

6. Locate the USB Modem.

7. See|Figure 2-11[ The reference keys are as follows:

* p§ - USB Modem

+ H - TSSC Internal LAN

+ [ - USB Keyboard/Mouse (or from optional KVM Switch)
« |1 - TSSC External LAN

« H - Video Cable (or from optional KVM Switch)

8. Plug the cables into the TSSC as shown.

D
(o]
Yo}
(e
]
<
—
@©

|
| Figure 2-11. Cables Plugged into the TSSC Server

9. See|Figure 2-12 on page 2-12}

10. Position the modem at the back of the frame. Use two 355 mm (14 in.) tie wraps B to secure it at
the back of the frame.

11. Connect the phone cord into the modem.
12. Use the other tie wraps to secure the USB modem cable to the frame as needed.
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Figure 2-12. Securing the USB Modem to the Frame.
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Tape System Call Home Setup for TS7700 Virtualization Engine

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Note: TS7700 attachment requires feature code 2718, 2720, or 2721. See [‘Feature Codes” on page 2-2
for details about feature code content.
1. From EBTERM or NetTerm login, at the IBM TS7700 Virtualization Engine Maintenance menu,
select Subsystem Configuration Menus.

/ N\
IBM TS7700 Virtualization Engine Maintenance

Move cursor to desired item and press Enter.

System Checkout Menus

SIM, Error Log, Diagnostics, Trace/Dump Menus
Utility Menus

Microcode Maintenance Menus

Subsystem Configuration Menus
Removal/Replacement Menus

3957-Vxx Online/0ffline Menus

3957-Vxx Shutdown and Restart Menus
PFE/Support Tools Menus

TS7700 GRID Menus

Fl=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do
o %
Figure 2-13. Call Home / Remote Services Menu — Virtualization Engine Maintenance
2. Select Call Home / Remote Services Menu. Press Enter. Following screen is displayed.
4 N
Move cursor to desired item and press Enter.
Display Hardware Vital Product Data (1scfg)
Adapter Slot Identification
Set Date/Time Menus
Customer Network Configuration Menus
Show / Change TS7700 Vital Product Data
Customer Configurations Menus
Data Management Settings
Call Home / Remote Services Menus
Fl=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do
o %

Figure 2-14. Subsystem Configuration Menus

3. Select IBM TotalStorage Master Console TCP/IP Configuration, and press Enter.
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Call Home / Remote Services Menu
Move cursor to desired item and press Enter.

IBM TotalStorage Master Console TCP/IP Configuration
Change / Show Call Home / Remote Services

Change / Show Call Home Filters

Send Test Notification Menu

Remote Data Monitoring

View Call Home Log

Reset Call Home Daemon

Configure Network Port for Remote Connection

Fl=Help F2=Refresh F3=Cancel F8=Image
\f9=She]1 F10=Exit Enter=Do

Figure 2-15. Call Home / Remote Services Menu — TCP/IP Configuration

4. Select Enter the Service Console IP Address:.

s

Set Service Console (TSSC) Customer Network Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP] [Entry Fields]

NOTICE: TSSC IPs must be in IPv4 format
because the TSSC only supports IPv4 addresses.
TSSC IPs cannot be disabled.

* Enter the Service Console IP Address: [172.31.1.1]
NOTE: This is the IP Address for the TSSC
that will be attached to this TS7700. The
values displayed are either the default
values or the current IP that is configured.

% Enter the Service Console Hostname: [blimpie]

[MORE. . .14]

Fl=Help F2=Refresh F3=Cancel F4=List

F5=Reset F6=Command F7=Edit F8=Image
\f9=$he11 F10=Exit Enter=Do

Figure 2-16. Set Service Console (TSSC) Customer Network Configuration Menu

5. At|Figure 2-16} verify that the System Console IP address is set to the IP address (defaults to

172.31.1.1).

6. At|Figure 2-16| verify that the TS7700 IP address is set to the IP address 172.31.1.x. The 'x' will be

replaced with the IP address that you designated for this subsystem.

Note: For the TS7700, the last octet of this IP address must be in an increment of 10 between 10
and 240 (that is. 10, 20 ... 230, 240). The router configuration will utilize this entire octet for
System Console configuration. All ten of these addresses must not be used by another

subsystem connected to the System Console.

7. Press F3 to return to|Figure 2-15 Select Change / Show Call Home / Remote Services. |Figure 2-1

on page 2-15|displays.
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Change / Show Call Home / Remote Services

Type or select values in entry fields.

Press Enter AFTER making all desired changes.

[Entry Fields]

* Enable Serious and Acute SIMs to Call Home? yes

* LM Customer Initiated Call Home Allowed Frequency disabled

* Enable Paging? no

* Customer Business/Company Name" [1BM]

% Customer Location [TUCSON]
Remote Phone Number 1 (call home) : [18005551234]
Remote Phone Number 2 (call home) : 1
Callback Phone Number [modem] 1
Customer Phone Number [voice] 1
Customer O0ffshift Phone Number 1

Fl=Help F2=Refresh F3=Cancel F4=List

F5=Reset F6=Command F7=Edit F8=Image

\f9=She11 F10=Exit Enter=Do

Figure 2-17. Change / Show Call Home / Remote Services Menu

8. At[Figure 2-17| verify that Serious and Acute SIMs to Call Home is enabled. If it is not enabled,
highlight the text, and press F4. Move the cursor to yes, and press Enter.

9. Press F3 to return to|Figure 2-15 on page 2—14[ Select Remote Data Monitoring. |Figure 2-18
displays.

Vs
Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]

* Change / Show Call Home Heartbeat Interval 3 days
* Error Initiated Call Home Data Gathering Enabled
* Timeout Period Between Successive Data Call Homes [24]

(In hours between 1 and 99)

Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
\f9=She11 F10=Exit Enter=Do

Figure 2-18. Call Home — Remote Data Monitoring Menu

10. At|Figure 2-18] verify that Call Home Data Gathering is enabled. If it is not enabled, highlight the text,

and press F4. Move the cursor to Enabled, and press Enter.

11. Press F3 to return to [Figure 2-15 on page 2-14} If more attached subsystems need configuration exit

the EBTERM or NetTerm session and connect the net subsystem.

12. Return to Step and configure all attached systems before continuing to Step

13. You have completed the TS7700 Virtualization Engine Configuration. Leave the screen active.

+ Go to[‘Setting Up Autonomic Ownership Takeover Manager (AOTM)” on page 2-16|if you want to

set up the autonomic takeover manager, then return here.
——AND - -

» Go to[Tape System Call Home Setup for VTS, VTC, and Tape Controllers” on page 2-21
——OR--

* [Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise Library Controller” on page

2-26,| if necessary.
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Setting Up Autonomic Ownership Takeover Manager (AOTM)

The Autonomic Ownership Takeover Manager (AOTM) allows the System Console to create a temporary
communication path around a failing communication path in a multiple IBM TS7700 Virtualization Engine
configuration to determine the health of the remote system. This activity is performed independently of
human intervention. This activity is similar to actions taken by an operator who intervenes to reestablish
communications by taking over ownership of the complex (or grid), or multiple clusters. But AOTM is done
automatically by a TSSC, without a request being made by an operator.

See A complex (or grid) can be defined as multiple clusters. The preferred minimum
configuration of a cluster contains one of each of the following:

* Two TS7700s

* Two TSSCs (one connected to each TS7700)

* Two grid switches (one supporting each TS7700 and TSSC pair)

Note: AOTM is also with one TSSC between two TS7700s, with the minimum configuration of the
following:
— Two TS7700s
— One TSSC (connected to each TS7700)

Notes:
— The Grid Network Interface should only be used for TS7700 peer-to-peer networks with the
AOTM function. Unless previously mentioned, other uses are not supported.
— No connection is made directly between any two TSSCs, but TSSCs are connected through
the grid switches.

IBM || Grid
TS7700 Switch

Grid || IBM
Switch TS7700

TSSC TSSC

Site
A

Site

|
1
1
|
|
1
|
1
1
|
1
1
|
1
1
|
1
\ B

al4or341

Figure 2-19. Autonomic Ownership Takeover Manager (AOTM) Layout. This is one example of how a customer might
have a complex with physically-separated clusters at multiple, separate sites, such as in multiple cities or in multiple
states.

1. You were directed here from[‘Console Settings” on page 2-60.)On both clusters, configure the local
TSSC Grid IP address. From the TS7700 Virtualization Engine Maintenance menu, select TS7700
GRID Menus > TS7700 GRID Configuration Menus > Autonomic Ownership Takeover Manager
Menus > Set Local GRID TSSC IP. Press Enter. You see [Figure 2-20 on page 2-17}
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4 N
Set Local GRID TSSC IP

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry fields]
Enter the Local GRID TSSC IP address: (10.11.110.40)

Fl=Help F2=Refresh F3=Cancel

F8=Image F10=Exit Enter=Do
/=Find

-

Figure 2-20. Setting Local Grid TSSC IP Address

2. In the Entry Fields field, type the TSSC Grid IP address to which the cluster's local TSSC is
configured (10.11.110.40, in this example). Press Enter.

3. Press F3 twice to return to the TS7700 Virtualization Engine Maintenance menu, and select
Configure Autonomic Ownership Takeover Manager to a Remote Cluster.

Note: The remainder of these steps apply to the failing cluster from which you want to take over
volumes.

4. Press Enter. |Figure 2-21| appears.

Select a remote cluster
Move cursor to desired item and press Enter.
# Select the Remote Cluster from the Tist below

#
# Remote Cluster

Fl=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do

Figure 2-21. Selecting a Remote Cluster. For this example, the cluster name is 'V06.'

5. Move the cursor to the desired cluster, and press Enter. [Figure 2-22| displays.

4 N\

Configure Autonomic Ownership-Takeover To a Remote Cluster

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry fields]
* Remote Cluster ID: 0
Enter the Autonomic Takeover Setting: [enabTled]

*

Enter the Takeover Mode: WOT
*

Enter the minutes for the Grace Period: [25]
Enter the minutes for the Retry Period: [5]

Fl=Help F2=Refresh F3=Cancel F4=List
F5=REset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

/=Find
o

Figure 2-22. Configuring AOTM To Remote Cluster

6. Add information in the appropriate fields, depicted in|Figure 2-22¢
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Remote Cluster ID
Set to the ID that you chose in [Figure 2-21 on page 2-17} (0 in this example.) The default
which appears in this field (0 or 1) depends on the cluster from which you are initiating this
configuration.
Enter the Autonomic Takeover Setting
Set to Enabled or Disabled. (enabled in this example.)
Enter the Takeover Mode
Set to Read only takeover (ROT) or Write-enabled ownership takeover (WOT). ROT allows
the local cluster to read (but not write to) volumes in the remote cluster. WOT allows the local
cluster to read from and write to any volumes that it takes over from the remote cluster.
Enter the minutes for the Grace Period
Set the number of minutes before the local cluster takes over the volumes of the remote
cluster.
Enter the minutes for the Retry Period
Set the number of minutes to wait before a retry of the takeover of the volumes occurs.

Press Enter. You see [Figure 2-23

Fl=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

- J

ARE YOU SURE?

Continue may delete information you may want
to keep. This is your last chance to stop
before continuing.

Press Enter to continue.

Press Cancel to return to the application.

Figure 2-23. Warning Message for Processing AOTM To a Remote Cluster

8.

Press Enter. You see [Figure 2-24

-

Command: [[[4 stndout: yes stderr: no

Before command completion, additional instructions may appear below.
Autonomic takeover configured successfully

Fl=Help F2=Refresh F3=Cancel F4=List

F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
- J

COMMAND STATUS

Figure 2-24. Processing AOTM To a Remote Cluster

9.

10.
11.

Press F3 until you are returned to the main menu for the TS7700 Virtualization Engine Service
Terminal.

Verify the TSSC Firewall settings:

Click the Custom Firewall Settings link at the top of the Console Settings page.

Verify the HTTP entry is properly set for the Grid interface. You should see the Grid entries configured
to allow HTTP connections, both in and out, as seen in the figure below. If either of them are set to
drop, change it to allow by selecting the option in the leftmost column.
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Figure 2-25. TSSC Firewall Settings

Note: If the customer's network is configured to run AOTM over the same network as the TSSC's
External adapter, you will need to repeat this step for the External firewall entries.

12. Once the settings have been verified, click the Update Firewall Settings button.

13. You will see a message stating the firewall settings have been successfully configured.

14. Close the open window.

15. To test the AOTM, go to [‘Testing Autonomic Ownership Takeover Connectivity To A Remote Cluster.”|

Testing Autonomic Ownership Takeover Connectivity To A Remote
Cluster

This information provides a procedure for testing autonomic ownership takeover connectivity to a remote
cluster.

The activity described in this section is a continuation of ['Setting Up Autonomic Ownership Takeover|
[Manager (AOTM)” on page 2-16) Your cluster should have been set up to allow the Autonomic Ownership
Takeover Manager (AOTM) before you perform these steps.

1. From the TS7700 Virtualization Engine Maintenance, select TS7700 GRID Menus > TS7700 GRID

Configuration Menus > Autonomic Ownership Takeover Manager Menus > Test Autonomic
Ownership Takeover Manager to a Remote Cluster. Press Enter. You see |Figure 2-26

4 N

Select a remote cluster
Move cursor to desired item and press Enter.
# Select the Remote Cluster from the Tist below

#
# Remote Cluster

0 - Vo6
Fl=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find
- J

Figure 2-26. Initiating Remote AOTM Cluster Test. For this example, the cluster name is 'V06.'

2. Move the cursor to the desired cluster (V06 in this example), and press Enter. [Figure 2-27 on page]

displays.
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Test Autonomic Ownership-Takeover To a Remote Cluster

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry fields]

* Remote Cluster ID: 0

Local Cluster IP: [ 1]
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image

\f9=She11 F10=Exit Enter=Do

Figure 2-27. Testing AOTM Connectivity To Remote Cluster

3. Add information in the appropriate fields, depicted in
Remote Cluster ID

This is the same setting that you chose in|Figure 2-21 on page 2-17| (‘0" in this example).
Local Cluster IP
This field contains a default setting, which you cannot change.

4. Press Enter. You see [Figure 2-28|

Ve
ARE YOU SURE?
Continue may delete information you may want
to keep. This is your last chance to stop
before continuing.

Press Enter to continue.

Press Cancel to return to the application.
Fl=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

o

Figure 2-28. Verifying AOTM Change

5. Press Enter to start the test, or press Cancel to return to application. If you press Enter, you see

Figure 2-29,

Ve
COMMAND STATUS

Command: OK stndout: yes stderr: no

Before command completion, additional instructions may appear below.
Local TSSC Connection: Successsful

Remote TSSC Connection: Successsful

Remote Node connection: Successsful

Remote node state: online
Based on the conditions above, will ownership takeover occur? false
Fl=Help F2=Refresh F3=Cancel F6=Command

F8=Image F9=Shell F10=Exit /=Find
n=Find Next
o

Figure 2-29. Processing AOTM Changes

Notes: In the |Figure 2-29|field "Based on the conditions above, will ownership takeover occur?"
False The local cluster is not taking control of the remote cluster's volume.

True The local cluster has ownership and is taking control of the remote cluster's volume.
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AOTM testing is complete.

Tape System Call Home Setup for VTS, VTC, and Tape Controllers

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1—1|to determine the code level.

1. From EBTERM or NetTerm, perform the following:
a. Make the following selections from one of these screens:
* IBM Virtual Tape Server (B10/B20 VTS) Maintenance
* 3590 Subsystem Maintenance
+ 3592 Subsystem Maintenance
b. Select Subsystem Configuration, and press Enter.
c. Select Call Home / Remote Services Menu, and press Enter. displays.

~
Change / Show Call Home / Remote Services
Type or select values in entry fields.
Press Enter AFTER making all desired changes.
[Entry Fields]
* Enable Serious and Acute SIMs to Call Home? Yes +
* LM Customer Initiated Call Home Allowed Frequency disabled +
* Enable Paging? no +
Customer Business/Company Name: 1
% Remote Phone Number 1 (call home): 0
Remote Phone Number 2 (call home): 0
Callback Phone Number (modem) [
Customer Phone Number (voice) 0
Customer Offshift Phone Number 1
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
Ensure Enable Serious and Acute SIMs to Call Home? is set to yes. )

Figure 2-30. VTS,VTC, A60, J70 & C06 Call Home / Remote Services Menu — Switch Call Home Selection

Note: Ensure that the Console Configuration Sheet (Table 2-5 on page 2-9) was completed before you
perform the following steps.

2. At|Figure 2-30, on Models VTS, VTC, A60 & J70, select Switch Call Home / Remote Services
to/from System Console, and press Enter. [Figure 2-31 on page 2-22|displays.
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Switch Call Home / Remote Service to/from System Console

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
% Switch Call Home/Remote Services to/from Console/WTI +
System Console

IBM System Console TCPIP Address (dotted decimal): [172.31.1.1]
1BM System Console Hostname: ]
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
\F9=She11 F10=Exit Enter=Do

Figure 2-31. Switch Call Home/Remote Services to/from System Console

Change / Show Modem Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]

Name of Modem Set: MultiTech MT5600BA +
* Dialer Phone System: tone +
% Cancel the call if not connected within (seconds): [45] #
* Number of consecutive retries to connect: [1] #
Name of Expander Set: WTI APS 16 or MDS 16 +
Expander port for modem: 1 +
Expander port for this Control Unit: 2 +
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

VTS,VTC, A60, J70 & C6 Call Home / Remote Services Menu —> Change / Show Modem Configuration.
\When the WTI is selected also select the Change / Show Modem Configuration and set as needed.

Figure 2-32. Change / Show Modem Configuration

Note: In|Figure 2-33 on page 2-23 Change this controllers IP and hostname as needed.
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Subsystem Configuration Menus -> Show / Change TSSC Connection
Show / Change Direct TSSC Connection

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
% Enter this controllers IP address on TSSC network: [172.31.1.xxx]

* Enter the Service Console IP Address: [172.31.1.1]
NOTE: This is the IP Address for the TSSC
that will be attached to this Control Unit.
The values displayed are either the default
values or the current IP that is configured.

% Enter the Service Console Hostname (TSSC): [

Fl=Help F2=Refresh F3=Cancel Fa=List
F5=Reset F6=Command F7=Edit F8=Image
\f9=She11 F10=Exit Enter=Do

Figure 2-33. 3592-C07 - Subsystem Configuration Menus - Show / Change TSSC Connection

Enable call home using the following screen:

Subsystem Configuration Menus -> Call Home / Remote Services Menu
Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

Change / Show Call Home / Remote Services
Remove Files from Call Home Send Queue
Change / Show Call Home Filters

Send Test Notification Menus

Remote Data Monitoring

View Call Home Log

View Call Home SNMP trap Log

Fl=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Select: Change / Show Call Home / Remote Services

Note: Ensure Change / Show Call Home / Remote Services is set to yes.

\fi]] in the appropriate phone numbers.

Figure 2-34. Enable Call Home
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Change / Show Call Home / Remote Services
Type or select values in entry fields.
Press Enter AFTER making all desired changes.
[Entry Fields]
* Enable Serious and Acute SIMs to Call Home? yes +
Customer Business/Company Name: [ Company Name]
Remote Phone Number 1 (call home): [1-zzz-xxx.yyyy]
Remote Phone Number 2 (call home): [1-zzz-xxx,yyyy]
Callback Phone Number (modem) [1-zzz-xxx-yyyy]
Customer Phone Number (voice) [1-zzz-xxx-yyyy]
Customer Offshift Phone Number [1-zzz-xxx-yyyy]
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
o J
Figure 2-35. 3592-C07 Subsystem Configuration Menus -> Call Home / Remote Services Menu
3. At[Figure 2-31 on page 2-22 and [Figure 2-33 on page 2-23| verify that the IBM System Console IP
Address is set to the IP address (defaults to 172.31.1.1). Press F4 for the pop up menu displayed in
Figure 2-36| Select Console Call Home/Remote Services thru System Console, and press Enter
twice.
4 N\
Switch Call Home / Remote Service to/from System Console
Type or select values in entry fields.
Press Enter AFTER making all desired changes.
[Entry Fields]
% Switch Call Home/Remote Services to/from Console +
IBM System Console
IBM System Console TCPIP Address (dotted decimal): [172.31.1.1]
IBM System Console Hostname: 0
1499994999999999999499999999999999999949999999999999999999999999999999499qqK
X Switch Call Home/Remote Services to/from System Console X
X X
X Move cursor to desired item and press Enter. X
X X
X WTI Call Home/Remote Services thru WTI Switch Modem X
x  Console Call Home/Remote Services thru System Console X
X X
x Fl=Help F2=Refresh F3=Cancel X
x F8=Image F10=Exit Enter=Do X
F5 /=Find n=Find Next X
\fg 19999999999999999999999999999999999999999999999999999999999999999999999999gk Y,

Figure 2-36. Models VTS, VTC, A60, J70 & CO06 - Switch Call Home / Remote Services to/from System Console — IP
Address
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Attention:

- Step 4}, Step[s} and Step[6 on page 2-26]apply to tape systems without SMC router WAN port
connectivity.

« If your installation uses an SMC router for WAN port connectivity, do not use Steps [4} [5} and [6 on]
but refer to the product's maintenance information for instructions to configure the SMC
router WAN and LAN IP addresses for connection to the System Console. You must set the router
configuration before proceeding. Continue at Step after configuring the router
WANY/LAN ports.

4. This Step only applies to 3590 A60: Select IBM System Console TCP/IP Configuration, and press
Enter. Select the presented Ethernet adapter. |Figure 2-38 appears.

Attention: Select the illustrated line item only at No other menu display items are
applicable for this process.

4 N
Call Home / Remote Services Menu
Move cursor to desired item and press Enter.
IBM System Console TCPIP Configuration
1d99999999999999999999999999999999999999999999999999999999999499999999994qqk
X Available Network Interfaces X
X X
x Move cursor to desired item and press Enter. X
X X
x enl X
X X
x Fl=Help F2=Refresh F3=Cancel X
x F8=Image F10=Exit Enter=Do X
F1 /=Find n=Find Next X
\Fg 199999999999999999999999999999999999999999999994999999999999999999999999q99gk Y,
Figure 2-37. Call Home / Remote Services Menu
4 N
Minimum Configuration & Startup
To Delete existing configuration data, please use Further Configuration menus
Type or select values in entry fields.
Press Enter AFTER making all desired changes.
[Entry Fields]
* HOSTNAME [VTS13AAA00]
% Internet ADDRESS (dotted decimal) [172.31.1.2]
Network MASK (dotted decimal) [255.255.255.0]
* Network INTERFACE enl
NAMESERVER
Internet ADDRESS (dotted decimal) 0
DOMAIN Name [l
Default GATEWAY Address ]
(dotted decimal or symbolic name)
Your CABLE Type N/A +
START Now yes +
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
o J

Figure 2-38. Minimum Configuration and Startup Menu

5. This Step only applies to 3590 A60: Use [Figure 2-38|as a reference to help you add the following
information:

* A descriptive host name. This will be the name used to identify the tape system in the customer's
environment.
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+ An Internet ADDRESS of the form 172.31.1.x (see [Table 2-5 on page 2-9|for the value 'x). It is
important that no two internet addresses are set alike in the local Ethernet network. It is essential
that the internet addresses are assigned using the network 172.31.1.x, otherwise TCP/IP
communication with the console will not work.

* A Network Mask of 255.255.255.0. The Network Mask will be the same for each tape system.

« Change the START Now setting to yes.

Press Enter. Press F3 to return to Call Home / Remote Services Menu displayed at [Figure 2-30 on

page 2-21

6. Press F3 twice to return to Call Home / Remote Services Menu. If more attached subsystems need
configuration, exit the EBTERM/NetTerm session and connect to the next subsystem.

7. Return to Step|1 on page 2-21| and configure all attached tape systems before continuing to Step @

8. VTS, VTC, and tape controller configuration is complete at this point. Leave the screen active.
Continue to[“Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise Library Controller’|
if necessary, then continue to [‘Configuration” on page 2-36|to perform System Console configuration.

Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise
Library Controller

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.
System Console

For 3494, Version 3.0.0 and above

For 3953, Version 3.2.0 and above

IBM 3494 ATL Models L12, L14, L22
Code Version 529 and above (LM531 and above for 3953), using a 7581 PC. If you are using a
7588 PC, you must have Feature Code 2715 installed, which will provide a 4-port ethernet
adapter, if one is not installed.

Notes:
» Either FC 5219 or FC 5220 must have been installed to enable the 3494 Specialist.
* The customer (usually an administrator) must authorize enabling the 3494 Specialist.

1. See [Figure 2-39 on page 2-27, Ensure that an ethernet connection has been completed between the
3494 ATL or 3953 SBC card port 1 (lower port) and a port on one of the System Console ethernet
switches. The ethernet cable should plug into the bottom port (Item 1 in [Figure 2-39 on page 2-27).
The SBC card is in slot 3 of the 7581.
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Figure 2-39. Plug Ethernet Cable Here (3494). Notice Item 1.

2. Ensure that the TSSC Server is listed in the command process window. Use Ctrl + Esc to view the
window list. See [Figure 2-40

Window, List

TSMC Server
slip

telnetd

ftpd

IBM TotalStorage Specialist
Library Dataserver Log Proces
Manual Mode Terminal
3494 Tape Library Dataserver

a140r230

Figure 2-40. Command Process Window List — Example. The text on your screen may differ with various levels of
code or with different machine model numbers.

Notes:

+ If the TSSC Server is not included in the list depicted in [Figure 2-40} you can start the
TSSC Server by typing tsmestrt from a command line.

* You can stop the TSSC Server. Right click TSMC Server from the [Figure 2-40} then click
on the Close button in the dialog box.

* You can restart the TSSC Server by stopping it, then starting it.
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3.

» If the "tsmcstrt" fails to start the "TSSC Server" window, the OS/2 device drivers may not
be installed on the 3494 ATL or the 3953. Shutdown the 3494 ATL or the 3953, and open a
service window. Run "tsmcinst". This loads the necessary OS/2 device drivers. Once
loaded, the 3494 ATL or the 3953 must be rebooted.

Use the 3494 ATL or 3953 menu commands Service --> Manage MasterConsole to view the dialog
box for setting any 3494 ATL or 3953 IP address or addresses. See|Figure 2-41|.

Configure the IP address of the 3494 ATL or 3953 for the System Console network. The default
addressing scheme uses the subnet 172.31.1.x. The specific address must not be in use elsewhere
on the System Console network.

Note: You must configure the library manager before you configure the System Console.

Manage Master Console

Change/enter |P address[es] for the Library Manager(s]. These addresses will be
used by the Master Console to communicate with the libraries.

-IP Address- - Configuration-
LM- A: | | | | Configuration successful
LM-B: | | | | Configuration successful

Master Console IP Address: 172.31.1.1

Library Manager Frame Serial Humber: I?BI]I]I]IM

a8300080

Figure 2-41. Manage System Console Dialog Box. The Library Manager Frame Serial Number must be the 3953 FO5

base
code

4.

2-28

frame number or the 3494 LXX frame serial number. The text on your screen may differ with various levels of
or with different machine model numbers.

Change the default IP addresses in the entry box to be IP addresses that are unique to the System
Console network. Click Change. After the address is successfully set, Configuration Successful is
indicated in the Configuration column. Click Exit when complete.

Ensure that Call Home is enabled on the 3494 ATL or 3953. Use the 3494 ATL or 3953 Menu
Commands Utilities --> Enable/Disable Functions --> LM Call Home --> Enable to enable Call
Home on the LM.

In order to use the System Console "Telnet to Attached Systems" tool to access the 3494 ATL or
3958, you must enable Service Access. Use the 3494 ATL or 3953 menu commands Commands -->
Service Access —>Enable Service Access. This will enable both the telnet services and the ftp
services for the 3494 ATL or the 3953. "Service" is enabled if it appears unhighlighted (grayed-out) on
the menu.

Notes:

» Either FC 5219 or FC 5220 must have been installed to enable the 3494 Specialist.
Though these feature codes are 3494-only, they are included in the 3953 FO5 base frame.

» The customer administrator must authorize enabling Service Access.

» The System Console tool "Telnet to Attached Systems" will be unable to connect with this
3494 ATL or 3953 if Service Access is disabled.

» System Console FTP access to this 3494 ATL or 3953 will be unable to connect, if Service
Access is disabled.
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7.

» [f the System Console tool “Telnet to Attached Systems” is unable to connect to a
subsystem, the telnet terminal screen disappears without presenting a login prompt. No
error message will be displayed.

* The customer administrator must authorize enabling the 3494 Specialist.

In order to view the 3494 or 3953 Specialist from the System Console, you must enable the
3494/3953 Specialist. Use the 3494 ATL or 3953 Menu Commands: > Utilities > Enable/Disable
Functions > 3494 Specialist > Activate. You may be asked for a User ID and Password. The
default User ID is 'service' and the default password is 'service".

After the 3494 or 3953 Specialist is enabled, wait for the hour glass icon on your screen to disappear,
then select Commands --> Specialist (Web Server) --> Settings... from the 3494 ATL or 3953
menu.

Either click All Yes or select Yes for each function you want to manage by using the 3494 or 3953

Specialist. Ensure that 'Manage TSSC' is set to 'Yes' to manage the System Console configuration via
the 3494 or 3953 Specialist. |Figure 2-42 appears. Ask the customer administrator for any settings that

need to be changed on this screen from Yes to No, and check the No box for those settings.

3494 Specialist Settings

-Web Administrator
Userid: BAariivaisl | Deactivate | Password: | Reset to default |
-Web Browser Access
Panel Name Allow Access
Manage Storage Groups ® Yes {7 Ho
Manage Management Classes @ Yes {J Ho
Manage Storage Classes ® Yes {7 Ho
Manage Data Classes ® Yes {J Ho
Manage Logical Yolumes ® Yes {7 Ho
Stacked Yolume Pool Properties @ Yes [ Ho
Move/Eject Stacked Yolumes ® Yes {J Ho
Find Logical Yolume's Home ® Yes {J Ho
Stacked Volume Map @ Yes {J Ho
Volser Ranges ® Yes [ Ho
¥PD Summary ® Yes [ Ho
Database Search ® Yes {J Ho
Operator Interventions ® Yes {J Ho
VTS Management Policies * Yes [J Ho
Manage TSMC ® Yes [ Ho
| Submit Access Change | All Yes | | All No |
[l
Exit | Help | 5
©

Figure 2-42. 3494 ATL or 3953 Specialist Settings. The text on your screen may differ with various levels of code or
with different machine model numbers.

10.

11.

Click Submit Access Change to change the Web Browser Access attributes. Wait for the message
“Web browser access was successfully changed.”

Notes:
» The customer administrator must authorize enabling the 3494 or the 3953 Specialist.
» No browser will be able to display the 3494 or 3953 Specialist, if the Specialist is not
activated.

Return to the beginning of this procedure, and perform Steps |1 on page 2-26[through|6 on page 2-28

for each 3494 ATL that you will attach to the System Console.
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This completes the configuration of the 3494 ATL or 3953 for the System Console attachment. Continue at

“Test Call Home Notification for 3494 ATL or 3953 Enterprise Library Controller” on page 2-91)or go to

“Configuration” on page 2-36|if you do not intend to test the call home notification.

Using 3494 ATL or 3953 Enterprise Library Controller Web Specialist to
Change System Console Settings

This section provides supplemental information. You do not need this information to complete the setup for
a 3494 ATL or 3953. You can, however, use the 3494 ATL or 3953 (Web) Specialist to change certain
System Console settings on the 3494 ATL or 3953. You can access and enable the 3494 or 3953 Web
Specialist by using a browser on the customer's network (common approach).

ZiEnterprise Automated Tape Library Specialist - Microsoft Internet Explorer

Eile Edit Yiew Favorites Tools Help

IBM TotalStorage™
Enterprise Automated Tape Library Specialist

wWelcome Pags

LISEIRIGIEN N Enterprise Automated Tape Library Specialis

2o
B Monitor library manager

[ administer library manager %‘# -w J 9 ﬂ‘ ,\
Monitor logical library - Ll AAN
Monitor VTS 1 (LUKE) 1 2

H Adrminizkar VTS 1 (LUKE) r—rr [ Ly 20 =

VTS 2 (ROSE)
VTS 2 (ROSE) Select a Language: H 7GR

urity

Library manager Code Level: 520.61

Currently attached to:

Partition Partition Name Sequence Number
MTS 1 LUKE BADIL

VIS 2 ROSE BA2IA

For mare information, select the help icon in the top right of the screen.

Copyright IBM Corporation 2000, 2003, Licensed Materials, Property of IBM, all Rights Reserved.
IBM is a registered trademark of IBM Corp. US Government Users Restricted Rights - Use,
duplication, or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

al4or234

& [T [ @ meemet 4

Figure 2-43. 3494 ATL or 3953 Web Specialist - Welcome Page

After you access the 3494 ATL or 3953 Web Specialist, you will see the [Figure 2-43] A number of work
items are listed on the left side of the screen.

1.

Select Service library manager, then select Administer call home. This menu contains the tasks
that are relevant for the System Console and call home. You may want to perform some or all of these
actions. From this menu you can select (in any order):
Test interface
Test network interface to System Console or send a test call home record (see
Configure settings
Enable or disable problem call home or data call home activity (see [‘Configure Settings” on
Flush queue
Clears 3494 ATL or 3953 call home entries from the System Console call home queue (see
[‘Flush Queue” on page 2-32)
Set heartbeat
Set the time interval of the heartbeat call home action (see [‘Set Heartbeat” on page 2-33)
Configure interface parameters
Configure IP addresses for the LM and the System Console. Set the hostname alias of the LM
on the System Console network (see[“‘Configure Interface Parameters” on page 2-33)

Wait for the message “The Action Completed Successfully” which indicates that the test of the interface
or the test call home was successful.
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Test Interface

1.

From the "Administer call home" list on the Web Specialist screen (Figure 2-43 on page 2-30), click
Test interface to see the options shown in[Figure 2-44 If you are prompted for a username and
password, use the default values of service for the username and service for the password. These
values can be changed by the 3494 ATL system administrator.

From this screen (Figure 2-44)), you can test the (network) interface between the LM and the System
Console (from the perspective of the LM).

Test Interface
Tests the (network) interface between the LM and the System Console (from the perspective of
the LM)

Test Call Home
Causes a test call-home record to be sent from the LM via the System Console

S Enterprise Automated Tape Library Specialist - Microsoft Internet Explorer

Eile Edit Wiew Faworites Tools Help

IBM TotalStorage™
Enterprise Automated Tape Library Specialist
Wark Items Test Interface

Welcome page Test Master Console Interface T

Monitor libi
oritor Hhrary managsr Use these buttons to test the interface between the Master Console and Library Manager and to test

v iocers) Gmeregey the entire Call Home interface
Manitor legical library
Manitor VTS 1 (DELUK) Test Interface Test Call Home Refresh

[ admin

B Adrinister ¥TS 1 (DELU)
Manitor VTS 2 (CHORPER) Status
[ Administer VTS 2 (CHOPPER) Mo operation in progress,

Mal ity Fnanager

Histary
Hl Service library lanager

) Timestamp User ID Status Action
E Administer call home
Test interface 03/19/04 16:48: 56 sBervice Complete Testintrfce
;””SWE EORINEE 03/19/04 16:48: 54 service Started Testintrfce
ush queue R
Set heartbeat 03/03/04 15:29:37 service Complete Updateaddrs =
Configure network 03/03/04 15:29:32 service Started Updateaddrs
Monitar Peer-to-Paer 1 (DAISYDLR) 3
Manitor Pear-to-Pear 2 (BIKER) %
ol =
& [ @ meemet | ©

Figure 2-44. 3494 ATL Web Specialist - Test Interface

2. Wait for the message "The Action Completed Successfully," which indicates that the interface test was

successful.

Configure Settings

1.

From the “Administer call home” list on the Web Specialist screen (Figure 2-43 on page 2-30), click
Configure settings to see [Figure 2-45 on page 2-32| If you are prompted for a userid and password,
use the default values of service for the userid and service for the password. These values can be
changed by the 3494 ATL system administrator.

Call home communication is a default action that you must choose to disable. To disable call home,
click Send diagnostic data with Call Home, select the Disabled button, click Save Call Home
Settings.
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B Enterprise Automated Tape Library Specialist - Microsoft Internet Explorer

File Edit View Favories Tools Help

IBM TotalStorage™

Enterprise Automated Tape Library Specialist
work Items Configure Settings

Welcomns pags

Configure Library Manager Call Home =

& meniter library manager
¥ 7 Use these settings to configure the behavior of the Library Manager Call Home function
& Administer library manager

Monitor logical library Library Manager Call Home @ Enabled ¢ Disabled
Monitor WTS 1 (DELUR) Send diagnostic data with Call Home @ Enabled " Disabled
[H administer WTS 1 [DELUX)
Meniter VTS 2 (CHOPPER) Save Call Home Settings Refresh
B Adrninister VTS 2 (CHOPPER.)
Mansge security Status
Bl Service library manager Mo operation in progress.
= adminizster call hame
Test intarface Histary

Configure settings

Timestamp User ID Status Action |
Flush queus
Set heartheat 03/19/04 16:48:56 service Complete Testintrfce
Configurs netuerk 03/19/04 16:48:54 service Started Testintrfce
03/03/04 15:29:37 service Complete Updateaddrs
Gilomlzor Pacrm-Raay i @SAIERETLT) 03/03/04 15:29:32 service Started Updateaddrs <
Monitor Peer-to-Peer 2 (BIKER) N
=g
& [ [ [ |@mtemet A5

Figure 2-45. 3494 ATL Web Specialist - Configure Settings

3. Wait for the message “The Action Completed Successfully,” which indicates that the call home settings
were saved.

Flush Queue

Note: This function requires that the 3494 ATL be successfully attached to the System Console. See
[‘Adding Attached System Information” on page 2-39)

1. From the “Administer call home” list on the Web Specialist screen (Figure 2-43 on page 2-30), click
Flush queue to see [Figure 2-46| If you are prompted for a userid and password, use the default
values of service for the userid and service for the password. These values can be changed by the
3494 ATL system administrator.

B Enterprise Automated Tape Library Specialist - Microsoft Internet Explorer

File Edit VYiew Favories Tools Help

IBM Tota

Enterprise Automated Tape Li

Work Items Flush Queue

el iz e Flush Call Home Queue =

Moniter library rnanzaer
Use this button to remove all unsent entries from the Call Home gueus on the Master Console for this
library.

& Administer library manager
Monitor lagical library
Monitar VTS 1 (DELUR) Flush Queua Refresh
[H administer WTS 1 [DELUX)

Maniter VTS 2 [CHOPPER) Status

& Adrinister VTS 2 (CHOPPER) MNo operation in progress,

Manage security

History
B service library manager .
Timestamp User ID Status Action
= administer call home
Test intarface 03/19/04 16:48:56 service Complete Testlntrice
Clﬂ":Q”'E SEEimES 03/19/04 16:48:54 service Started Testintrice
Flush queus
Set heartbeat 03/03/04 16:29:37 service Complete UpdateaAddrs |
Configure netwark 03/03/04 15:29:32 service Started Updateaddrs
Monitar Peer-to-Peer 1 (DAISYDLK) ~
Monitor Peer-to-Peer 2 (BIKER) ﬁ
=
=g
€] http:/fbikelm] bucson.ibm, comfsrvrrontfenjen-us/wsfishq.htm || | |8 mternet 45

Figure 2-46. 3494 ATL Web Specialist - Flush Queue

2. Click Flush Queue to delete (flush) all the call home records on the System Console that are
associated with this 3494 ATL. All other call home records in the System Console's call home queue
will remain in the queue.

3. Wait for the message “The Action Completed Successfully,” which indicates that the System Console
queue settings were deleted.
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Set Heartbeat

The Heartbeat Interval Setting is the elapsed time between sending heartbeat call home records.

A heartbeat call home record is verification that the 3494 ATL is operating properly. A heartbeat call home
record which does not arrive at its expected interval indicates a problem.

1. From the “Administer call home” list on the Web Specialist screen (Figure 2-43 on page 2-30), click

Set Heartbeat to see [Figure 2-47| If you are prompted for a userid and password, use the default
values of service for the userid and service for the password. These values can be changed by the

3494 ATL system administrator.

S Enterprise Automated Tape Library Specialist - Microsoft Internet Explorer

Eile Edit Wiew Faworites Tools Help

IBM TotalStorage™
Enterprise Automated Tape Library Specialist

Work Ttems

Wielcome page Set Heartbeat

Set Hearthear

Monitor library manager

[ administer library manager
Monitor legical library
Monitor ¥TS 1 [DELUN)
Administer VTS 1 (DELUX)
Monitor VT 2 (CHOPPER)

Heartheat Interval Setting: |7

Set Heartbeat | Refreshl

administer UTS 2 (CHOPPER)

Status
Manage security

Mo operation in progress.
E Service library manager P! prog

El Administer call home
Test interface
Configurs settings Timestamp
Flush queue 03/19/04 16:48: 56

Set heartbeat
03/19/04 16:48:54

Histary

Configure network

User ID
service

service

Use this setting to control how frequently the Library Manager sends heartbeat Call Home records to the
Master Consaole. A setting of 0 days disables the heartbest,

Status
Complete
Started

Action

TestIntrfce
Testintrfce

- 03/03/04 15:29:37 service Complete Updateaddrs
Manitor Paet-to-Paer 1 (DAISYDLE) 03/03/04 15:29:32 service Started UpdateAddrs ©
Monitor Peer-to-Peer 2 (BIKER) J @
-l| o
EJooe T @ e 2R

Figure 2-47. 3494 ATL Web Specialist - Set Heartbeat

2. From the drop-down box, select the number of the Heartbeat Interval Setting days between 1 and 28
days, then click Set Heartbeat. Set the Heartbeat Interval Setting to 0 to disable heartbeat call home

activity.

3. Wait for the message “The Action Completed Successfully,” which indicates that the new heartbeat

interval was set.

Configure Interface Parameters

You can use this option to set the IP address and hostname alias of the 3494 ATL on the System Console
network. This option informs the 3494 ATL of the IP Address of the System Console. You also can use this
option to set the IP addresses and hostname aliases for both 3494 accessors when the 3494 ATL is part

of a high availability (HA) dual accessor complex.

This task most commonly will be used to reset the hostname alias for the 3494 ATL on the System

Console network for system identification.

1. From the “Administer call home” list on the Web Specialist screen

Figure 2-43 on page 2-30), click

Configure Interface Parameters to see [Figure 2-48 on page 2-34

If you are prompted for a userid

and password, use the default values of service for the userid and service for the password. These
values can be changed by the 3494 ATL system administrator.
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“FEnterprise Automated Tape Library Specialist - Microsoft Internet Explorer =10(x|

| Bl Edt wew Favortes Tools Help ‘ :,-'l

|BM TotalStorage™
Enterprise Automated Tape Library Specialist
Work Ttems Canfigurs Network

iclkEmne pege Master Console Interface Configuration =

B Monitor library managar .
Usze these settings to configure the interface to the Master Consale,
B Administer library managar

I Master Console 1P address [172 |, [31 [t |1
[ Monitor VTS 1 Library Manager [P Address 172 |, 31 . |1 L5 LM Bliasg [~LMa~ Path State: Configured
Bty oS 2 Library Serial Mumber 1314501
Save Interface Settings | mefresh |
<onfigure call homne Status

Flush queue
Set heartbest

No operation in progress.

Caonfigure interface parameters

History

Timestamp User 1D Status action =

02/16/05 10:48:46 service Complete TestCallHom

02/16/05 10:48:45 service Started TestcallHom

02/10/05 11:29:42 service Complete TestCallHom

02/10/05 11:29:41 service Started TestcallHom

02/10/05 11:25:00 service Complete Updateaddrs

02/10/05 11:24:56 service Started Updateaddrs

02/07/05 08:10:58 LMOR Complete Updateaddrs

02/07/05 08:10:55 LMOP Started Updateaddrs

02/04/05 15:52:14 LMOP Complete Updateaddrs 8

02/04/05 15:52:11 LMOR Started Updateaddrs N
11— Y N VE Y PR P IR T eputre Fomnlata Tactntrica =
& [ [ nternet s

Figure 2-48. 3494 ATL Web Specialist - Configure Interface Parameters

2. Enter the appropriate values for the IP Addresses and hostnames, then click Save Network Settings
to update the network information.

3. Wait for the message “The Action Completed Successfully,” which indicates that the new heartbeat
interval was set.

Note: Avoid changing the System Console's IP address from the default value of 172.31.1.1. If you must
change the System Console's IP address, change it first on the System Console. Then change to
the new IP address setting on each tape system on the System Console network.

Tape System Call Home Setup for 3584 Tape Library

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Using CETool to Configure for Call Home. Follow this procedure to configure the library for Call Home via
Master Console (FC 9217).

Notes:
» CETool is a tool that is run externally from a workstation which is directly connected to a 3584
library. CETool is not run from the System Console.
* Use CETool version 3.10 or later for this procedure.
* For more information about using CETool, refer to the 3584 M.
1. Start the CETool program.
2. Double click the CETool icon on your desktop.

3. When the CETool screen displays, click Configure Remote Service. You see [Figure 2-49 on page|
-2-35
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Remote Serviceability Configuration x|

— Call Home Options — Custarmer Info
[” Dizable Call Home Company Mame
I" Disable Heart Beat/MRPD/Data Call Home #rZ Cop
Threshold Timeout |1440 | Minutes Comtact Phone B IE;DD.555.4557
Account
I Offshift Phane # |E“3'3'555'E‘?BEI
zer D I
E I —WT| Switch Dptiong
[T Wl Switch Installed
r— Prirary Library Switch Port # I [2-1E]
Fhone #

IP Address I_ I_ . I_ . I_ —Maszter Conzale Options

¥ Enable i aster Consale

M aster C | I I I I
— Secondary |pa§;dr,e::me 172 . A . ! . !

Phare & I Master Cansole |255 |255 |255 ID
IP &ddiess . I . I . I Subnet sk - - .
Master Conzole Itssneﬂ
Host Mame

Library Frame [decimal) I2 [1-18)

Submt I Cancel | Library [P Address Iﬁ IT |1_ Iﬁ

a69m0318

Figure 2-49. Remote Serviceability via System Console

4.

© ® N O

At the Remote Serviceability Configuration screen, ensure that the Disable Call Home checkbox is
not checked.

Ensure that the Disable Heart Beat /MRPD/Data Call Home checkbox is not checked.
Ensure that the Threshold Timeout field is set to 1440 minutes.

Enter the customer phone number in the Contact Phone # field.

Enter the customer offshift phone number in the Offshift Phone # field.

In the Master Console Options area, set the following fields:

a.
b.

f.

Select Enable Master Console.

Set the Master Console IP Address field to 172.31.1.1. This is the default IP address for the
System Console.

Set the Master Console Subnet Mask field to 255.255.255.0.
Set the Master Console Host Name field to the host name of the System Console.

Determine the 3584 frame number for the model Dxx frame containing the ethernet-capable MCP
or MCA that will be used for the connection to the System Console. Type that number in the
Library Frame (decimal) field.

Notes:
* The Lxx frame is always frame 1, even if an HA1 frame (Service Bay A) is attached.

» Typically the two-character display on the MCP or the MCA will be flashing 00 and the
frame number.

Set the Library IP Address to 172.31.1.170. This is the default IP address for a 3584 library that is
attached to a System Console. If you have more than one 3584 library attached to a single
System Console, increment the last number for each additional library. As an example, the first
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library would have an IP address of 172.31.1.170, the second library would have an IP address of
172.31.1.171, the third library would have an IP address of 172.31.1.172, and so forth.

10. Select Submit.

11. Click Configure Remote Service again, and review the configuration data that you entered above.
Verify that all the data you entered is correct. Exit the CETool program. The 3584 library should now
be configured to call home via the System Console.

12. To verify that the 3584 library is configured to call home via the System Console, initiate a test call
home. At the 3584 operator panel, click Menu, and select Service —> Tests/Tools -—> Diagnostics
—> Call Home.

Configuration

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Prior to beginning System Console configuration, you must accommodate the following items:

» Attached subsystems should be configured for System Console operation. All physical cabling
connections should be complete. Subsystem IP addresses should be known, available, and documented
on a Console Configuration Sheet (see [Table 2-5 on page 2-9).

* Have available the telephone number of the analog lines attached to the System Console modems, as
well as tone/pulse and dial out prefix information, and 7-digit, 10-digit, or other local dialing conventions.

+ Complete the Console Configuration Sheet (see [Table 2-5 on page 2-9).

User Login

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

The System Console is ready for user login when you see the Console Login Screen, represented in
[Figure 2-50 on page 2-37| (microcode level may vary). There are two login options.
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TS3000 System Console

A

S

IBM TS3000 System Console V4.0.0

Login: II

Password: I

License Materials - Praperty of IBM. © Copyright IBM Corporation 2004. All Rights Resarved. IBM is a registered rademark of IBM Corporation in tha Unitad States or
ather cauntries, of bath, US Govarnment Users Restricted Rights - Usa, duplication, or disclasures restricled by GSA ADP Schadule with the 1BM Corporation,

Restart Shutdown

al4or302

Figure 2-50. Console Login Screen — Example. The Version number (Vx.x.x) will reflect your level of microcode.

Login Options

There are two ways to login to the System Console:
* Non-Authenticated

* Authenticated

Non-Authenticated:

For a non-authenticated login, in the Login field (depicted in type service. Press the Tab key
to move your cursor to the Password field and enter the case sensitive password service. This type of
login will provide access to all console configuration and service tools. This username and this password
are not valid for subsequent logins to any attached system. Non-authenticated logins are not available for
remote access (see |“Remote Access Using NetTerm” on page 3-19b.

Authenticated:

Note: If not already done, contact IBM Support for access to the IBM Authentication Server and to be
placed on the distribution list for the System Console authentication user passwords.

Follow these steps to login to the System Console. IBM Support will provide your level of authorized
access and your personal authentication ID for accessing System Consoles and tape systems.

1. At the Console Login screen (Figure 2-50), in the username field enter Service (case sensitive). Press
the Tab key to move your cursor to the Password field, and enter ibm2serv (case sensitive).

2. At the prompt “Please enter your Authentication Id:,” enter your personal authentication ID that was
provided by IBM Support. [Figure 2-51 on page 2-38| depicts a typical authentication session:
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g N

Group: Service (<- Your level of authorized access)
Creating user jdoe (<- Your Authentication ID)
Account expires on: 07/02/02
6792-22U-:78-KA5XBA1:1:4:1920: jdoe
Changing password for user jdoe
New password:

Retype new password:

passwd: all authentication tokens updated successfully
Initiating broadcast to... vtsl
Initiating broadcast to... vts2
Initiating broadcast to... vts3
Initiating broadcast to... vts4
Waiting for completion...

vtsl: Ok

vts2: 0k

vts3: Could not execute remote command
vtsd: 0k

Please logout and log back in with jdoe and password abclzyxw(<- New Password)

Press [c] to continue.

- v
Figure 2-51. Authentication Menu — Sample

3. After successfully creating a user ID and password, the system attempts to copy them to all tape
systems attached to the console (making it possible to login to each device with the same user id
and password). It is possible that the attempt to copy the user id/password will not be successful.
This process will always fail on VTS/VTC systems with code levels below 2.26, and for all attached
3494 ATLs.

Note: When the process of copying your userid/password to attached tape system is not successful,
you will need to either authenticate separately for these systems (VTS code level 2.26 or above,
A60 code level 1.16 or above, any 3592 J70, A60, or C06), or login using previous access
methods (VTS code level 2.25 and below, all 3494 ATL).

The following is a list of possible responses to the process of attempting to copy user id/password to
attached tape systems. Responses other than “Ok” are not successful responses.

Ok

* Process timed out

» System subroutine failure

e Could not create socket

» Could not establish connection
* Could not send data

* Invalid /etc/hosts file

* Invalid request

* Could not validate client

* Could not send data file

* Could not receive data file

* Could not execute remote command

Notes:

* Make a note of your password! If you lose your password, you will need to authenticate
again. Also, you will be able to use your password to log into attached subsystems (if
broadcast was successful).

» Verify the results that appear following "Waiting for completion..." This indicates the success
of copying your password to systems that are attached to the console.

* Your userid and password will be valid for the time indicated on the console, and all
systems that indicate “Ok” after “Waiting for completion...”
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* The “Waiting for completion...” process should take no longer than five minutes before
timing out. During the "Waiting for completion" process, you may skip the results of the
broadcast by simultaneously pressing CTRL + C. If you press CTRL + C, you will NOT be
notified of a failed username broadcast.

4. Enter ¢ to continue. You will be returned to the Console Login Screen.

5. Login to the console using the ID and password posted on the screen. The System Console Main

Menu shown in |Figure 2-52| appears.

TS3000 System Console

Main Menu

IBM TS3000 Sysiem Console 5.6.1
System Console Actions
Browser Funclions
TS3000 System Console Mainienance Information
Terminal
Serial Port
Hotepad
PDF Viewer
Shutdown Console...
Restart Console...
Logout...

System Console Actions

Console Configuration Utility

Telnet to Tape System

Tape Drive Service Information
Error/Defer Matrix Update
Offload User Files to Call Home
CD Copy to Console

Disk Rebuild and Restore Config
Update Console Version

Install Additional Packages
Apply Patch

Import InfoCenter

Launch Assist On-site Session

Right click

Desktop Area A

Clock

40r458

Mon Nov 30 16:44:26 2009| 5

a

Figure 2-52. System Console Main Menu. Notice that the System Console Main Menu appears after you right click

inside the Desktop Area.

Adding Attached System Information

Attention: Many procedures in this book are code specific. Before starting any procedure, go to

[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in |Figure 2-52|

2. From the Main Menu, select System Console Actions —> Console Configuration Utility. You see
the Username and password screen shown in [Figure 2-53 on page 2-40|
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Usemame and password

Sarver localhost

Message System Console

Usemams

Password

r1 Remember password

a140r300

Figure 2-53. Login Username and Password Screen

3. Type service in the Username box, type service in the Password box, then click OK to start the
Console Configuration application. You see the Console Configuration Utility screen shown in

Figure 2-54,

TS3000 System Console
Comments? Send User Feedback

WI Attached Svstems E,} Fix Acquisition

g Baclap Restore % Modem Transmission

Call Home Queue % Network Information

@ Call Home Settings 4 Offload User Files

Console Settings PE Packages

EIL Console Stams @% System Interfaces ~
©

Console Time @ Svstem Tools §
©

Figure 2-54. Console Configuration Ulility Screen

4. Click Attached Systems. You see the screen shown in [Figure 2-55 on page 2-41}
5. To add a new system, enter the system IP Address in the input fields next to Add System, and click
Add System. A warning dialog box appears, informing you that it may take several minutes. Click OK.

You may select numerous systems by using the check boxes to the left of the attached systems.
» Use the Delete Selected, Edit Selected, and Query Selected buttons to work with the list of systems.
* Use the Query All button to query all currently-attached systems.

If the application can establish contact with the attached system, the Device-Model, Serial Number,
Host Name, and Subnet Mask fields will be filled-in automatically. Otherwise, these fields will be filled
in with "NA."
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‘ r ‘De«nce Model ‘Sma] Number ‘ D ‘ HostName | IP address | SubnetMask 7%?&1038 ‘ Standby ‘ —mL%‘isl;;"
[ & | 3ss4r23 | 7843457 | 1 [ BLc-A | 17231151 [2552552550 | 1 | 1 [ ma
| & | 3ss4r23 | 78A3629 | 2 [ BLCB | 17231150 (2552552550 | 1 | 0 | ma
[ 0 [ 35843 | 783200 | 3 [ BLc.c [ 17231152 [2552552550 1 | 0 [ Na
[ T [ 3584123 | 78A3628 | 4 [ BLcD | 17231153 [2552552550 1 | 0 [ Na
[ & | sssars2 | 1340013 | 5 [ MsBF1 172311228 (2552552550 | 1 | 0 [ wa
| & | s3ss4rs2 | 1340074 | 6 | MsBF3 [ 172311203 [2552552550 | 1 | 0 [ ma
[ & | 3ss4rs3 | 7819831 | 7 | MsBF4 [ 172311204 2552552550 | 1 | 0 I
[ T [ 3584023 | 7820220 | 8 | msBF11 [172311212 [2552552550 1 | 0 [ Na
[ T [ 358423 [ 7842017 | 9 | MSBF12 [172311239 [2552552550 1 | 0 [ Na
e .1 .| o Add System | Health Legend:
__ Delete Selected| I |1\'0 Problems Returned From System Health Check
Edit Selected — =
m |— |'\.'\;mmng(s) Found in System Health Check
T QueyAl | B [Faied Status(es) Found in System Health Check
__ Toggle Standby | I |Gﬁiﬂe Status(es) Found in System Health Check
View Health I |C0mmun.icalion Failure Between TSSC and Attached System
View Events
Ipant il )
Refresh | ;:O“

Figure 2-55. Add System Screen

6.

You can set the System Console to periodically check for responses from attached systems (see Step
[12 on page 2-75).

Call home records will not be sent for systems that are marked as Standby (such as 3584L23, Serial
Number 78A3457 in the example),

To set a system as Standby or to change a Standby setting, select the appropriate system by using the
check boxes to the left of the attached systems. The numeral '1' in the Standby column indicates that
system is in standby mode. A '0' in the Standby column indicates that this system is not in standby
mode.

After you have selected the appropriate systems, you may toggle between the two settings by
repeatedly pressing the button that is labeled Toggle Standby.

When querying a large number of systems at one time, it can take from several minutes to as long as
an hour for the attached system data to be retrieved. If you have a 3958-AP1 or 3958-DE2
configuration, continue at step 4 in|“Adding a Complex System.”l If all systems have been added, click
Close this window to close the screen.

Adding a Complex System
Use this task to add a complex system if you have a 3958-AP1 or 3958-DE2 configuration.

1.
2.

o o

Right click anywhere in the Desktop to view the Main Menu as shown in|Figure 2-50 on page 2-37|

From the Main Menu, select System Console Actions —>Console Configuration Utility. You will
see the Username and password screen as shown in[Figure 2-53 on page 2-40}

Type service in the Username field; type service in the Password field, then click OK to start the
Console Configuration application. You will see the Console Configuration Utility screen as shown in
[Figure 2-54 on page 2-4

Click Attached Systems. You will see the screen shown in
Click the Complex View link in the upper right hand corner.
Select the type of Complex System you are adding from the drop down list:
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» TS3000 System Console | Close this window |

Attached Svstems Complex View

Add New Complex System Configured Complexes

Select the Complex System vou would like to add: No Complexes have been defined
i -Select Complex Type- ¥ |

al4or403

Figure 2-56. Complex System Screen.

7. Enter the serial number and host name of the complex system.

8. Enter the frame IP range for the complex system. NOTE: If the systems you are creating the complex
for are 172.31.1.100 and 172.31.1.105, then enter 100 for the frame IP range. The TSSC will find the
correct systems for creating the complex with, and add them to the complex. If the 3958-AP1
complex is a single 3958-AP1 cluster, it will only add the one system to the complex.

9. Click the Add Complex button, when the system is added correctly. You will see a message

confirming the complex system was added successfully; the screen will return with the new system
shown on the right:

TS3000 System Console | Close this window |

Attached Systems Complex View

Add New Complex System————————— 7 — Configured Complexes
Select the Complex System vou would like to add:
-Select Complex Type- v

Complex Type |Serial Number [Name |Cumplex Pair Information

—Pair 0
3958AP1 |78GABGN  |AP1 AP1, AP178HZBNN, tssc_Naples ~
Delete Complex AP1, AP178HZENN, tssc_Naples || [T
3
©

Figure 2-57. Add New Complex System Screen - 1.

10. To delete a complex system click the Delete Complex link below the Complex Type.

TS3000 System Console | Close this window |

Attached Svstems Complex View

Add New Complex Svstem——— [ Configwred Complexes
Select the Complex System you would like to add:
“SelectComplexitype il

Complex Type |Serial Number [Name |C'Dmple.\: Pair Information

—Pair 0

Srerial JSGABGN  |AP1 | APL APITSHZBNN. tssc_Naples | | [

Delete Complex AP1, AP178HZBNN. tssc_Naples || [T
S
©

Figure 2-58. Add New Complex System Screen - 2.

11. When all systems have been added, click Close this window to close the screen.
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Adding a 3584 Model SC1 Complex System

Use the following procedures to add a 3584 model SC1 shuttle complex system.
1. Right click anywhere in the Desktop to view the Main Menu as shown in|Figure 2-50 on page 2-37|

2. From the Main Menu, select System Console Actions »>Console Configuration Utility. You will
see the Username and password screen as shown in|Figure 2-53 on page 2-40|

3. Type service in the Username field; type service in the Password field, then click OK to start the
Console Configuration application. You will see the Console Configuration Utility screen as shown in
[Figure 2-54 on page 2-4

4. Click Attached Systems. You will see the screen shown in|Figure 2-55 on page 2-41|
Click the Complex View link in the upper right hand corner.
6. Under -Select Complex Type- select 3584 Complex from the drop down list:

o

Close this window
Attached Svstems Complex View
Add New Complex System Configured Complexes
Select the Complex System vou would lilee to add: ’7}(0 Complexes have been defined
-Select Complex Type-i¥|

-Select Complex Type- ‘
| 3958AP1

3958DE2
3584 Complex

Figure 2-59. 3584 Complex Screen.

al4or523

7. Enter a 3584 Complex Name and click Add Complex.

Close this window

Attached Svstems Complex View
—Add New Complex Svstem Configured Complexes
Select the Complex System vou would like to add: ’71\_0 Complexes have been defined

3584 Complex il
3584 Complex Name: |3584Complex]|

Add Comalex

al4or525

Figure 2-60. Add Complex Screen.
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The following screen will be displayed showing the complex just added:

TS3000 System Caonsole

Attached Systems Complex View

Successfully created blank 3384 complex 3584Complex1

—Add New Complex System — Configured Complexes
Select the Complex System vou 31854
would like to add: ] B Libraries ) ‘
3584 Complex [v] Complex Type MName i Connections |Station Commands
Complex
S 3584 Complex
C_omple;, Number of Libraries:
Name: 0
Add Complex 3584Complex1 Execute Command M
Delete Selected
Delete Complex

al4or526

Figure 2-61. 3584 Complex Added.

8. Click Add Library.

TS3000 System Console

Attached Systems Complex View

—Add New Complex System — Configured Complexes

Select the Complex System you

3854
would like to add: ] _ Libraries . _—
3524 Complex o Complex Type Name in Connections |Station Commands
Complex
s 3584 Complex
C_Umple:!, Number of Libraries:
Name:

0

Add Complex [AddLbrrd = 3584Complexl Execute Command v:
Delete Selected

Delete Complex

al4or527

Figure 2-62. Add Library.
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9. Under "Add Library to 3584 Complex" click on the Select 3584 dropdown box and select the first
library in the shuttle span. Click Apply.

TS3000 System Consale

Attached Svstems

Complex View

would like to add:
3584 Complex

3584
Complex

Name

Add Complex

—Add New Complex System

Select the Complex System you

— Configured Complexes

Complex Type

3854
Name ‘]_1branes
in
Complex

Connections |Station Commands

3584 Complex
Number of Libraries: 0

Add Library
Delete Selected

Delete Complex

Add Library to 3584
Complex

Select3584  lv
Select 3584
113AAA16- 13AAATE

3584Complex1

Execute Command

7822329 - 7822329 |y

— 13AAA14 - cities

Figure 2-63. Add Library to 3584 Complex.

10. The following screen shows the added library.

al4or528

TS3000 System Console

Close this window

Attached Svstems

Complex View

3584 library 13AAA16 successfully added to 3584Complex1

Add New Complex System—
Select the Complex System

vou would like to add:
-Select Complex Type- |%

i~ Configured Complexes

Complex Type Name

3854 Libraries in
Complex

Connections

Station Commands

Figure 2-64. Add Library.

3584 Complex
Number of Libraries
1

Add Library
Delete Selected

3534Complex] | [

Delete Complex

13AAALG,
13AAAL6

000000000000 | Exe

cute Command ¥| || Execute Command
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11. Select Add Library to add the next 3584 library in the shuttle span. The screen now shows TWO
libraries. Note: To delete a library: Select a box under "3584 Libraries in Complex" and click Delete
Selected ).

TS3000 System Console

Attached Systems Complex View

Command executed successfully!

Add New Complex System— — Configured Complexes

Select the Complex System 3854 Libraries in

vou would like to add: Complex Type [Name Complex Connections Station Commands

Select Complex Type- [+
ced-ompex ype 3584 Complex

[Number of Libraries:

3AAA
ssgiComplest| 2216 000000000000 [Execute Command [v] | iR Comectons .. v
Add Library o 7822329, Select System |v
Delete Selected 7822329

[Delete Complex

al4or535

Figure 2-65. Add Second Library in Shuttle Span.

12. Click on the serial number of each library in the "3584 Libraries in Complex" column to bring up the
Web Specialist for each library. Click Library > Shuttle Stations. Verify the shuttle stations are
assigned to the correct logical library for each library.

13. See the following screen. In the "Station Commands" box, use the Execute Command dropdown box
to select Discover Connections.

Note: The Discover Connections command is a process where the shuttle car will move and discover
all the stations in a shuttle connection. It will then send the data gathered to all other libraries
in the shuttle span.

TS3000 System Conscle

Attached Systems Complex View

3384 library 7822329 successfully added to 3584Complex1

Add New Complex System— — Configured Complexes

Select the Complex System 3834 Libraries in

you would lke to add: Complex Type Name Complex Connections Station Commands

-Select Complex Type- [

3584 Complex
Number of Libraries:
i

35 <
‘Add Library 3584Complex1
Delete Selected

[Delete Complex

a.n | 000000000000 | Execute Command ¥| | iExecute Command v

Execute Command

Prepare Station for Service
Set Station Online

Set Station Offline

SetLED On

SetLED Off

Blink LED

Move Cartridge

Paosition to Element

Calibrate Station

Discover Connections
Distribute Connections %
Set Station Timer

al4or531

Figure 2-66. Discover Connections.
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14. In the "Station Commands" box, under the Select System dropdown box, select the IP address of

the library where the shuttle car is currently located.

TS3000 System Conscle

Attached Systems Complex View

3584 library 7822329 successfully added to 3584Complex1

Add New Complex System—

Select the Complex System
you would like to add:
-Select Complex Type- [

— Configured Complexes

Complex Type [Name

Complex

3854 Libraries in

Connections

Station Commands

3584 Complex
[Number of Libraries:
B

Discover Connections

‘Add Library 3584Complex1 000000000000 | Execute Command ~| :SE\EE(Systemiv
SelectSystem

Delete Selected 172311170 l%
172311580

[Delete Complex

al4or532

Figure 2-67. Select System Where Car Located.

15. See the following two screens. Under Select Station dropdown box, select the station number. In the
example below the station is located in frame 3. Service Bays are NOT included in the frame count.

16. Click Execute and OK.

TS3000 System Console

Attached Systems Complex View

3584 library 7822329 successfully added to 3584Complex1

Add New Complex System— — Configured Complexes
Select the Complex System 3854 Libraries i
vou would like to add: Complex Type Name éu'mpl;;unes * | Comections Station Commands
-Select Ci lex T - %
Sec ~ompex ype 3584 Complex
Number of Libraries:
b Discover Connections bl
000000000000 | Execute G d . x]
3584 Complex] ecute Comman, o N P —
Add Library et : Select Station |
Delete Selected Select Station
Station 3 ™
®
Delete Complex. Lg
<
-
©

Figure 2-68. Select Station.

TS3000 System Console

Close this window

Attached Svstems Complex View

3584 library 7822329 successfully added to 3584Complex1

Add New Complex System—|

Select the Complex System g -
vou would like to add: Complex Type The page at http://9.11.221.79:7080 says:

Select Complex Type- [

~ Configured Compl

Station Commands

3584 Complex
Number of Libraries:

2

35840 3 UUUUUUUUU0UD | txecute Command ~
Add Library ekl L
Delete Selected

Delete Complex

a Are you sure you want to discover?

Discover Conngctions [
172.31.1.80 £

7822329,

7822329

Sttion3 [

al4or534

Figure 2-69. Execute Select Station.
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17. See the following screen. In the "Station Commands" box, use the Execute Command dropdown box
to select Distribute Connections.

Note: The Distribute Connections command is a process where the shuttle car sends the data from
the Discover process to each library in the shuttle span.

TS3000 System Console

Attached Systems Complex View

Command executed successfully!

Add New Complex System— [~ Configured Complexes

Select the Complex System 3854 Libraries in

you would like to add: (Complex Type [Name Coplex Connections Station Commands

-Select Complex Type- v

3584 Complex
[Number of Libraries:

2 13AAALG Distribute Connections [+
13AAALG . EEZEINE T C2
Add Library 3584Complex] T 000000000000 | Execute Command >l [ FSetoet Sysiom
B e 17231.1.170
i

Delete Complex

a14or536

Figure 2-70. Distribute Connections - Select Next Library in Shuttle String.

18. In the "Station Commands" box, under the Select System dropdown box, select the IP address of
the library where the shuttle car is currently located.

19. See the following screens. Under Select Station dropdown box, select the station number. In the
example below the station is located in frame 3. Service Bays are NOT included in the frame count.

20. Click Execute and OK.

TSB000 System Console

Attached Systems Complex View

Command executed successfuly!

Add New Complex System—| [~ Configured Complexes

Select the Complex System 3854 Libraries i
vou would like to add: Complex Type Name E,D;ﬂplgxrmes " |connections Station Commands
-SelectC lex Type- |v
Sec -omeex ype 3584 Complex
Number of Libraries:
2 13AAALG Distribute Connections d
= 000000000000 | Execute C; d rzEaE e
Add Library ARt ompil Scule Lomman T
Station 3 N~
(5]
Delete Complex %
<
©

Figure 2-71. Select Station.
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TS3000 System Console

Close this window

Attached Systems

Complex View

Command executed successfully!

Add New Complex System— — Configured Complexe:

Select the Complex System

L L
vou would ke to add: (Complex Type The page at http://9.11.221.79:7080 says:

-Select Complex Type- [V]

[Number of Libraries:
,

3584 Complex e Are you sure you want to distribute?

Cancel

Station Commands

Delete Complex

Add Library FemComplexl [ oya30.

U0UUUUUUUU0U | Execute Command

™

Distribute Connections [v]
172.31.1.80 lv]
Station 3 [v]

a14o0r538

Figure 2-72. Select Station - Execute.

21. Repeat steps [13 on page 2-46|through [20 on page 2-48|for each shuttle span.

22. Ask the customer to run a host discovery command (SCS). The shuttle map is now created.

23. See the following screens. Go to the Web User Interface of each library in the span. Click on Shuttle
View X where 'X' is the selected library, and verify the configuration is correct.

System Summary

Library Status:
.Accesscrr

_LTD Capacity Utilization
_3592 Capacit_y Utilization

Shuttle Stations

All Frames |+ |

Figure 2-73. Web Ul Shuttle View.

& g9,

Inventory/Audit

al4or540
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System Summary Help

Library Status:

Accessor & ok

LTO Capacity Utilization & g9

3592 Capacity Utilization & s%

Shuttle Stations & ok
Frame View Shuttle View 1

Aerial View of Active Frames: (service bays not shown)

-

al4or541

Figure 2-74. Web Ul Shuttle View.

24. If the configuration and connections are good, this verifies the host discovery was successful.

25. Under Connections, use the Execute Command dropdown box to select Connection Verify which
will retrieve and move a diagnostic cartridge to each station in the connection. Do this for each span
in the complex. Connection Verify commands can be run concurrently.

T$3000 System Console Close this window
Attached Svstems Complex View
Command executed successfully!
Add New Complex System— —Configured C;
Select the Complex System vou 5
s e Complex Type Name éﬁ;ﬁ‘:’m“ ™ \Connections Station Commands
-Select Complex Type- [+ 3584 Comples
[Number of Libraries: 2 At
Add Libay ssgaComplext | ontl® | 000000000000 [Excite Command . [v] | [Exeeute Command %]
7822329 Execute Command
Delete Selectad H 820320 Set Connection Online N
Set Connection Offline b
Delete Complex Prepare Carfor Service 5
Comecton Vety [ I
Span Verify =

Figure 2-75. Connection Verify.
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26.

Under Connections, use the Execute Command dropdown box to select View/Set Connection

Serial. Type in the serial number of the connection on the label located on the base station (where
the agency label is located) and click Update.

27.

TS3000 System Console

Do the above step for each connection in the complex.

Close this window

Attached Systems

Complex View

Add New Complex System

Select the Complex System you

would like to add:
-Select Complex Type-[»

—Configared Complexes

3854 Libraries in

[Delcte Complex

Complex Type Nameo, o Comections Station Commands
3584 Complex
PNumber of Libraries:2 | | o000
Lab340RASCar Bsasciie Gommand v
3
& ; |Execute Command
Add Library RS | (o | TESTCONNECTION |Oeniefommenc Exscute Cammand =

O 3anale | TESTCONNECTION2 |SetConneciion Offine

Prepare Car for Service
Connection Veriy
Span Verify

View/Set Connection SE’IE|

aldorb46

Figure 2-76. View/Set Connection Serial.

TS3000 System Consale

Close this window

Attached Systems

Complex View

Add New Complex System

Select the Complex System you

would like to add:
~Select Complex Type- [+

[~ Configured Complexes

3854 Libraries in

232

Complex Type Name |0 e Connections Station Commands
3584 Complex
Number of Libraries: 2 Lab340RASCar View/Set Connection Serial [

TESTCONNECTION | Execute Command

v

RAS sanats | TESTCONNECTION2 Execuls Command ] |[Executs Command v
Ui ~
= | Sera[1388829 | [Updaje k
Delete Complex i g
<
©

Figure 2-77. Connection Serial Number.

28. When completed, click Close this window to close the screen.
29. After successful completion, turn the system over to the customer.
30. Go back to the Shuttle Feature Code install instructions to complete the installation.
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Installing DS6000 Graphical User Interface (GUI)

Use this procedure to install the DS6000 graphic user interface (GUI). Only perform this procedure if you
are attaching a TS7740 (3957) with a 3956 CC6 to the System Console.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39[

2. From the Main Menu, select Browser Functions > DS6000 GUI Functions > Install GUI. A Terminal
window appears, and prompts you to insert the DS6000 Graphical User Interface CD-ROM.

-
il

Pleaze inzert TSSC DSEOO0 Graphical User Interface disk and hit <enter::
Inztallation may last up to 20 minutes, FPleaze be patient,,.

SICCESS: The DSEOO0 GUT iz now installed,

Please Press <Enter> to exit,

[
al4or318

Figure 2-78. Install DS6000 GUI

3. Insert the CD-ROM, and press Enter. Installation of the GUI begins. This can take as long as thirty
minutes to complete.

4. The message "SUCCESS" displays when the installation is complete. Remove the CD-ROM from the
System Console.
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Installing Storage Manager (SM) Graphical User Interface (GUI)

Attention: Many procedures in this book are code specific. Before starting any procedure, go to

[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level. Please be sure to follow

the installation screens exactly, as you must make sure to not install the Support Monitor in code level
10.50 or greater.

1.

Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39[

2. From the Main Menu, select Browser Functions > Storage Manager GUI Functions > Install GUI. A

Terminal window that is similar to|Figure 2-78 on page 2-52 appears and prompts you to insert the
appropriate Storage Manager Graphical User Interface CD-ROM.

Insert the CD-ROM, and press Enter. Installation of the GUI begins. This can take as long as thirty
minutes to complete.

Use this procedure to install the Storage Manager graphic user interface (GUI). Only perform this
procedure if you are attaching a 3957-V06/V07 (with a DS4000 cache), 3957-VEA/VEB, 3958-DD1,
3958-DD3, 3958-DD4, or a 3958—-AP1 to the System Console.

If you have a previously installed Storage Manager GUI, you will be presented the current levels of
code installed as well as the level you are currently installing. If you are installing the 10.50 level or
greater of Storage Manager GUI, the Versions to be installed: section will be blank. Press y to
continue with the install.

Note: If you are installing the 10.50 or greater GUI, continue through the following screen shots. If you
are installing the 10.36 GUI continue at step

Table 2-6. Code Level 10.50 or Greater Installation Screens

Figure 2-79. Welcome Screen

IBM System Storage DS Storage Manager 10

The installation program will allow you to select and install the
storage array host software and tools reguired to configure,
manage, anc monitor a storage array.

IBM System Storage™ DS Storage Manager \“*%

Cance|

al4or445

Figure 2-80. Introduction Screen

al4or453
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Table 2-6. Code Level 10.50 or Greater Installation Screens (continued)

IBM Sysiem Storage DS Storage Manager 10

Cance|

IBM System Storage DS Storage Manager (Enterprise
Management)
(C) Copyright International Business Machines Corporation,
2003-2009 Licensed Material -
Program Property of 1BM
All Rights Eeserved.

US Gowernment Users Restricted Rights - Use, Duplication, or
disclosure restricted by C5A ADP Schedule Contract with 1BM
Corp.

Figure 2-81. Copyright Statement

aldor446

IBM System Storage D3 Storage Manager 10

Installation and Use of IBM System Storage DS Storage
Manager 10 Requires Acceptance of the Following License
Agreement:

1BM License Agreement for Machine
Code

Licensee accepts the terms of this IBM License Agreement for Machine
Code ("License Agreement) by Licensee’s initial use of a Machine that
contains Machine Code fincluding Licensed Internal Codel, whether the
rightful possessor of a Machine (the “Licensee*) obtains such Machine
from IBM or from a third party.

This License Agreement applies to all Machine Code provided to
Licensee for such Machine and replaces any license agreement =
5 Kk o Machina Cade Thic |

pi the terms of the Lice

) | do NOT accept the terms of the License fgreement

al4or4d7

Figure 2-82. License Agreement

Warning

An existing version of storage array configuration files already
reside on this computer.

If wou choose to continue, the existing files will be ovenwritten
with new files.

If wou weant to keep your existing configuration information, back
up your configuration files (emwback.bin and emwdata.bin) before
continuing.,

Click the OF button to continue the software installation twhich
will ovenvrite any existing configuration information) Click the
Cancel button to return to the previous step, Click the Exit button
to quit the installation,

| Cancel || loK

Figure 2-83. Overwrite Warning
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IBM System Storage DS Storage Manager 10

Cancel

Typical (Full Installation)
Installs all of the software you'll need. This is a safe choice if
you do not know which installation type to select

Management Station

Includes the software needed to configure, manage, and
monitor 2 storage subsystem. This option is for your
workstation or management PC

Host

Installs the storage subsystem sener software. Use this type of
installation for the host {server) connected to the storage
subsystem

Custom
Choose this option to customize the features to be installed.

Frevious MNext

al4or505

Figure 2-84. Select Custom Installation Type
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Table 2-6. Code Level 10.50 or Greater Installation Screens (continued)

IBM System Storage DS Storage Manager 10

Install Set |Custom

[¥|DS Storage Manager 10 Client =
000 vioniol

[v|DS Storage Manager 10 Utilities
[v|DS Storage Manager 10 Agent

4

4

[ »

r Description
The Support Maonitar is a wek-based application that can he
configured to automatically collect support data for the storage
arrays managed by the starage management software. You
can optionally upgrade the Support Monitor 1o provide
extended functionality, including trend and usage anakysis.

Figure 2-85. Make sure the checkbox next to the Support Monitor entry is NOT selected. All other entries should

remain checked.

a14or503

‘*} IBM System Storage DS Storage Manager 10

Please Review the Following Before Continuing:

Install F_p]_deh
Jopt{IBM_DS

Product Components:
DS Storage Manager 10 Client,
DS'Storage,Manager3 31_'O_-Util’\tie_s/
DS Storage Manager 10 Agent

Required Disk Space
572 MB i

Available Disk Space
7,048 MB

Figure 2-86. Pre-Installation Summary

a14o0r506

. IBM_S'ﬁm Sfomge TJS_S_to_ri\E Managerﬁ £

IBIM System Storage™ 0§ Storage Manager

Figure 2-87. Installing the GUI

Installing... Java Runtime Environment
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Table 2-6. Code Level 10.50 or Greater Installation Screens (continued)

= IBM System Storage DS Storage Manager 10 -

The installation completed successtully. Files were installed to

fopt/IBM_DS

Select "Done” to exit the installation program.

aldor452

Figure 2-88. Install Complete

5. The message "SUCCESS" displays when the installation is complete. Remove the CD-ROM from the
System Console.

Installing ProtecTIER Manager Graphical User Interface (GUI)

Use this information to install the ProtecTIER Manager graphic user interface (GUI). Use this information
only if you are installing a 3958 system to the System Console.

To read about launching the GUI, see [‘Launching ProtecTIER Manager Graphical User Interface (GUI)” on|

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39}

2. Select Browser Functions > ProtecTIER Functions > Install GUI. You are prompted to insert the CD
into the TSSC CD drive. Press Enter. Installation of the GUI begins.

3. You see the Introduction screen in [Figure 2-89 on page 2-57 Click Next.
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[P ——

P Introduction

[ Choose Install Falder

[> Choose Link Faolder

[ Pre-Installation Summary
[= Installing...

[ Install Complete

Lancel

Installanyswhiere will guide wou thraugh the installation of

ProtecTIEE Manager.

It is stronghy recommended that wou quit all programs befare

continuing with this installation.

Click the 'Wext’ button to proceed 1o the next screen. If wou want
10 change something on & prewvious screen, click the ‘Previous’

hutton.

You may cancel this installation at amy time by clicking the
‘Cancel' button.

Presdaus

a140r390

Figure 2-89. Introduction to ProtecTIER GUI Manager InstallAnywhere Screen

4. Read and accept the terms which are depicted on the License screen (not shown). Select | accept
both the IBM and the non-IBM terms, and click Next.

5. You see This screen shows you where the ProtecTIER GUI Manager software will be

installed.

P —

+/ Introduction

«/ Choose Install Falder

+/ Choose Link Falder

B Pre-Installation Summary
[> Installing...

[ Install Complete

Cancel

Figure 2-90. Pre-Installation Summary Screen

Please Review the Following BEefore Continuing:

Product Name:
ProtecTIER Manager

Install Folder:
fopt/IBM/PTManager

Link Folder
foptf/IBM{PTManager

Disk Space Information (for Installation Target):
Required: 132,151,433 bytes
Available: 2,436,018,176 bytes

Prewious Install

a14o0r392

6. Click Install to continue. You see an Installing ProtecTIER Manager screen (not shown).
7. When the installation successfully completes, you see an Install Complete screen (not shown). Click

Done.
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Upgrading ProtecTIER Manager Graphical User Interface (GUI)

Use this information to upgrade the ProtecTIER Manager Graphical User Interface (GUI). Use this
information only if you are installing a 3958 machine to the System Console.

To read about launching the GUI, see [Launching ProtecTIER Manager Graphical User Interface (GUI)” on|

Attention: Many procedures in this book are code specific. Before starting any procedure, go to

|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1.
2.
3.

Right click from anywhere in the Desktop to view the Main Menu shown in |Figure 2-52 on page 2-39l
Select Browser Functions » ProtecTIER Functions -»Upgrade GUI.

You will be informed that the existing version of ProtecTIER Manager will be uninstalled before
updating. Continue by typing y and press Enter.

The uninstall program will launch and you will see the Uninstall ProtecTIER Manager window shown
in |Figure 2-91| Click Uninstall.

= Uninstall ProtecTIER Manager r

B Introduction Apout 1o uninstall...

B Hrlestaiing ProtecTIER Manager

[> Uninstall Complete

This will remove features installed by InstallAmswhere. It will not
remowe files and folders created after the installation.

Previous Uninstall

ald4ord27

Figure 2-91. Uninstall ProtecTIER Manager Window

5.

2-58

A message will be displayed stating that all items were successfully uninstalled. Press Done to close
this window.

Next you are prompted to insert the ProtecTIER Manager Graphical User Interface disk. Insert the CD
and press Enter.

You will see the [Figure 2-92 on page 2-59| Click Next.
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IBM ProtecTIER Manager

P Introduction Installamywhere will guide wou through the installation of

[> Choose Install Folder R SRS e

> Choose Link Folder [t is strongly recommended that you gquit all programs befare

B> Pre-Installation Sumrmary cantinuing with this installation.

B Installing. . Click the 'Mext' button 1o proceed to the next screen. I you want

[= Install Complete to change something an a previous screen, click the 'Prewvious'
button.

You may cancel this installation at amy time by clicking the
‘Cancel' button.

Cancel Previous

aldord28

Figure 2-92. Introduction Screen

8. Read and accept the terms which are depicted on the License screen (not shown). Select | accept
both the IBM and the non-IBM terms, and click Next.

9. You will see the [Figure 2-93| This screen shows you where the ProtecTIER GUI Manager software
will be installed.

IBM ProtecTIER Manager

+ Introduction Please Review the Following Before Continuing:

+/ Choose Install Falder

 Choose Link Folder Product Name:

= Pre-Installation Summanry ProtecTIER Manager

F= Installing. . Install Folder:

[= Install Complete fopt/IBM/PTManager
Link Folder:

fopt/IBM/PTManager

Disk Space Information {for Installation Target):
Required: 132,125,413 bytes
Available: 3,638,444,032 bytes

Previous

)
N
T

S
<
3

©

Figure 2-93. Pre-Installation Summary Screen

10. Click Install to continue. You see an Installing ProtecTIER Manager screen (not shown).
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11. When the installation successfully completes, you see an Install Complete screen (not shown). Click
Done.

Console Settings

The System Console comes pre-configured with the default IP address 172.31.1.1, subnet mask
255.255.0.0, and hostname 'tssnet1,' on the Internal Network Interface (see [Figure 2-94 on page 2-61[).
This interface is used to communicate with the tape subsystems, as seen in[Figure 2-1 on page 2-2|
Normally, you will not need to change these settings, since the System Console operates on a dedicated
network.

The System Console External and Grid Network Interfaces do not come pre-configured. You must use the

Console Settings dialog box to set up these interfaces, if you are to use Intranet (high-speed) call home

method or Autonomic Ownership Takeover Manager function.

1. Right click from anywhere in the Desktop to view the Main Menu, shown in|Figure 2-52 on page 2-39|.

2. From the Main Menu, select System Console Actions -—> Console Configuration Utility. The Login
screen displays, as shown in [Figure 2-53 on page 2-40|

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen shown in
[Figure 2-54 on page 2-40|

Note: To login remotely from another System Console, you must obtain an Authentication ID (see
FLogin Options” on page 2-37). Launch your browser, and enter the System Console location
into the Address field. Enter your Authentication ID into the Username field and your password
into the Password field. Click OK to start the Console Configuration utility.

4. Click Console Settings. You see [Figure 2-94 on page 2-61|
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[ Close this window ]

IP Settings

SSL Certificates

Security Settings Custom Firewall Settings

—Internal Network Interface

IP Address: [ | [ . ]
Subnet Mask: I ] | |
Status: Connected

—External Network Interface

Obtain IPv6 Address:

Enable: © [Pv4 O IPv6 @ Both
[ Obtain IP Address Automatically

IP Address: | J |_H¥|D
Subnet Mask: |J |

© Using DHCP o Usmg Stateless Autoconfig @

Manually

‘ Refresh H Save Changes H Cancel |

IPv6 Address: ¥| :] :] [:| |O_|:\L}:|u |D_\ / |D
Status: Connected
—Grid Network Interface
Enable: O IPv4 O IPv6 @ Both
IP Address: IS[Z][;[ 6 ]
Subnet Mask: RE] ; |El . @| [Z
GridGaeway:[10_|.1__J.i__|.[
Obtain IPv6 Address: O Using DHCP O Using Stateless Autoconfig @ Manually
v address:( J:( ) ) )0 )0 I ) 1)
pveGaeway: [ J:( J:( J:(J:(_J:_J:(C_ )i )
Status: Disconnected
—System Properties
Hostname: | % |
Domain Name: | |
onst:( ). ). ). ]
onsz:( ). ). ). ]
pnsa: [ J.[ J.[J.[]
wveonst:(J:( J:(_J:(C_J:(_J:(_J:(_J:()
evepnsz():( ). J:(_J:(C_J:(_J:(C_J:(C]
wveonsa:(__J:( J:(_J:(_J:(_J:[ J:(_J:[]
Search Domain 1: ]
Search Domain 2: [ l
Search Domain 3: | |
Default Gateway: |- |.[__J.[_|
1Pv6 Default Gateway: [_] [:][:J : |:] : [_] |:\ : :| §
$
©

Figure 2-94. Console Settings

5. You can change the entries by typing new values in the indicated fields. If you need to change the

hostname or the internal IP address of the System Console, you also will need to change this
information on each tape system attached to the System Console. See [‘Tape System Call Home Setup|

for VTS, VTC, and Tape Controllers” on page 2-21| or[‘Using 3494 ATL or 3953 Enterprise Library

Controller Web Specialist to Change System Console Settings” on page 2-30|to perform these

additional tasks.

Note: See [Feature Codes” on page 2-2|to locate external ports for Grid and External Network

Interfaces.

» All network interface entries display their status as either Connected or Disconnected.
These designations signify whether or not the TSSC sees a working connection at each

interface, and

they can be used to help troubleshoot connectivity problems.
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6.

8.

Contact your network administrator to obtain an unused Grid IP address if you plan to set up
Autonomic Ownership Takeover Manager (AOTM) for the IBM TS7700 Virtualization Engine. To set up
AOTM, connect your Grid network to the Grid Network Interface that is located in the back of your
server. See [Figure 2-6 on page 2-5| [Figure 2-8 on page 2-6} and [Figure 2-10 on page 2-7|for locations.

Use I‘Setting Up Autonomic Ownership Takeover Manager (AOTM)” on page 2-16| to enter the
connection settings. Return here after setting up and testing AOTM.

Note: The Grid Network Interface should only be used for TS7700 peer-to-peer networks with the
AOTM function. Unless previously mentioned, other uses are not supported.

Contact your network administrator to obtain an internet connection, if you have selected the IBM
Intranet or Autoselect call home methods. To set up the broadband interface, connect the internet
connection to the External Ethernet Interface that is located in the back of your server. See
fon page 2-5} [Figure 2-8 on page 2-6} or|Figure 2-10 on page 2-7|for location. Enter the information for
this interface into the External Network Interface input area depicted in |Figure 2-94 on page 2-61l

Notes:

* The External Network Interface should only be used for call home purposes. Unless
previously mentioned, other uses are not supported.

* When you set up the External Network Interface, you might need to enter a default gateway
setting. Obtain this setting from your network administrator, and enter the address into the
Default Gateway input area of [Figure 2-94 on page 2-61

» After you have entered an address, you can test the interface by pinging another location on
the customer network. Click on Network Information from the screen in|Figure 2-54 on page]
for this option.

» The External and Grid networks can both be assigned IPv6 addresses. This can be done
manually through DHCP (if a DHCPvV6 server is running on the network) or by using IPv6
Stateless Auto-configuration.

» If IPv6 is enabled for External, the IPv6 DNS and IPv6 Default Gateway entries will appear
in System Properties.

+ Selecting IPv4 will hide these entries if they are not being used. Selecting IPv6 will hide the
IPv4 entries.

Click Save Changes.

Security Settings

Use this page to create, modify, delete and assign authentication policies. There are two type of policies
for authentication, System Storage™ Productivity Center or native LDAP using Microsoft Active Directory
(MSAD). LDAP use is dictated by the customer's environment, so you must collect the pertinent
information from the customer when creating policies and logging in to the TSSC.

The authentication policy will apply to both local and remote accounts.

Use this information to update Security settings.

1.
2.
3.

Right click from anywhere in the Desktop to view the Main Menu, shown in|Figure 2-52 on page 2-39|.
From the Main Menu, select System Console Actions -> Console Configuration Utility.

From [Figure 3-93 on page 3-74} select Console Settings -> Security Settings. You see the screen
shown in [Figure 2-95 on page 2-63}
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TS3000 System Console

IP Settings Security Settings SSL Certificates Custom Firewall Settings
Authentication Policies —Policy Configuration
Active policy: Policies disabled *Policy Type:
Direct LDAP O Storage Authentication
Policy Name Type *Policy Name
SASpolicy Storage Authentication Service .

LDAPpolicy LDAP Primary Server URL

\ Assign Policy | Delete Policy \ Cancel ‘

Alternate Server URL

*Base Distinguished Name

DJLDAP Attributes
| New Policy ‘ Cancel

Test user authentication and authorization.
UserID:
Password:

al4or596

Figure 2-95. Security Settings

Creating a Storage Authentication Service (SAS) policy or Direct LDAP policy:

1. Click the New Policy Button in the Policy Configuration panel to enable the configuration fields.
2. Select the policy type SAS or Direct LDAP.

3. Enter values for the following required fields:

Policy Name

The name of the policy that defines the authentication settings. The policy name is a unique value
composed of one to 50 Unicode characters. Blank spaces and special characters are not permitted.

Primary Server URL

The primary URL for the Storage Authentication Service. The value in this field is composed of one to 254
Unicode characters and takes one of the following formats:

https://<server_address>:secure_port/TokenService/services/Trust
1dap://<server_address>:port

Note: If this value is a Domain Name Server (DNS) address you must activate and configure a DNS
server on Console Settings -> IP Settings page.

Enter values for any of the optional fields you want to define:
Alternate Server URL

The alternate URL for the Storage Authentication Service if the primary URL cannot be accessed. The
value in this field is composed of one to 254 Unicode characters and takes one of the following formats:

https://<server_address>:secure_port/TokenService/services/Trust
1dap://<server_address>:port
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Notelist:

The server address value in the Primary or Alternate Server URL can be an IP or DNS address. Valid IP
formats include:

IPv4

Is 32 bits long, consists of four decimal numbers, each ranging from 0 to 255, separated by periods, like:

C 98.104.120.12 )

IPv6

Is an 128-bit long hexadecimal value enclosed by brackets and separated into 16-bit fields by colons, like:

(: [3afa:1910:2535:3:110:e8ef:ef41:91cf] :)

Leading zeros can be omitted in each field, so that :0003: can be written as :3:. A double colon (::) can be
used once per address to replace multiple fields of zeros. For example,

[3afa:0:0:0:200:2535:e8ef:91cf]
can be written as:
[3afa::200:2535:e8ef:91cf]

If the Primary or Alternate Server URL uses the https protocol, a certificate for that address must be
defined on the SSL Certificates page or retrieved with the Retrieve Certificates.

Server Authentication

Values in the following fields are required if WebSphere® Application Server security is enabled on the
WebSphere Application Server hosting the Authentication Service.

User ID

The user name used with HTTP basic authentication for authenticating to the Storage Authentication
Service. This field supports a maximum length of 254 Unicode characters.

Password

The password used with HTTP basic authentication for authenticating to the Storage Authentication
Service. This field supports a maximum length of 254 Unicode characters.
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—Policy Configuration
*Policy Type:
_ Direct LDAP @ Storage Authentication
*Policy Name
|sASpolicy |
*Primary Server URL
[https:h’lz?.o.0.1:BDBDlTokenSewicefsewices!Trust ]

atrii rtificate
Alternate Server URL
|https /127 0.0 2:8080/ TokenService/services/Trust |

Auser ID and password are required if authentication is enabled on
the server hosting the authentication service.

*User ID: [Admin |

*Password: [..... ]

a14or591

|- New Policy | | Save Changes | lit Poli | Cancel

Figure 2-96. Creating Storage Authentication Policy

Direct LDAP
Values in the following fields are required.
User Distinguished Name

The user distinguished name used to authenticate to the LDAP authentication service. This field supports
a maximum length of 254 Unicode characters. For example:

( CN=Administrator,CN=users,DC=mycompany,DC=com )

If you selected Add Direct LDAP Policy in Step 2, enter values for LDAP Attributes:
Base Distinguish Name

The LDAP distinguished name (DN) that uniquely identifies a set of entries in a realm. This field is
required but blank by default. The value in this field is composed of one to 254 Unicode characters.

Username Attribute

The attribute name used for the username during authentication. This field is required and contains the
value uid by default. The value in this field is composed of one to 61 Unicode characters.

Group Member Attribute

The attribute name used to identify group members. This field is optional and contains the value member
by default. This field can contain up to 61 Unicode characters.
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Group Name Attribute

The attribute name used to identify the group during authorization. This field is optional and contains the

value cn by default. This field can contain up to 61 Unicode characters.

Username filter

Used to filter and verify validity of an entered username. This field is optional and contains the value

(uid={0}) by default. This field can contain up to 254 Unicode characters.

Group Name filter

Used to filter and verify validity of an entered group name. This field is optional and contains the value

(cn={0}) by default. This field can contain up to 254 Unicode characters.

—Policy Configuration
*Policy Type:
@® Direct LDAP © Storage Authentication
*Policy Name
LDAPpolicy |
*Primary Server URL
lldap://127.0.0.1:8080 |

Hetrneve Certncat

Alternate Server URL

[ ]

*Base Distinguished Name

|_CN=Adrninistrator.CN=users.DC=rn3rc0mpany.DC=cnrn]

LDAP Attributes
Username Attribute: [uid

Group Member Attribute: [member

Group Name Attribute: [cn

User name filter: [(uid:{D})
Group name filter: [(cn:{D})
| Mew Policy ‘ | Save Changes ] Edit Policy | Cancel |

Figure 2-97. Creating LDAP Policy

Note: These fields will depend on the customer's individual network configuration. Consult with them to

collect the necessary values.

4. Click Save Changes to save the policy.
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Notes:
» The Retrieve Certificates button will retrieve certificates for both the primary and alternate server.

Edit Policy

1. In the Authentication Policies Panel (figure n) select the policy to be edited.

2. Click the Edit Policy Button and the fields will be enabled in the Policy Configuration panel.
3. Make the changes.

4. Click Save Changes.

— Authentication Policies

Active policy: Policies disabled

| Policy Name | Type
| ® | SASpolicy | Storage Authentication Service
| O | LDAPpolicy | LDAP
‘_ Assign Policy | | Delete Policy H Cancel

al4or592

Figure 2-98. Policies Panel

Notes:
- If the URL changed, it is necessary to Retrieve another Certificate
- If the policy name changed, a new policy will be created

- You are required to re-enter the Authentication Password to save any changes made to SAS policies

- Every time a policy is edited, it must be re-tested before it can be assigned as the active policy

Test Policy

This section is to test policies already saved. With this function you can verify that the configuration of the

policy is correct.
1. Enter a valid user and password.
2. Click Test.

Test user authentication and authorization.
User ID: | |
Password: | ]
Tost.

al4or594

Figure 2-99. Test Policy
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| Notes:
I - This function will be only available on policies already saved.
I - Before assigning a policy, the policy should be tested to guarantee a correct log in.

Assign Policy
1. In the Authentication Policies Panel (figure [Policies panel figure above]) select the policy.

|
I
| 2. Test the policy in the right panel at the bottom to make sure that is correctly configured (figure [Test
I Policy figure above]).

|

3. Click the Assign Policy button in the Authentication Policies panel.

| Notes:
| - If the Policy has not been tested, you will not be able to assign the policy
| - Only one policy can be active at a time.

| Delete Policy
I 1. In the Authentication Policies Panel (figure [Policies panel figure above]) select the policy to delete.
| 2. Click Delete Policy.

| Note: When LDAP authentication is enabled, remote and local access is controlled by the LDAP server.
I Service access requires the user to authenticate through the normal service login and then
I authenticate again using the IBM service representative Direct LDAP Policy.

| System Storage Productivity Center and Tivoli Storage Productivity Center

| You can use the System Storage Productivity Center (SSPC), a server operating with the Tivoli® Storage
| Productivity Center (TPC) software, as an LDAP proxy to enforce Access Controls on the TSSC.

| Native LDAP

| You can use a Microsoft Active Directory (MSAD) Lightweight Directory Access Protocol (LDAP) server
| directly to centrally manage access controls on the TSSC.

| SSL Certificates
| Use this page to display, add, and delete SSL Certificates.

| If any SSL certificates have been retrieved, they will be displayed in a table as seen below.

3000 System Console
1P Settings Security Settings SSL Certificates Custom Firewall Settings
—SSL Certificates
\ Alias Issued To Fingerprint (SHA Digest) Expiration
=WIN- /i = i iav 27 21:05:

FsaScen CNZWIN-TLUVOSBNMIT, OZIBM. | A F:22.65:1B:£9:C5:F9:24:39:AA22 ADT9:A:17:CA:12:36:5B:9 | T ™ M 27 210550 UTC
| Delete Selected Entry |
*Alias
\ \
*Server URL

*Port
I |

\ Retrieve Certificate H Cancel

al4or593

|
| Figure 2-100. SSL Certificates Page
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Add SSL Certificate

1.

2.
3.
4.

Enter an Alias for the Certificate
Type the URL

Type the port

Click the Retrieve Certificate button.

Delete SSL Certificate

1.
2.

Select a SSL Certificate
Click the Delete Selected Entry button.

Customizing Firewall Settings
Attention:
« Many procedures in this book are code specific. Before starting any procedure, go to

|“Maintenance Starting Point,” on page 1-1| to determine the code level.

* You must request and receive permission from the customer each time that you update firewall

properties.

Use this information to update the firewall settings.
Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|
From the Main Menu, select System Console Actions > Console Configuration Utility.
From the |[Figure 3-93 on page 3-74, select Console Settings > Custom Firewall Settings. You see

1.
2.
3.

the screen shown in|Figure 2-101 on page 2-70|
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|[ Accept ”[ Drop ]|Inte;rface ‘Direction |P0rt Name ‘Por‘t Number
o |®  [Estemal IN  [FTP 21
|o |®  [Extemal [N |HTTP 180
o |®  [Extenal IN  [HTTPS 443
|® |0 [Extemal [N [pING TcMP
o |®@  [Fstemal [N [sSH 22
o |®  |Estemal IN  [SSHTUNNEL [9088
o |®  [Extemal IN  [TELNET |23
lo |®  [External IN  [TSSCGUI  [7080
l® |©O  [Extemal OUT [DNS 53
o |®@  [Extemal oUT  [FTP 21
|® |©O  [Extemal oUT  [HTTP 180
o |®  [Extenal [OUT  |[HTTPPROXY N/A
|® |©O  [Extemal [OUT  |[HTTPS 443
|® |O  [Extemal OUT [PING IcMP
o |®  [Extemal OUT [SNMPTRAP (162
|o |®  [Extemal OUT  [ssH |22
o |®  [Esternal [OUT  [SSHTUNNEL [9088
|o |®  [Estemal [OUT [TELNET |23
o |®  [External OUT  [TSSCGUI  [7080
l® lo |eid |IN  |conm 9666
o l@ |eia |~ [FTP 21
l® o  loid [N [HTTP 20
|® O  |Gid [N |HTTPS 443
l® lo |Gid [N  [PING cMP
|® o |Gid | |ssH 22
o |®@ |Gid [N [TELNET |23
o l® |Gid [N [TsscGUT  [7080
|® O  [Gid [OUT |coMM  |9666
o |®@ |orid |oUuT [FTP 21
l® o |Gid |ouT |HTTP |80
l® |0 |Gid |oUuT  |HTTPS 443
l® o  leid |ouT  [PING jtavi
|® O [Gid [oUT |ssH 22
o |®@ |Gid [OUT |TELNET |23
o |® |Gid |ouT [TsscGur  [70%0 I
‘[ Cancel H Update Firewall Settings ” Restore Defaults l %

Figure 2-101. Customize Firewall Settings
4. Click the radio button in the Accept column to authorize a port or in the Drop column to disallow a port
name, then Click on Update Firewall Settings after you have made all your selections.
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Configuring Call Home Settings Electronic Customer Care

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39

2. From the Main Menu, select System Console Action -> Console Configuration Utility. You see the
login prompt shown in [Figure 2-53 on page 2-40

3. Type service in the Username field, service in the Password field, then single click OK to start the
Console Configuration application. You see the menu shown in|Figure 2-54 on page 2-40|

4. Select Call Home Settings. You see the screen shown in|Figure 2-102|

Note: In the following steps, for any changes made to other than Delay Call Home, Unlock Call

Home, or Reset Modem, you must scroll down, if necessary, and click 'Apply".

TS3000 System Console Close this window
General Settings Location Settings Phone Settings Machine Settings Disposition Settings SNMP Settings AOS Settings
Call Home Heartbeat
[7] Enable Call Home Enable System Console Heartbeat
Heartbeat interval: | 12 |Z| Day(s)
Select Call Home Interface: Modem Connactions
Modem _ -
z @ Allow Inbound © Disallow Inbound
@ Ethernet

Autoselect

Call Home Communication Setup:
Modem Port: | /devittyS0

Reset Modem

Ethernet Communication:
@ Direct Connection
Connect Through HTTP Proxy
Proxy server requires authentication

Proxy Address:

Proxy Port:

al4or559

Figure 2-102. General Settings Screen (Call Home and Heartbeat)

5. Select an interface to be used for call home. See
* Modem
— If you select the modem call home interface, the Modem Port selection box under Call Home
Communication Setup enables.
— If you select the modem port by using the Modem Port selection box: Select "/dev/ttyS0"
("/dev/ttyS0" is the serial port COM1 and "/dev/ttyS1" is serial port COM2, as labeled on the
back of the System Console).

OR

If the System Console has two modems and has two analog telephone lines attached, in the
Modem Port display, select "/dev/ttyS1" as the Call Home Modem Port.

Notes:
— Using this method will disable all broadband call home.
— If "/dev/ttyS1" is selected but unavailable, no call home activity will take place on the
console and there will be no warning or error messages given.
— When two modems are installed, the modem on COM1 can be configured to be the
inbound modem, and the modem on COM2 can be configured to be the outbound

Chapter 2. Installation  2-71



modem. If only one modem is installed, it must be installed on COM1, and it will be
used for inbound and outbound communication.
— Call Homes that are present in the Call Home Queue will be sent home every 5
minutes to ensure the modem line is not always in use.
e IBM Intranet:
— If you select the IBM Intranet call home interface, the Ethernet Communication section will
enable, under the Call Home Communication Setup.

— Select a method for broadband call home based on the customer's network configuration:

- Direct Communication implies there is not an HTTP proxy between the configured TS3000
and the outside network to IBM. Selecting this method requires no further setup.

- Connect Through HTTP Proxy implies there is a customer HTTP Proxy server which the
customer requires all call home traffic to go through. When selecting this option, enter the
Proxy IP Address and Proxy Port. If necessary, enter any required proxy server username
and password. The customer should supply these values.

Notes:

- Using this method will disable all modem call home transmission (outbound only).

- Ensure that the External Network Interface has been set up in Console Settings.

- Obtain the IP Address, Subnet Mask, and Default Gateway from the customer.

- Port 443 (HTTPS) must be free for outbound traffic. You can verify this with the
customer if a firewall is present.

- If ECC has been locked due to too many failed tries, you can clear the lock by
clicking the "Unlock Call Home" button as shown in

- Call Homes will be sent home back-to-back until the Call Home queue is empty.

— Call Home

Enable Call Home
| Delay Call Home | | Unlock Call Home

Select Call Home Interface:
O Modem
O IBM Intranet
® Autoselect

al4or456

Figure 2-103. Unlock Call Home

* Autoselect
— If you select Autoselect call home interface, the System Console will first attempt to call home
over the IBM Intranet. If an intranet interface failure is encountered, call home is attempted over
the modem. Both Modem Port and Ethernet Connection sections should become enabled
below.
— Select a modem port and Ethernet Communication settings, as described in Modem and 1BM
Intranet section above.
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Notes:

* If you have a 3958DD1/DD3/DD4/AP1 attached, you will add the values you recorded in
the note in Step [10 on page 2-74 into the fields of [Figure 2-108 on page 2-77,

» To determine whether you need to check the Enable Software Problem Call Home box in
[Figure 2-108 on page 2-77} contact your next level of support. They can help you to
determine if this option is available in your region.

» If you are uncertain whether you need to check the Enable Software Problem Call Home
box in |Figure 2-108 on page 2-77|, your next level of support can help you to determine if
this option is available in your region.

» If you have selected Autoselect or IBM Intranet, the call home code will connect the TSSC
to one of the following URLs.

» Call Homes that are present in the Call Home Queue will be sent home every 5 minutes to
ensure the modem line is not always in use.

Table 2-7. URL Table

Hostname IP Port(s) Description
eccgwO01.boulder.ibm.com 207.25.252.197 443 ECC transaction gateway
eccgwO02.rochester.ibm.com | 129.42.160.51 443 ECC transaction gateway
www.ecurep.ibm.com 192.109.81.20 443 File upload for status
reporting and problem
reporting.
www6.software.ibm.com 170.225.15.41 443 File upload for status

reporting and problem
reporting. Proxy to
testcase.boulder.ibm.com

www-945.ibm.com 129.42.26.224 443 Problem reporting server v4

www-945.ibm.com 129.42.34.224 443 Problem reporting server v4

www-945.ibm.com 129.42.42.224 443 Problem reporting server v4

www.ibm.com 129.42.56.216 80, 443 Service provider file (CCF)
download

www.ibm.com 129.42.58.216 80, 443 Service provider file (CCF)
download

www.ibm.com 129.42.60.216 80, 443 Service provider file (CCF)

download

www-03.ibm.com 204.146.30.17 80, 443 Service provider file (CCF)

download

6. Ensure that the customer's network is properly configured for ECC functionality.

7. If you want to enable the System Console heartbeat, check Enable System Console Heartbeat,
then select the day interval (usually set to 3). This is the number of days between heartbeats. Select
Apply.

If Software Problem Call Home is disabled, the call home packages are deposited in the
/var/enc/SWCH directory. You may need to know this if your next level of support requests that you
locate the call home package.

8. You may disallow inbound modem connections by selecting the Disallow Inbound option in the
Modem Connections section and click Apply. This will allow outbound connectivity through the
modem for call home while ignoring any incoming calls. To allow incoming calls, select the Allow
Inbound option and click Apply.

9. From the top menu, select Location Settings. [Figure 2-104 on page 2-74 appears.

Note: This screen has an 'Override tape system location settings' checkbox. If this box is NOT
checked, the information on this screen will NOT be sent along with all Call Home records sent to the
TSSC from attached systems. If this box IS checked, information on this screen can be changed and
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sent with all Call Home records from attached systems. These changes will also be sent back to any
attached 3957 and 3592 remote systems. It will therefore be unnecessary to update this information
in those remote systems.

TS3000 System Console

General Settings Location Settings Phone Settings Machine Settings Disposition Settings SNMP Settings AOS Settings

Location Settings For This Site
Customer Business/Company Name*: [BM
Customer Location®: Tucson
Customer email address™®: |user@company_com
Customer Phone Number (modem)*: |1-123-665-1212
Customer Phone Number (voice)™: |1-213-555-1212
Customer Offshift Phone Number:

[[] Override tape system location settings

(*) Indicates a required field

a140r560

Apply |
Figure 2-104. Site Location Settings Screen

Enter the information into the input areas of the Location Settings For This Site. The fields that
require you to enter information are denoted by an asterisk. Select Apply.

10. From the top menu, click Phone Settings. [Figure 2-105|appears. This is required even if you have
selected the IBM intranet option.

TS3000 System Console

General Settings Location Seftings Phone Settings Machine Settings Disposition Settings SNMP Seftings AOS Seftings
Configure the Call Home Phone Settings:

Phone List Selection

1. Select a country

2. If the country is United States or Canada. select a state or province
Dialing Options 3. Select a location
@ Tone Dialing 4. Click an import button to import the selected location phone number to one of the 'to dial' fields below.
® Pulse Dia]in_g 5. Modify the number to dial as required by your local telecommunications provider.

[ Do not wait for dial tone
Dial Out Prefix: |9,

Note: If possible configure all four numbers with the last one(s) being nationwide toll free numbers.

Country: United States [=]
State or Province (US and Canada): | Arizona E
Set Location : Phone Number Nationwide Toll - 1-800-586-3089 [~ |
Phone Numbers To Dial
First Number To Dial: |555-000
Second Number To Dial: 555-0001
Third Number To Dial: |1-800-555-0001
Fourth Number To Dial: 1-800-656-0002
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Figure 2-105. Call Home Phone Settings Screen
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11. Choose one of the Dialing Options.

Note: The input areas in the Phone Numbers To Dial fields are limited. If a dial-out prefix such as '9'
is needed to get to a dialing network, put the prefix number in the field that is labeled Dial Out
Prefix.This is required even if you have selected the IBM intranet option.

In the Phone List Selection area, select a country, select a state or province (U.S.A. and Canada
only), and select a location for the Location: Phone Number input area from one of the Phone
Numbers To Dial fields.

Enter information in the Phone Numbers To Dial fields. (Remove the area code if System Console will
be placing a seven-digit call.)
Select Apply.

12. From the top menu, select Machine Settings. You see the Machine Settings screen in

Enter information into the Machine Settings input areas. Enter a four-digit Machine Type (such as,
3494), a three digit model (such as, B20), and a Machine Serial Number, such as the example shown
'1370806' for one of the attached systems. The machine serial number, entered as a seven-character
alphanumeric, with no dashes, is developed from the first two digits and last five digits of the actual
machine number. For example, 13-0070806 would be entered as 1370806.

Note: For TSSCs with 3958-DE2 or 3958-AP1 complexes attached, the complex's information may
be entered into the Machine Settings section.

The System Console periodically checks for responses from attached tape systems. If a system fails
to respond, the following choices are available:

» Create and Send a Problem Report to RETAIN
* Create an Entry in the Console Log (only)
* Do nothing

The default selection is "Create and Send a Problem Report to RETAIN." However, either of the other
choices is available for selection from this panel by clicking the appropriate button located next to the
desired selection.

Mark any standby systems in the attached systems page to avoid the transmission of unnecessary

call home records(see Step|6 on page 2-41). Make a selection from the Response Check for
Attached Systems choices. Select Apply.

TS3000 System Console
General Settings Location Settings Phone Setiings Machine Settings Disposition Seftings SNMP Settings AOS Setfings
Machine Settings

Console problems will be reported to RETAIN using the machine type. model and serial number of one of the attached systems. Enter the machine type. model. and serial number
of one of the attached systems in the fields below.

Machine Type 3592
Machine Model co7
Machine Serial Number |78D0009

Response Check for Attached Systems

The console is configured to check if attached systems respond to communication requests. In the event that an attached system fails to respond to the console communication
request:

@ Create and Send a Problem Report to RETAIN

© Create an Entry in the Console Log (only)

© Do Nothing
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Figure 2-106. Machine Settings Screen
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13. From the top menu, select Disposition Settings to develop, specify, or change a schedule for when
you would like Disposition Code 2 records to be sent to the IBM server. The Disposition Settings
screen in [Figure 2-107] appears. In the Weekdays and the Weekends fields, choose on what days of
the week and during what time periods you would like notices to be sent. Select Apply.

A Disposition Code 2 problem record is typically a lower severity problem which should be sent during
normal business hours. The System Console defaults to sending these records from 0900 to 1500
Monday through Friday.

» TS3000 System Console

General Settings Location Setfings DPhone Settings Machine Seftings Disposition Settings SNMP Settings AOS Settings

Specify when a disposition code 2 problem record is sent to the IBM server. A disposition code 2 problem record describes a less severe problem. Usually a disposition code 2
problem record should be sent out during normal business hours.
Send disposition code 2 records during the following times:

Weekdays

Monday © Always @ Never ©® Sometimes Send between 09:00 [~ | and 15:00 [~]
Tuesday © Abways @ Never © Sometimes Send between 09:00 [~ | and 15:00 [~]
Wednesday © Always @ Never © Sometimes Send between 09:00 [~ | and 15:00 [~]
Thursday © Abways @ Never © Sometimes Send between 09:00 [~ | and 15:00 [~
Friday © Always @ Never @ Sometimes Send between 09:00 [~ | and 15:00 [~]
Weekends
Saturday © Always @ Never @ Sometimes Send between 00:00 [~ | and 00:00 [~ |
Sunday © Always @ Never @ Sometimes Send between 00:00 [~ | and 00:00 [~ |

a14or563

[ Cancel ] [ Restore Defaults ]

Figure 2-107. Disposition Settings Screen

14. Select Apply to enable the new disposition information, or Restore Defaults if you want to return to
the defaults.

Note: Before ending the installation, ensure that you test the call home setup.

15. From the top menu, select SNMP Settings to request to set up SNMP trap alerts. The two options for
sending traps are:

a. Send Traps for Call Home Failures - This option will alert the customer that the TSSC was unable
to call home for one of three reasons: the failing machine is not entitled for call home, the file
already is present in ECC, and the system is not attached to the TSSC.

b. Send traps for Login/Logout - This option will alert the customer when a remote user logs into the
TSSC.

After setting the trap types, the Community, IP or Hostname and Port need to be updated.

c. The value for the Community field needs to match what is set in the customer's SNMP manager.
The default value is set to public.

d. The value for the IP or Hostname field should represent the destination server that hosts the
SNMP manager. The default value is set to localhost.

e. The value for the Port field should represent the port that the customer's SNMP manager is
listening on. The default value is set to 162.
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» TS3000 System Console

General Settings Location Settings Phone Settings Machine Settings Disposition Settings SNMP Settings AOS Settings

Control Unit SNMP Trap Forwarding

@ Enable to IP Address:

Forward [P: 255 - 255 . |255 . 255
© Disable

SNMP Trap Alerting

[¥] Send traps for Call Home faihires
[¥] Send traps for LogmLogout

Community public
IP or Hostname localhost
Port 162

al4or564

Figure 2-108. SNMP Settings screen

16.

17.

To test the SNMP settings, click the Send Test Trap button to send an SNMP trap to the configured
recipient.

See |F_igure 2-109 on page 2-78 To configure Assist-on-Site (AOS), click the AOS Settings link at
the top of the page.

To Start, Stop, or Restart the AOS service, click the corresponding button in the AOS
Configuration section.

If you want to enable AOS Lights Out (unattended mode), place a checkmark next to Enable AOS

Lights Out and click Apply. If you want Lights On (attended mode), uncheck the box next to
Enable AOS Lights Out and click Apply.

If a customer is not using DNS, place a checkmark next to Enable No-DNS mode. You will be
prompted to enter the IP address of the AOS relay server. If this is not known, click the Defaul
button to populate the field with the last known IP address. Click Apply.

t

Connect Through HTTP Proxy implies there is a customer HTTP Proxy server which the customer
requires all call home traffic to go through. When selecting this option, enter the Proxy IP Address

and Proxy Port. If necessary, enter any required proxy server username and password. The
customer should supply these values.

You may add and delete AOS port forwarding targets in the Manage Port Forwarding section.

To add a new port forwarding entry, enter the Hostname or IP address of your port forwarding

target in the text field under Host Target. Enter the destination port in the text field under Port.

Click the Add button to save this entries.

To delete a port forwarding entry, place a checkmark next to one or more entries in the port
forwarding target list. Click Delete Selected Entries to remove these port forwarding targets.

Adding or removing port forwarding entries will restart the AOS service.
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» TS3000 System Console

General Settings Location Settings Phone Setiings Machine Settings Disposition Seitings SNMP Setiings AOS Settings
AOS Configuration Manage Port Forwarding
Start AQS = Host Target Port
] localhost 2

ra| 2

Enable Lights Out

1 Enable No DNS mode L locabost 2
[ Connect Through HTTP Proxy B focathost 080
Proxy server requires authentication Lotk
Proxy Address:
Proxy Port:

al4or565

Figure 2-109. AOS Settings Screen

Initializing System Console Serial Port for connection to local devices
Complete this task to initialize a serial port on the system console.

Use this procedure to initialize a serial port on the system console. You use the serial port to set the baud
rate (or 'data transmission speed’).

1. Attach to the system console the null modem adapter and serial cable that shipped with the system
console.

2. Set the system console serial port baud rate for the serial connection by using one of the following
procedures.

« [‘Setting Baud Rate for System Console Serial Port from System Console’]

- —OR - -
« [‘Setting Baud Rate for System Console Serial Port from Remote Connection” on page 2-80|

Setting Baud Rate for System Console Serial Port from System Console
Complete this task to set the baud rate for a System Console serial port from the System Console.

Perform the following steps to set the baud rate for a System Console serial port:

1. After logging in to the System Console, from the System Console desktop, right click on the desktop to
see [Figure 2-110 on page 2-79
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IBM T33000 System Console V4.0.0

System Console Actions

Browser Functions

T33000 3ystem Console Maintenance Information

Tenminal

serial Port

Notepad

PDF Viewer
shutdown Console...
Hestart Console...

Logout...

Figure 2-110. Serial Port Selection on System Console Screen
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2. Select Serial Port. You see|Figure 2-111|. Type the number of the port speed (baud rate) for the device
to which you will be connecting. The message 'Connected' appears. Press Enter.

|
I v

.— e

IBM T53000 System Conzoleitm?
Cormnect to device through zerial port

For RACK MOUNT Conzole {In 2953 frame}, connect to single serial paort
For STAWDALOME Conzole, connect where CALL HOME modem connects (COM23
Available baud rates:

1, 9600

2, 13200

2, 38400

4, &R0

b, 115200

B, 230400

Select baud rate (1-6B) or 0 to quit and press ENTER: |}

Figure 2-111. Baud Rate Screen - From System Console

Notes:

al4or291

You may need to try various baud rates if 19200 (2) does not work for your application.
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» After you have completed setting the baud rate, if unexpected characters appear while you
are typing, you may have set a baud rate that is not correct for your device. Refer to the
documentation for the device to which you have connected, and confirm that you are using
the correct baud rate for your device.

» Use the ~. command to end the connection from the System Console serial port at any
time.

Setting Baud Rate for System Console Serial Port from Remote Connection
Complete this task to set the baud rate for a System Console serial port from a remote connection.

Use this procedure to set the baud rate (transmission speed) for a System Console serial port from a
remote connection. You may need to try various baud rates if 19200 (2) does not work for your application.

1. After logging in to the System Console, at the command line enter the serialport command, on the
prompt line, and press Enter.

(}ase]mc: ~ # serialport :)

The baud rate screen depicted in [Figure 2-112 appears.

IBM TS3000 System Console(tm)

Connect to device through serial port

For RACK MOUNT Console (In 3953 frame), connect to single serial port
For STANDALONE Console, connect where CALL HOME modem connects (COM2)
Available baud rates:

9600

19200

38400

57600

115200

. 230400

lect baud rate (1-6) or Q to quit and press ENTER:

D OOl WN -

S
-

Figure 2-112. Baud Rate Screen - From Remote Connection

2. At the prompt, type the number (from the list) for the port speed for the device to which you will be
connecting. The message '‘Connected’ appears. Press Enter. The baud rate is now set.

Notes:

» After you have completed setting the baud rate, if unexpected characters appear while you
are typing, you may have set a baud rate that is not correct for your device. Refer to the
documentation for the device to which you have connected, and confirm that you are using
the correct baud rate for your device.

* Use the ~. command to end the connection from the system console serial port at any time.

Backing Up Configuration Data

Complete this task to back up configuration data.
Note: It is recommended, but not required, that you back up configuration data.

Attention: Many procedures in this book are code-specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. System Console configuration is complete. You may now backup your configuration settings if you
need to re-image the hard disk drive or load a new version of software. You will need a 1.44MB
DOS-formatted floppy diskette (model dependent), a USB storage device, or a CD for this procedure.
Use this procedure when reconfiguring:

* Attached systems
» Call Home settings
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Notes:

* You can store multiple configurations by using unique backup names. Follow the
convention for backup configuration names of <host name>-<machine type>-<serial
number>.tgz when you create a unique name.

» Model 8849: The 306m does not contain a floppy diskette drive. A USB device is the only
option.

» USB devices must support USB storage standards.

Right click from anywhere in the Desktop to view the Main Menu shown in |Figure 2-52 on page 2-39l

From the Main Menu, select System Console Actions -—> Console Configuration Utility. You see
the screen shown in [Figure 2-53 on page 2-40}

Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the screen shown in |Figure 2-54 on page 2-40[

Click Backup/Restore. You see the screen shown in|Figure 2-113

Backup Console Configuration Data Restore Console Confisuration Data

—Baclkup Configuration data — Offload Schedule

This page allows you to backup Console configuration data to a
diskette, USB device, or CD.

The configuration data contains the current Console settings. such as
Call Home and Remote Support settings.

Baclaup files can be periodically offloaded to an attached 3957 or
3958 system.

Please Note

Please Note ® The default backup schedule is weekly.

* The default backup host is the primary system defined in

o A diskette must be a DOS formatted diskette
o All data on a diskette will be erased
® A CD must be a CD-RW or a blank CD-R

Click your selection below to begin the backup process.

Machine Settings under the Call Home Settings menu.
* You may click Check Offload Status to display information
about the last successful backup that occurred.

Enter the desired backup schedule.

O Backup to USB device
OBackup to CD

® Weekly O Monthly

Baclaup Host IP Address: 571772?:1?7175:0 i
[ Save Backup Schedule ] [ Check Offioad Status

Restore Defaults

O Backup to Remote Host
Backup file name: ilaselmc'FBTB'KQHGCGi

[ Backup the Canfiguration Data ]

al4or395

Figure 2-113. Backup Configuration Data Screen. The options you will see on this screen are model dependent.

6.

Click Backup Console Configuration Data. You see the Restore Console Configuration Data
screen, which is similar to the Backup Configuration Data screen.

Click Backup Console Configuration Data To Diskette.

- —-—OR - -

Click Backup Console Configuration Data to a USB Drive.

- —-—OR - -

Click Backup Console Configuration Data to a CD.

- —-—OR - -

If you are attached to a 3957, 3958, or 3592, you can backup to a remote host. You are shown a box
into which you enter the IP address of the system you want to back up to. You can do this with all
3958's, but only with 3957's with code at V8.5 or higher and 3592's with microcode levels at
1.23.1.54 or higher.

Notes:

2-81
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11.

* Record the IP address of the remote host that you backed up to. You may need this when
you perform a Restore in Step|7 on page 2-84;
Remote host IP address:

» If you changed the hostname to something other than tssnet1, record the new host name
here.

Remote host name (if you changed it from tssnet1):

A dialog box appears, requesting that you perform one of the following steps.
* Insert a 1.44MB DOS-formatted floppy diskette.
* Insert a CD.

- —OR - -
* Plug in a USB storage device.

Click OK. A message appears which informs you of the success of the procedure.
Click OK.

Note: If you have SNMP Trap Forwarding enabled for the 3958-DD1, collect and manually record
the IP addresses as a backup. You may need this address information for a later procedure:
a. On the Backup Console Configuration screen, click Close This Window.
b. From the home page, click Call Home Settings > SNMP Settings.
c. Record the IP addresses which you can acquire from the DS4000 Forwarding IP and RSA
IP fields.

DS4000
RSA IP . .
Click Close this window to exit the Backup screen.

Scheduling Configuration Backups

Note: This procedure only works with 3958's, 3957's with microcode levels higher than V8.5, 3592-C06,

and (Enterprise Control Units in 3958-DE2) with microcode levels higher than 1.23.1.54.

* 3957 backups will be stored in the /vtd_hydlog/tsscBRConfig/ directory

» 3958 backups will be stored in the /opt/ras/persist/ directory

* 3592 backups will be stored in the /var/adm/ras/ directory.
Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39}
From the Main Menu, select System Console Actions > Console Configuration Utility. Type
service in the Username field, type service in the Password field, then click OK.

Select Backup/Restore. You see [Figure 2-114 on page 2-83]
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— Offload Schedule

Backup files can be periodically offloaded to an attached 3937 or 3938 system.
Please Note:

e The default backup schedule is weeldy.

& The default backup host is the primary svstem defined in Machine Settings under the Call Home
Settings menu._

e You may click Check Offload Status to display information about the last successful backup that
occurred.

Enter the desired backup schedule.

@ Weekly O Monthly

Baclkup Host IP Address: [172.31.1.20

[ Save Backup Scheduls ” Check Offload Status ” Restore Defaults

a14or391

Figure 2-114. Offload Schedule Screen

4. Click on the:
* Weekly button to request a weekly backup (default)

- —-—OR - -

Monthly button to request a monthly backup
If you do not want to reschedule configuration backups, go to Step

Note:

5. Choose the host system you want to back up to, or the Backup Host IP Address will default to the IP
address of the main attached system.

6. Select Save Backup Schedule. You are prompted with a confirmation screen. Click OK to continue.

7. If you want to determine when the last offload was performed, select Check Offload Status. The
screen refreshes. In the upper left corner, you see a message like:

Last offload was performed on Wed Feb 13 11:25:28 UTC 2008
Files were offloaded to: 172.31.1.150

8. To reset to the default schedule, select Restore Defaults.

Note: The default backup host is the primary system that is defined in Machine Settings, under the
submenu Call Home Settings.

Restoring Configuration Data

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Notes:
* Perform this procedure ONLY if it is necessary to restore Console Configuration Data.
» Restoration of configuration data from System Console Code Level V1.x.x to a system with
Code Level Version V3.x.x or V4.x.x will not work. It will be necessary to reconfigure the
console settings manually.

1. Log in to the System Console using one of the login options in[‘User Login” on page 2-36.|
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2. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39
3. From the Main Menu, select System Console Action -—> Console Configuration Utility. You see
the login prompt shown in |Figure 2-53 on page 2-40.

4. Type service in the Username field, service in the Password field, then single click OK to start the
Console Configuration application. The menu shown in|Figure 2-54 on page 2-40| appears.

Notes:

» To login remotely from another system console, you must obtain an Authentication ID (see
|“Login Options” on page 2-37[). Launch your browser, and enter the System Console
location into the Address field. Enter your Authentication ID into the Username field and
your password into the Password field. Click OK to start the Console Configuration utility.

 If you are restoring configuration from a remote system, and the hostname of the TSSC is
not going to be remain tsscnet1, use the hostname that you recorded in Step
Also you will need to reattach the subsystem that you wish to retrieve the backup
from. To reattach the subsystem, See |“Adding Attached System Information” on page 2-39.|

5. Click Backup/Restore. You see|Figure 2-113 on page 2-81|

6. Click Restore Console Configuration Data. You see the screen shown in [Figure 2-115,

7. Select Restore from diskette, Restore from CD, or Restore from USB drive. Confirm that the
floppy diskette or the CD is inserted in the drive or that the USB device is attached.

——OR - -
If you are restoring configuration data to the default settings, select Restore to factory defaults.

» TS3000 System Consale

Backup Console Configuration Data Restore Console Configuration Data

—Restore Configuration Data

This page allows vou to restore Console configuration data.

® You can restore configuration data that vou have backed up on a diskette, USB device, or CD
* You can restore configuration data to factory defanlts
* YouMUST restart the Console after restoring to re-initialize configuration data

O Restore from USB device
O Restore from CD

@ Restore to factory defaults
© Restore from remote host

[ Restore the Selected Configuration Data

al140r463

Figure 2-115. Restore Configuration Data Screen

- —-OR - -

If you are restoring configuration data from a remote host, select Restore from remote host. You

can use the default remote host IP address or you can type in a different address, such as the one
you would have recorded in Step|7 on page 2-81]
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Backup Console Confisuration Data Restore Console Configuration Data

— Restore Configuration Data

This page allows you to restore Console configuration data.

® You can restore configuration data that you have backed up on a diskette, USB device, or CD
¢ You can restore configuration data to factory defaults
® You MUST restart the Console after restoring to re-initialize confisuration data

O Restore from USB device
O Restore from CD

O Restore to factory defaults
& Restore from remote host

Remote host: :r'l_?ﬂ_._?»rl_1_15'b

’ Restore the Selected Configuration Data ]

a14or389

e 2-116. Restore Remote Host. In the Remote host field, add the IP address you recorded in Step
2-81

8. In the Remote host input area, type the host IP address you recorded in Step|7 on page 2-81

9. Click Restore the Selected Configuration Data to begin the Restore. Another dialog box appears,
which informs you of the success of the previous operation, and informs you that the System Console
must be rebooted to complete the restore operation.

Note: When you select OK to continue, the System Console will reboot without further warning!

However, to close any open applications and reboot the system manually, select Cancel. Your
new configuration settings will not be fully in effect until the system console reboots. Remove
the floppy diskette from the diskette drive if you installed one.

10. If you chose Cancel as is mentioned in Step Q you will need to perform the following steps to reboot
the system console:

a. Click Close this window to close the Restore Console Configuration Data screen.
b. Click on File -—> EXxit to exit the browser.
c. Rii ht click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page|

2-39
d. Select Restart Console. The restored configuration data will be available once the System
Console restarts.

11. If you collected and recorded the SNMP Trap Forwarding IPs in Step|10 on page 2-82|, as a backup
for the 3958 configuration:
a. After the system has rebooted, from the TSSC Main Menu, select System Console Actions >
Console Configuration Utility > Call Home Settings > SNMP Settings.
b. Into the boxes, enter the IP addresses that you collected and recorded in Step|10 on page 2-82l
c. Click Apply.

Setting Console Date and Time
Complete this task to set the date and time on the TS3000 System Console (TSSC).

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Note: If the TSSC is connected to a 3958-DE2 complex and you have replaced the system planar board,
first remove the Internal Ethernet cable from the back of the TSSC. Use the time on the lower
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ProtecTIER server as the TSSC time for NTP Server re-syncing. Once you have updated the time
on the TSSC, you can reconnect the Internal Ethernet cable, and then start the NTP server.

Right click from anywhere in the Desktop to view the Main Menu shown in[Figure 2-118 on page 2-87

From the Main Menu, select System Console Actions -—> Console Configuration Utility. The Login
screen displays, as shown in|Figure 2-117

Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen, shown in
[Figure 2-118 on page 2-87]

Note: To login remotely from another System Console, you must obtain an Authentication ID. Launch
your browser, and enter the System Console location into the Address field. Enter your
Authentication ID into the Username field and your password into the Password field. Click OK
to start the Console Configuration utility.

Click Console Time. The screen in|Figure 2-117|appears.

r— Console Time

Wote: Clicking inside or tabbing to a field will stop the clock so that vou can edit the time and date.
To restart the clock click "CancelRefresh” or "Save Changes".

HH MM  SS
Time[14 |:[36 |:[s3 | UTC

MM DD YYYY
Date (05 |/[13 |/[2000 |

Cancel/Refresh H Save Changes ]

—INTP Server Settings
TP Server is off

Start NTP server

al4or400

Figure 2-117. Console Time and Date

5.

See [Figure 2-118 on page 2-87} If you need to change the system clock on the TSSC, you must first
ensure the NTP server is stopped. To do this, click the Stop NTP server button.

Enter the correct values in the Time and Date fields.
Click Save Changes when you are finished.
See [Figure 2-119 on page 2-87} To start the NTP server, click the Start the NTP server button.

Note: It may be necessary to log out and log in again to refresh the date and time indicator on the
desktop application bar. It is also possible that the screensaver may be invoked when resetting
the time.
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NTP Server successfully started.

—Console Time

Note: Clicking inside or tabbing to a field will stop the clock so that vou can edit the time and date.
To restart the clock click "CancelRefresh" or "Save Changes".

*Note: NTP server is running, vou can not change the TSSC time.
MM SS

HH
Time[20 |:[z3 |: 2| UTC

MM DD YYYY

e [/ ] ]

— NTP Server Settings

NTP Server is on

.
¥
<
©

Figure 2-118. Stop NTP Server Screen

— Console Time
Note: Clicking inside or tabbing to a field will stop the clock so that you can edit the time and date.
To restart the clock click "CancelRefresh” or "Save Changes".
HH MM 55
Time[14 |:[36 |: [a | UTC
MM DD YYYY
Date[05 |/[13 |/[2009
[ Cancel/Refresh ] [ Save Changes ]
—INTP Server Settings
NTP Server is off
StartNTP server §
k
©

Figure 2-119. Start NTP Server Screen

Test RETAIN Connection - During Installation

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|
2. From the Main Menu, select System Console Actions —> Console Configuration Utility. The Login

screen displays, as shown in|Figure 2-53 on page 2-40

3. Type service in the Username field, type service in the Password field, then single click OK to start

the Console Configuration Utility. You see the screen shown in [Figure 2-54 on page 2-40

Note: To login remotely from another System Console, you must obtain an Authentication ID (see

[‘Login Options” on page 2-37)). Launch your browser, and enter the System Console location
into the Address field. Enter your Authentication ID into the Username field and your password
into the Password field. Click on OK to start the Console Configuration Utility.

4. Click Console Status. The Test RETAIN Connection screen shown in [Figure 2-120 on page 2-88]

appears.
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TS3000 System Console

Consale Message. File Test RETAIN Connection Console VPI Test ECC Connectivity
— Test RETAIN Connection

Use this page to test the Call Home (RET AIN) connection, This tests the configuration done as part of the Call Home Settings task, specifically it uses the phone
numbers or network cenfigured, and the RET AIN registered primary system to do the test,

To test the connection do the following:

1. Review the call home settings for correcmess,
2. Click on the Test Problem Notification button or the Test Data Upload button to begin the desired test.

Use the Refresh button to update this page if you change setfings in the Call Home task,

[ Phone number 1: [Not Configured

[ Phone number2: [Nat Canfigured Test Problem MNotification |
[ Phone number3: [Fot Canfigured Test Data Upload
[ Phone number4: [Fot Canfigured Refresh

¥ IBM intranet

al4or478

Figure 2-120. Test RETAIN Connection Request Screen - During Installation

5. Click Test RETAIN Connection.

6. Click one of the configured telephone numbers.

7. Click Test Problem Notification in the right-hand panel to test the PMR path, or click Test Data
Upload in the right-hand panel to test the data upload path. Details of the results of the test appear in

the screen shown in|Figure 2-121}{ If you changed a telephone number, click Refresh to refresh the
display, then again perform Step (7]

rstem Console

Enzcutien ovtput llows:

= Startmg to test AGNS / RETAIN connection

—> Starting to create problem record, type: 4

Looking up properties for type 4

Reading Type DI /4 .

Found: "#4*DI*Test notification

Checking primary subsystem

Creating problem record header

Adding informational message: ESS Master Cuﬂscﬂe Prub]em Nut1f1catwﬂ test

Could not open fnr appending its contents to ord (Mo such file or directoryd

= Return Code — Problem record /var/enc/data/aasammSDDDMED DItest0l successfully created (3953 L05—1 3000047

000 Ign_Dialer Z006/03/06-16:44: 4.0559 *T* 00000 00000 *** Program started *

on0 Tan_Dialer 2006/03/06—16: *T* 00000 00000 Updating gateway mfnrma tinl

o000 Tan_Dialer 2006,/03/06—16: *T* 00000 00000 Pre?armg for dialing the IBM netwnrk

000 Tan_Dialer 2006/03/06-16: *T* 00000 00000 Dialing IBM netwark: 9,837-1005

000 Ian_Dialer 2006/03/06-16: 1% 00000 00000 Connected to the IEM networ’k, trying to reach remote host

000 Ian_Dialer 2006/03/06-16: *I* 00000 00000 ﬁdatmg routing tables

000 Ign_Dialer 200B/03/06-16: #I* 00000 00000 Checking remote host .

000 Ian_Dialer 2008/03/06-16:2 #I* 00000 00000 Connection to IBM entirely established, ready for communi

Dialing IBM network: fusr/binfenc/rsTCPIGNLink —i “G0° -t “G00° 107 —b 1152007 -1 —w Idev[ttySU ’9,837— 1005 URUS “DASDUST “d

Sem:hng data to IBM: fusr,"mn/enc/rsTCPSendPMH -y —C '/var/enc/dataISBSBLDM300004EU DItest01” “167.210.250.597 “19285° 79.5G.214.2497
Send_Pmh_To_Retain 06/03/06—16:45:04 000 Converting prim/sec IP and Port

DD1 Send_Pmh_To_Retain EDDEJDBIDE 162 45:04:0802 *I* DDDDD DDDDD Reading data file fvar/enc/datas33531051300004E0.DItestdl

001 Send_Pmh_To_Retain 2006/03/06-16:45:04:0802 *I* 00000 00000 Prncessma product: 1300004-3953-L05

001 Send_Pmh_To_Retain 2006/03/06—16:45:04:0802 *I* 00000 00000 Start sendin E data to prim IP

001 Send_Prh_To_Retain 2006/03/06-16:45:04:0 *T* 00000 00000 Creating socket

001 Send_Prmi Tn_Retam 2006/03/06—162 #T* 00000 00000 Connecting socket

001 Send_Pmh_To_Retain 200B/03/06—16: *I* 00000 00000 Sending user data

001 Send_Pmi _To_Retam 200E/03/06-16:45:04: #I* 00000 00000 Receiving response

001 Send_Pmi _To_Retam 2006/03/06-16:45:05: 0256 *I* 00000 00000 Ana'lyzmg response o

001 Send_Pmh_To_Retain 16 #*I* 00000 00000 Using Togan record Fur IEM product =

001 send_Pmh_To_Retain 3/06-16 #*I* 00000 00000 Sending U?Uﬂ record )

001 Send_Pmh_To_Retain 06—16 =T* 00000 00000 Receiving first response o

001 Send_Pmh_To_Retain J06-16:45:11:00 *T* 00000 00000 Analyzing first response <

001 Send_Pmh_To_Retain 2006/03/06-16:45:11: 0613 *I* 00000 00000 Receiving second response ©

Figure 2-121. Test RETAIN Connection Results Screen - During Installation
Test Electronic Customer Care (ECC) Connectivity

This feature can be used to assist in both setting up and troubleshooting problems with ECC call home.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Actions —> Console Configuration Utility. The Login
screen displays, as shown in|Figure 2-53 on page 2-40

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration Utility. You see the screen shown in|Figure 2-54 on page 2-40|
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4. Click Console Status. Click the Test ECC Connectivity link at the top of the page. You will see the
following screen:

S3000 System Console

Close this window

Console Message File Test RETAIN Connection Console VPD Test ECC Connectivity

Test ECC Connectivity

Use this page to test connectivity between this TSSC and the ECC Call Home servers. Click Test Connection to begin the test. To see which IP addresses and ports need
to be opened on the customer's network., click Show ECC Info.

aldord77

Figure 2-122. Test ECC Connectivity Screen

5. To test connectivity to the ECC servers, click on the Test Connection button. The test will begin
immediately, and you should see the results of the test on the screen.

Note: If any of the tests report "NOT OK", the listed IP address and port will need to be opened
through the customer's firewall in order to gain access to the ECC service.

S3000 System Console

Close this window

Consale Message File Test RETAIN Connection Console VPD Test ECC Connectivity

 Test ECC Connectivity

Testing ECC Connections...

Testing direct connection

Testing prefix Status_Report
Status_Report_1: 207.25.252.197 OK
Status_Report_2: 129.42.160.51 OK

Testing prefix Problem Report:
Problem Report_1:129.42.26.224 OK
Problem Report_2:129.42.34.224 OK

Cancel Test H Show ECC Info

al4or475

Figure 2-123. ECC Test in progress showing successful connections being made

6. To cancel the connectivity test, click the Cancel Test button while the test is active.

If you would simply like to see the current IP address and ports used by ECC, click the Show ECC
Info button. You will see results similar to the figure in the following image:

Note: All IP addresses and ports must be allowed through a customer's network in order to use all
ECC features.
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, TS3000 System Console

Console Message File Test RETAIN Comnection Console VPD Test ECC Connectivity

rTest ECC Connectivity

Current ECC IP Addresses And Ports

The displayed IP addresses and ports must be allowed through any customer firewall to provide access to each service.

Status Reporting Problem Reporting Fix Acquisition

IP Address Port| [IP Address  [Port IP Address Port
207.25.252.197 443 | |129.42.26.224 443 170.225.15.28 [80
1294216051 [443 ||120.42.34.224 443 170.225.15.107 80
[120 4242 224 443
129.42. 3
129.42.34.224 |443

7180
80
80
sle0
80

al4ord76

Figure 2-124. Sample output showing ECC IP addresses and ports

Logging Out of System Console

After you complete your current task on the System Console, you will need to log out of the System
Console.

See [Figure 2-52 on page 2-39|
1. Using the right mouse button, click on the desktop to view the Main Menu.
2. Using the left mouse button, click on Logout.... You are logged out of this console session.

You can use the Shutdown Console... menu item if you need to log out and halt the System Console. You
would use this if you needed to physically power OFF the System Console at the end of the shutdown
process. Use the Restart Console... menu item to reboot the System Console. You also can use the
Shutdown and Restart buttons on the System Console Login screen (Figure 1-1 on page 1-1)) to halt or
reboot the System Console without logging in.

Test Call Home for 3494 VTS, VTC, 3590 A60, 3592 J70, and 3592 C06

1. Return to the tape system's Call Home / Remote Service Menu at the Library Manager EBTERM
Service Screen (if available). To test a call home through the System Console, select Send Test
Notification Menu, as shown at|Figure 2-125| Press Enter. |Figure 2-126 on page 2-91| displays.

Attention: Select the illustrated line item only at No other menu display items are
applicable for this process.

4 N

Call Home / Remote Services Menu
Move cursor to desired item and press Enter.
Send Test Notification Menu

Fl=Help F2=Refresh F3=Cancel F8=Image
\F9=She11 F10=Exit Enter=Do

Figure 2-125. Call Home / Remote Services Menu — Send Test Notification Menu

2. AtfFigure 2-126 on page 2-91| select Service Notification (via modem). Press Enter. [Figure 2-127

|gn page 2-91| displays.
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4 N

Send Test Notification Menu
Move cursor to desired item and press Enter.

Service Notification (via modem)
Pager Notification (via Pager)

Fl=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do
o J

Figure 2-126. Send Test Notification Menu — Service Notification

3. Verify that the following message is received, and verify that the Test Message was received in
RETAIN®.

Service Notification Test Result: Test message was queued successfully.

Start waiting for queue program (rsCHDaemon) to receive the Test message (gname=
DI_Vycia).

Press Ctlr-C anytime to cancel test .

11: 418, Tue Jul 10 14:32:37 2001, waittime=131 seconds, send delay after the di

splayed time..........
. %
Figure 2-127. Send Notification Test Result Menu — Waiting
Test Call Home Notification for 3494 ATL or 3953 Enterprise Library
Controller

Note: This function requires that the 3494 ATL or 3953 be successfully attached to the System Console.
See [‘Adding Attached System Information” on page 2-39.|

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

This procedure requires that you previously performed [‘Tape System Setup for 3494 ATL (Library

[Manager) or 3953 Enterprise Library Controller” on page 2-26.|

1. To test call home through the System Console, use the 3494 ATL or the 3953 menu commands
Commands --> Call Home... to view the Call Home Dialog box (see [Figure 2-128 on page 2-92).
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B .ome |

To initiate a "Call home", select a subsystem from the listbox, select the
type of "Call home", then press the "Initiate call home" button.

Frame  Subsystem  Port Serial - Type of Call Home
-- MC —---  —---- (® Initial install
01 J70 0x20
02 J70 0221 () Subsystem problem
03 J70 0x22 (7 Send LM code level
15 ¥I5-1 0x25 B1510
15 ¥T15-1 0x26 B1510
15 ¥T15-1 0x27 B1510

Initiate call home... I Cancel I Help I

Figure 2-128. Call Home Dialog Box

al4or232

2. Highlight the line containing 'MC' in the Subsystem column. Click Subsystem problem -> Initiate call
home... Once the call home has been created, a dialog box appears which indicates that the call
home was successfully created and sent to the System Console. The call home package should be
available for viewing within two or three minutes by using the System Console's Queue Management
tool (see [‘Call Home Queue Management” on page 3-23).

Once the System Console has sent the package to RETAIN, the PMR number will be available by

viewing the Call Home Log tool. To verify the record, log into the RETAIN system and search for the
PMR, or search for records from the type, model, and serial number of the 3494 ATL or the 3953.

Setup for Remote Data Monitoring (VTS, VTC, A60, J70, C06)

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Perform this procedure ONLY if Remote Data Monitoring is to be activated.
1. From the tape system Maintenance menu, select Subsystem Configuration, and press Enter.
2. At[Figure 2-129| select Call Home / Remote Services Menu, and press Enter.

Attention: Select the illustrated line item only at No other menu display items are

applicable for this process.

Note: To activate Remote Data Monitoring, ensure that the Call Home/Remote Services are set

through the System Console. See Step |2 on page 2-21|and Step|3 on page 2-24{

Subsystem Configuration
Move cursor to desired item and press Enter.
Call Home / Remote Services Menu

Fl=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-129. Subsystem Configuration Menu — Call Home / Remote Services Menu

3. At[Figure 2-130 on page 2-93| select Remote Data Monitoring, and press Enter. [Figure 2-131 on|

|Qage 2-93|displays.
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Attention: Select the illustrated line item only at[Figure 2-130} No other menu display items are
applicable for this process.

/ N\

Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

Remote Data Monitoring

Fl=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do
o J
Figure 2-130. Call Home / Remote Services Menu — Remote Data Monitoring
4. At[Figure 2-131|, select Change / Show Call Home Heartbeat Interval, and press Enter.
Attention: Select the illustrated line item only at No other menu display items are
applicable for this process.
4 N
Remote Data Monitoring
Type or select values in entry fields.
Press Enter AFTER making all desired changes.
[Entry Fields]
* Change / Show Call Home Heartbeat Interval Disabled +
* Error Initiated Call Home Data Gathering Disabled <
* Timeout Period Between Successive Data Call Homes [24] #
(In hours between 1 and 99)
Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
- J

Figure 2-131. Remote Data Monitoring Menu — Change / Show Call Home Heartbeat Interval

5. In the example in [Figure 2-132 on page 2-94] 7 days has been selected. Press Enter. [Figure 2-133

|on page 2-94| displays.

Note: The Change / Show Call Home Heartbeat Interval option allows the user to select how often a
heartbeat is sent home. A heartbeat consists of Machine Reportable Product Data (MRPD),
such as installed features and code levels, and the output of a health check program like VTS
Checkout. The frequency of these heartbeats can be between 1 and 15 days. The heartbeat
can be disabled.
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s

Remote Data Monitoring
Ty 19999999999999999999999999999999999999999999999999999999999999999999949999qak
Prx Change / Show Call Home Heartbeat Interval X
X X
X Move cursor to desired item and press Enter. X
* X X
* x [TOP] X
* X Disabled X
x 1 day X
x 2 days X
x 3 days X
x 4 days X
x 5 days X
x 6 days X
x 7 days X
x 8 days X
X 9 days X
x [MORE...6] X
X X
x Fl=Help F2=Refresh F3=Cancel X
x F8=Image F10=Exit Enter=Do X
x F5 /=Find n=Find Next X
F9 Tqqq99999999999999999999999999949999999999999999999999999999999999999999qqqk

-

J

Figure 2-132. Remote Data Monitoring Menu

6. At |Figure 2—13§|, select * Error Initiated Call Home Data Gathering, and press F4 to display the list

of options shown in|Figure 2-134 on page 2-95l

Note: The Error Initiated Call Home Data Gathering option allows the user to enable or disable data
gathering when a call home occurs. If enabled, data collection and diagnostic programs will be

run whenever a call home event occurs, and the collected output will be sent to the Support
Center. The data that is collected contains information that will help in determining what

caused the problem leading to the call home. If disabled, no data collection will occur when a

call home event occurs.

-

Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Change / Show Call Home Heartbeat Interval 7 days +
* Error Initiated Call Home Data Gathering Disabled +
* Timeout Period Between Successive Data Call Homes [24] #
(In hours between 1 and 99

Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
\F9=She11 F10=Exit Enter=Do

Figure 2-133. Remote Data Monitoring Menu — Error Initiated Call Home Data Gathering Disabled
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4 N
Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]

* Change / Show Call Home Heartbeat Interval 7 days +
* Error Initiated Call Home Data Gathering Disabled +
* Timeout Period Between Successive Data Call Homes [24] #

(In hours between 1 and 99)

1999999999999999999999999999999999999999999999999999999999999999999999994qagk

X Error Initiated Call Home Data Gathering X
X X
X Move cursor to desired item and press Enter. X
X X
x  Disabled X
x  Enabled X
X X
x Fl=Help F2=Refresh F3=Cancel X
xF1 F8=Image F10=Exit Enter=Do X
xF5 /=Find n=Find Next X

k

\FQ 19q99999999999999999999999999999999999999999994999999999999999999999999999499

Figure 2-134. Remote Data Monitoring Menu — Error Initiated Call Home Data Gathering Results

7. Select Enabled, and press Enter. |Figure 2-135|appears with the selected values displayed.

4 N
Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]

* Change / Show Call Home Heartbeat Interval 7 days +
* Error Initiated Call Home Data Gathering Enabled +
* Timeout Period Between Successive Data Call Homes [24] #

(In hours between 1 and 99)

Fl=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
- J

Figure 2-135. Remote Data Monitoring Menu — Error Initiated Call Home Data Gathering Enabled

Note: The Timeout Period Between Successive Data Call Homes option allows the user to select the
minimum time between successive Error Initiated Call Home Data Gatherings. The user can
select any number of hours between 01 and 99 hours (leading zero is required). As an
example, assume that the user has chosen 24 hours. If a call home event occurs, extra data
gathering will be performed, and the 24-hour clock begins timing. If another Call Home event
occurs before the 24 hours has expired, no extra data gathering will be performed, even if that
option is enabled. If a call home event occurs after the 24-hour period and Error Initiated Call
Home Data Gathering is enabled, the extra data gathering will occur and the time-out period
will begin again.

8. At[Figure 2-135, press Enter. A COMMAND STATUS screen (Figure 2-136 on page 2-96) displays
showing that a command is running.
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COMMAND STATUS
Command: running stdout: yes stderr: no
Before command completion, additional instructions may appear below.

The values have been successfully changed

Figure 2-136. COMMAND STATUS Screen — Running

9. The Command Status screen (Figure 2-136) displays for as long as five minutes. It is normal for there
to be no response for this period of time. DO NOT press any keys while the command is running.

10. When the execution of the command is complete, the screen shown in|Figure 2-137| displays. "OK"
appears in the "Command" field.

COMMAND STATUS
Command: OK stdout: yes stderr: no
Before command completion, additional instructions may appear below.

The values have been successfully changed

Figure 2-137. COMMAND STATUS Screen — OK

11. Press F3 twice to return to the "Call Home / Remote Services Menu."

Setup for Remote Data Monitoring (3494 ATL or 3953 Enterprise
Library Controller)

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

See [‘Set Heartbeat” on page 2-33.|
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Chapter 3. Procedures

Service Tools

Telnet to Attached Tape System

Attention:

[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Many procedures in this book are code specific. Before starting any procedure, go to

After you complete the System Console configuration, the tool to establish telnet connections to attached
systems is automatically enabled.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39)
and select Telnet to Tape System. You see the screen shown in|Figure 3-1|.

IBM TS3000 System Console

Telnet to Attached Tape Syztem

# MakeModel  Serial Humber IP Addres=s Hostname
i F953L05 1300005 172.31.1.12 RASELE
2 A953L05 1300005 172.31.1.11 RASELA
3 309270 TAC4049 172.31.1,45 elojfidi
4 ARAZC06E TaCcHO11 172,231,135 elocOB30
T 3092006 TACEONT 1¥2.31.1,36 rascib
[ AR30AEN TAOOZ39 172,231,126 razabi
i 2957V TEOOI2A 172,31,1,160 rasta?rdn
a: 249422 1314501 172.31,1.5 RASLMS
i ARAZC06E TACHOZS 172,311,125 rasC06
103 ARA2T0 100B394 172,231,115 el j7iln
11: 29570 TAOEZEG 172,31,1.,150 rasmatazz
123 3092006 FACROOT 172,231,127 rascuiny
13: ARAZC06E TACHOZG 172.31.1.28 razdew
14: 3957V TEH2910 172,31,1,210 rashorse
150: 2957VEA TBHH123 172,31,1,220 raswolf
1E: aha4L 32 13ARA15 172,31,1,170 RAS32534
17: F957V0R TEOOERA 172,31,1,190 rashydra

Which system would you like to connect to (or 'q' to quit)? |

Figure 3-1. Telnet to Attached Tape System — Selecting

2. Enter the number of the system you want to telnet to, and press enter.

al4or457

3. When you have a successful telnet connection, you see the screen shown in|Figure 3-2 on page 3-2}

© Copyright IBM Corp. 2002, 2012
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| Telnet Model; 3434820 Serial: 1344411 IP; 172.31.1.2 =S|

2,23.17 .48

IBHM TOTALSTORAGE 3494 MODEL BZ0
PEER-TO-PEER VIRTUAL THPE SERVER

service Terminal

Available Menus [ jughead]:

zeryice Service Menu
extended Extended Serwice Menu
©
=4
Please enter a menu name: | || 2
@

Figure 3-2. Telnet to Attached Tape System — Connection Successful

Notes:

* Log into the system using the established security procedures for that device. If your ID and
password were successfully propagated, they can be used to log in.

* You may establish as many telnet sessions at one time, as necessary.

* You may establish multiple telnet sessions with a single system.

« If the function keys (F3, F4, F10, and so forth) do not work as intended in the SMIT
screens, use ESC+3, ESC+4, ESC+0 key sequences instead.

* The telnet screen must be a minimum of eighty columns-by-twenty-five lines in order for
SMIT screens to display properly. To change the size of the telnet screen, click and drag the
lower right corner of the screen.

* If a communication attempt with an attached system fails, the telnet screen will disappear
from the desktop, and no error message will display.

Telnet to Grid TSSC

Use this procedure to connect to another TSSC within the Grid network.
1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39I

2. From the Main Menu, select Telnet to Grid TSSC. You see the figure shown below. You will see
information about each Grid system as it is available, including IP address, hostname and location.
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_
I Telnet to Grid TSSC

TEM TS3000 Syztem Console
S5H to Remote TSSC

# IF Addresz=s Hozthame Location

# Attached Systems

1: 10,2,2,2 xslt RZ, U5 18

Which system would you like to commect to ('L’ to list or 'q' to quit)? ]

al4ord68

Figure 3-3. Telnet to Grid TSSC

3.

4.

To connect to a system, press its corresponding list number. To see attached system information about

a particular system, press L. Press q to exit this application.

If you would like to see attached system information for a particular system, press L. You will be
prompted to enter the system number. Attached System information will look like the following:

I Telnet to Grid TSSC E

IEM TS3000 System Conzole
S5H to Remote TSSC

Systemz attached to 10,2,2,2:
[1] 2494L22-1314501
[2] 3524L32-12AAR15
[2] ZB90ABO-FE0O0239
[4] 3992C06-7ECO007
[5] 3592C06-7aC5009
[6] 3592C06-7acooll
[7] 3592C06-78C5023
[8] 3B92C0E-7ECE025
[9] 3m32170-100B390
[10] 3532]70-7aC4049
[11] F9m3L05-1300005
[12] 2953L05-1300005
[12] 2957Y0E-7a008EA
[14] 3957Y0R-7800920
[15] 2957Y0E-7a083EG
[1B] 3957Y0E-7BOBEEG
[17] 2957Y0E-7E8H2910
[18] 3957YEA-TOHHLZ3

Presz 'c' to connect, 'b' to go back to the main screen, or 'q' to quit: [

Figure 3-4. Attached Systems List

al4or467

5. After viewing the Attached Systems, you can connect to the selected TSSC by pressing ¢. Pressing b

will take you back to the main screen.
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Tape System Service Information (VTS, VTC, A60, J70, C06) - [Code
Level Below V5.3]

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

After you complete the System Console configuration, the tool to update and review service information for
attached systems is automatically enabled.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39}

2. Select System Console Actions, Tape System Service Information. You see the Tape System
Service Information screen shown in [Figure 3-5].

Last Update
05/27/03 11138 IN|
05/27/08 1138
4 05/27/03 1138
5 05/27/08 11138
6 05/27703 11:30
7 05/27/08 1138
NEVER

FAIL WT52 2434B20 FEE2019 172,31.1,
WARM WT51 2434B20 FRE2018 172,31.1,
0K WTC-0 2494CK1 FEYT0EA 172,311,
0K WTC-1 2434CK1 FETT04R 172,31.1,
(i3 WTC-2 3434CKH1 FEFTO5A 172,31.1,
i3 YTC-2 2434CK1 FEFTOEA 172,31.1,
MR 2630cu40 2RF0AE0 1224944 172,31.1,

Red Background
Yellow Background
Green Background
Gray Background

(Selected systems are highlighted with a slightly darker color
than unselected systems)

el

Select All | Deselect All | View events | Update | Quit |

a140r188

Figure 3-5. Tape System Service Information — Main Screen

3. The Tape System Service Information screen, as depicted in shows a summary of the
status of the systems that are attached to the System Console as of the date and time that are
included in the Last Update column. The system listing is sorted in descending order of status severity.
The background color scheme provides this information:

* Red Background - A Failure has occurred

* Yellow Background - A Warning has occurred

» Green Background - No Failures or Warnings have occurred

» Gray (or White) Background - No status has ever been reported to the System Console

4. Tape System Service Information status is NOT run automatically. It is performed by selecting any
number of systems in the listing and then clicking the Update button. Systems may be selected
individually by pointing to the system list entry and clicking the left mouse button once. (Clicking the
entry again deselects the system.) Alternatively, you can select all of the systems on the list by clicking
Select All (or deselect by clicking Deselect All).

5. As the System Console receives service information from the selected tape systems during the update
process, the selected systems become deselected (un-highlighted), the date and time of last update is
changed to the current date and time, and the new status is indicated by the background color of the
system entry listing and the STATUS column (located on the left side).
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Note: The update process can be lengthy for a large number of attached systems. However, this tool
will time-out at ten minutes for unresponsive systems and return control to the user. The tool is
normally unresponsive during the Update process and may appear to be locked up if attached
systems are not responding.

6. The Tape System Service Information may be reviewed at various levels of detail. The main screen

shows a one-line status summary for each system attached to the console. Selecting one or more of

the systems in the listing and clicking View Events results in a listing of the specific service events
that resulted in the failure or warning status, as shown in|Figure 3-6

12AAAZZ( 34348207
13AAAZE(2434B20)
13AAAZE2434B20)
12AAAZ2( 34340407
13AAATL(2434B20)

NEVER
OB/Z7A0L 29500
0B/27/01 20100
0B/27401 22100
07/19/01 15150
MO ERRORS

FAILUREY
WARNING:
WARNIMG
WARMIMGE

'ERROR: This machine has not been queried

A unknown error occured

rumber of Scratch wolumes (252) not equal to wolumes in FFO

(there are open SIMz)
{there are open SIHs)

Ho failures or warnings for thiz machine

0K|

=l

al4or109

Figure 3-6. Tape System Service Information — Events

7. Double-clicking one of the events shown in results in the full details of the event, as shown

in [Figure 3-7 on page 3-6|
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sent for 1: 3 . EQ[EQEE
Event for 13AAA3E
number of Scratch wolumes (252) not equal to wolumes in FFO3 (2510,
CORRECT: Check if there are mizplaced, inacceszible or manually ejected
CORRECT: wolumes using the database search menu at the LM, Check for readonly
CORRECT: and unavailable volumes in the VTS,
CORRECT: The difference iz -1, Make next lewel of support aware of this
COREECT: on the next service calll
Al o
0K §
©

Figure 3-7. Tape System Service Information — Event Detail

You also can view the contents of the entire service status file for an attached system by selecting it at
the Tape System Service Information main screen (Figure 3-5 on page 3-4) and clicking View File.

Note: The Tape System Service Information tool remotely invokes rdm_bc_check (Models B10, B18,
B20) or rdm_gm_check (tape subsystem control units) service diagnostic programs and then
presents the results to the System Console as a local convenience. No modification of the
results of the diagnostic programs is performed by the console, and the service programs
remain available for direct invocation on the attached systems with proper user access.

8. From the Main Screen in|Figure 3-5 on page 3-4} select Quit to quit.

Creating Attached Subsystems List

Use this procedure to create a list of all the subsystems that the System Console is attached to.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39I
2. Select System Console Actions > Console Configuration Utility. Login, as required.

3. Select Attached Subsystems. You see |Figure 3-8 on page 3-7l You can sort the list by clicking on a
column heading.
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‘ r ‘Dewce Model ‘ Serial Number ‘ D ‘ Host Name ‘ IP address ‘ Subnet Mask ‘ 7%?&?1?:: ‘ Standby ‘ Cﬂ‘ﬁ
[ & | 3ss4r23 | 7843457 | 1 [ BLc-A | 17231151 [2552552550 | 1 | 1 [ ma
| & | 3ss4r23 | 78A3629 | 2 [ BLCB | 17231150 (2552552550 | 1 | 0 | ma
[ 0 [ 35843 | 783200 | 3 [ BLc.c [ 17231152 [2552552550 1 | 0 [ Na
[ T [ 3584123 | 78A3628 | 4 [ BLcD | 17231153 [2552552550 1 | 0 [ Na
[ & | sssars2 | 1340013 | 5 [ MsBF1 172311228 (2552552550 | 1 | 0 [ wa
| & | s3ss4rs2 | 1340074 | 6 | MsBF3 [ 172311203 [2552552550 | 1 | 0 [ ma
[ & | 3ss4rs3 | 7819831 | 7 | MsBF4 [ 172311204 2552552550 | 1 | 0 I
[ T [ 3584023 | 7820220 | 8 | msBF11 [172311212 [2552552550 1 | 0 [ Na
[ T [ 358423 [ 7842017 | 9 | MSBF12 [172311239 [2552552550 1 | 0 [ Na
72 pr .| Add System | Health Legend:
__ Delete Selected| I No Problems Returned From System Health Checke
Edit Selected — =
m |— |'\.'\;Emm1g(s) Found in System Health Check
T QueyAl | B [Faied Status(es) Found in System Health Check
__ Toggle Standby | I |[Offine Status(es) Found in System Health Check
View Health I |C0mmm.icalion Failure Between TSSC and Attached System
View Events
Ipant il )
Refresh | ;:O“

Figure 3-8. Attached Subsystems List Screen. Use with|Table 3-1

Table 3-1. Color Indications for Health Check. Use with|Figure 3-§.

Health Legend

Color Health Legend Indication

Green No problem returned from system health check

Yellow Warnings found in system health check

Red Failed statuses found in system health check

Black Offline Status(es) Found in the System Health Check

Blue Communication failure between TSSC and attached systems

4. You can use one group of buttons to perform Delete, Edit, and Query operations on the list of attached
subsystems. You also can use another set of buttons to interrogate the System Console for the
following operations. Click on any quantity of attached subsystems and select one of the button titles.
You see a screen like [Figure 3-9 on page 3-8|with one of these reports:

Note: These choices are not available for a 3584 or a 3494L.

View Health

Returns information about the machines you choose

View Events

Returns event information on any machines for which a problem has been logged

Update Health

Performs another machine health check

Refresh

Refreshes the information and the color scheme in|Table 3-1| to reflect your most recent activity
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Detailed Output:

o -

SYSTEM REFPORT (S)
M-Type:3957-V06 Hostname:rashydra IP:172.31.1.1%0 SN:78-00008BA Clstr:cO
———— Time Initiated from T35C: 05/16/08 14:13:33
———— Time It Ran On Subsytem : 05/16/08 14:15:07

T57740 Checkout Version 1.01 executed on: 05/16/08 at 14:15:07
Command syntax and parameters: /usr/vtd/scripts/vtd check -P v

al4or364

Figure 3-9. Health and Events Report Screen Example.

5. View the properties of the Attached system by selecting the hyperlinked serial number. This will display
all of the properties of that attached system. To go back to the list of the attached systems, click the
Attached Systems link at the top of the screen.

Remote Code Broadcast By Using the Web Interface

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level. The code level
requirements are:

System Console
Code Version 5.3.x and above

IBM TS7700 Virtualization Engine
System Console must be a hardware model 8485 (x206m) or 8849 (x306m). Code Versions
8.5.XX.XX and lower. For higher code levels, refer to [‘Mksysb Broadcast from the Web Interface”|

on page 3-82.

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.26.xx.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.xx.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

You can use the web interface to copy control unit code from a source CD that you place in the CD drive
of the System Console. You then can broadcast this code to another device.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39I

2. Select System Console Actions > Console Configuration Utility. Type service in the Username
field, service in the Password field, then click OK.

3. Select System Tools > Remote Code Broadcast. You see the screen shown in [Figure 3-10 on page]
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—Remote Code Broadcast Options

This servlet will provide functions to copy the broadcast code from a disc to the console. It will NOT work for Mksysh images.

Select "Do not overwrite existing controller code. " if vou think the console mav not need updating, and view the log file afterwards.
Select "Delete code images..." if vou wish to select on which machines to delete already exisitng code.

Note: This servlet has two phases. The first copies files from the disc and prepares a list of machines to broadcast to. The second does the
broadcast. For large code images this process can take time. Please wait for the page to reload.

VIDVTSVTC Tape Controller Remote Code Broadcast Menu

1. | BroadcastCode Disc

[ Do not overwrite existing controller code if already on this console.
[0 Delete code images on attached machines to make room for broadcast image.

2. | Viewthe LogFile
3. | Clearthe LogFile
4. | Ejectthe Disc

al4or469

Figure 3-10. Remote Code Broadcast Options

4. Insert the disc which has the code you wish to broadcast into the optical disc drive of the TSSC.

5. Select one of the options for Broadcast Code Disc, then select Broadcast Code CD.
Do not overwrite existing controller code if already on this console
Select this option if you previously broadcast code to a system using the code disc that you
just inserted into the drive. This eliminates the time it takes to load code from the disc.

Note: If the image copy failed, select View the Log File. Retry Broadcast Code Disc after
you determine the cause.
Delete code images on attached machines to make room for broadcast image
Select this option to choose which images you want to delete from the target system. A list
displays. To add an image to the target system, ensure that the target system has no more
than one image.

Note: If you selected "Delete code images on attached machines to make room for broadcast
image" the screen reloads and refreshes the list of images to delete. Select the images
you want to delete. Type in the numbers of the images that you wish to delete.
Separate the numbers by spaces (for example, “0 1 4 57). Select Submit Choices.

6. When the code copy completes, a message appears, and prompts you to select which system to

broadcast the code image to. You see a box entitled “Systems for Code Broadcast” at the bottom of
the screen.

This box contains a list of the attached systems that can be broadcast to. |Tab|e 3-2 on page 3-11| lists
the possible status conditions you might anticipate.
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—Choose Systems for Code Broadcast

Select systems for broadcast by typing in the box below the numbers you wish to delete separated
by spaces, or leave it empty. (e.g. 0 1 2 3
If you wish to broadcast to all systems, type "all" and hit submit

Systems to choose from:
NO MODEL SERIAL IP ADDRESS HOSTHAME CODE LEVEL

0 3592 CO6& 7T8C5011 17

1 3592 CO06 1300BER 17

[SRY)
W

1.1.35 rasC06 Unavailable
1.1.35 rasCO06 Unavailable

Systems for Code Broadeast: 01| Submit Choices

al4or372

Figure 3-11. Choose Systems for Code Broadcast

7. Select the systems to which you want to broadcast a code image. In the "Systems for Code
Broadcast" column, type the numbers of the systems, separated by spaces. Leave this field blank if
you do not want to broadcast a code image, or you can select the Cancel button. Click on Submit
Choices.

Notes:

» This can take as long as five minutes per system.

[Figure 3-10 on page 3-9 provides an example, which depicts that the code broadcast will fail

because the attached control units are “Unavailable.”

« If an error occurs, select View the Log File from [Figure 3-10 on page 3-9 to check the log
file to determine the failure.

+ If the status is 2+ IMGS (which indicates "2 or more images") on the attached system you
wish to broadcast to, the image is not broadcast unless you select the “Delete images...”
option depicted in|Figure 3-10 on page 3-9} and you remove the images from the target
system.

8. You also can use the following additional options which are depicted in|Figure 3-10 on page 3-9|:
» Option 2: After you select the systems to broadcast and the page reloads, you see a status

message at the top of the screen. Use option 2 “View the Log File” to see the details of the
broadcast. This log lists the code that was successfully broadcast and the code that was

successfully finalized. If an error occurred, the log file will specify where the load failed. [Figure 3-12
i

n page 3-11 shows you a sample of status in a log file.
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—Remote Code Broadcast Log File

Thu Oct 02 05:31:28 UIC 2008: ATTACHED S5YS5TEMS FOR CODE BROADCAST Eﬂ

MODEL SERIAL IP ADDRESS HOSTNAME CODE LEVEL STATUS

3592 CO6 78C5011 172.31.1.35 rasC06 Unavailable NOT OK

3592 CO6 1300BEA 172.31.1.35 ra=sC06 Unavailable NOT OK

Thu Oct 02 09:31:28 UTC 2008: Completing gatherSystemStatus with rc=false

Thu Oct 02 09:31:28 UIC 2008: Starting prepareBroadcastList...

Thu Oct 02 0%5:31:28 UIC 2008: Systems to choose from are:

NO MODEL SERIAL IP ADDRESS HOSTNAME CODE LEVEL

0 3592 C06 78CS011 172.31.1.35 rasC06 Unavailable

1 3592 CO06 1300BEA 172.31.1.35 1rasC06 Unavailable

Thu Oct 02 09:31:2% UTC 2008: prepareBroadcastList completed

Thu Oct 02 09:31:29 UIC 2008: Completing phase 1 of copyCD successfully, requsting input

Thu Cct 02 09:31:29 UIC 2008: Viewing log

Thu Oct 02 05:39:02 UTC 2008: Input recieved, starting resumeCreateBroadcastlist. ..

Thu COct 02 09:39:02 UIC 2008: Attempting to broadcast to system numbers: 0 1

Thu Oct 02 09:39:02 UTIC 2008: System 0 was chosen to broadcast but cannot be broadcasted.

Status was: 3

Thu Oct 02 0%5:39:02 UIC 2008: System 1 was chosen to broadcast but cannot be broadcasted.

5tatus was: 3

Thu Oct 02 09:39:02 UIC 2008: Starting copyRemote...

Thu Oct 02 085:39:02 UIC 2008: No files copied to remote hosts =

Thu COct 02 09:39:02 UIC 2008: Completed copyRemote, returning false |

Thu Oct 02 09:39:02 UTC 2008: Completing copyCD, copyRemote failed 2

Tnu Oct 02 09:39:03 UTC 2008: Viewing log »g
<
©

Figure 3-12. Remote Code Broadcast Log File. See|Table 3-4 for a list of the possible status messages.

Table 3-2. Code Load Status Messages - From Web Interface. See for an example of broadcast status.

Status Meaning
OK OK to copy code to attached system
NO DIR No temporary directory exists on attached system to copy code into
PREV VER The temporary directory on the attached system is not empty
Unable to communicate with attached system (possibly due to downlevel code on attached
NO COMM : )
system or bad physical connection)
NO SPACE Insufficient space on attached system for copying code
NO SPC 1 Insufficient space on attached system's gdc file system for copying code
NO SPC 2 Insufficient space on attached system's usr file system for copying code
NO SPC 3 Insufficient space on attached system's gdc and usr file systems for copying code
There are two or more code images on the attached system (will not broadcast code unless
2+ IMGS . : p : W
you remove images by using the "Delete code images..." option.
NOT OK Unspecified error condition has occurred

» Option 3, “Clear the Log File,” deletes the log file and clears this screen. Use this when the previous
log file is irrelevant. Only use this option if you no longer need the old log file for reference to an

error.

» Option 4, “Eject the CD,” should be used when the disc is no longer in use or when you are
attempting to copy the code from the disc for a second time. If the program reports that there is an
error mounting the disc, remove and insert the disc again.

3-11
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Tape Drive Service Information

Attention: Many procedures in this book are code specific. Before starting any procedure, go to

[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level. The code level
requirements are:

System Console
Code Version 3.0.0 and above

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.28.700.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.5.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

1. See [Figure 3-13| After you complete the System Console configuration, the tool to update and review
tape drive service information for attached systems is automatically enabled. Right click from anywhere
in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39.

2. Select System Console Action --> Tape Drive Service Information.

Tape Drive S =B
Hao IP Address Last Update

LOG razakl ZRF0AEC FROO22S 172,31,1.25 10/22/04 19148141 S
MA razjil 2RE2IT0 FROOO1L 172,31,1.35 MEVER
MA rasvts 2494820 FBE2018 172,31,1.2 MEVER

Infor mation

Yellow Background (Systems with Updated Information
Gray Background (Systems which have not been queried)

(Selected systems are highlighted with a slightly darker color
than unselected systems)

il

Select Al | Desetectan | v oo g [ v e s View All Files update | ouit |

al4or250

Figure 3-13. Tape Drive Service Information — Main Screen

3. The[Figure 3-13)lists all systems attached to the System Console which might have tape drive
information available. The Main Screen shows a summary of the update status of the systems
attached to the System Console as of the DATE and TIME INDICATED in the right column. The
systems listed are highlighted according to the following color scheme:

Yellow Background
Tape drive information for this system has been updated
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Gray (or White) Background
No tape drive information has ever been reported to the System Console

4. Tape Drive Service Information is NOT run automatically. It is performed by selecting any number of
systems in the listing and then clicking Update. You can select individual systems by pointing to the
system list entry and clicking the left mouse button once. (Click the entry again to deselect the
system.) Alternatively, you can select all of the systems on the list by clicking Select All (or deselect by
clicking Deselect All).

5. As the System Console receives service information from the selected tape systems during the update
process, the selected systems become deselected (un-highlighted), the date and time of last update is
changed to the current time, and the new status is indicated by the background color of the system
entry listing.

Note: The update process can be lengthy with a large number of attached systems. However, this tool
will time-out after ten minutes for unresponsive systems and return control to the user. The tool
is normally unresponsive during the Update process and may appear to be locked up if
attached systems are not responding.

6. The Control Unit Tape Drive Service Information Files (code level V3.1.0 and above) show the
following information for each attached tape system, following a successful update (see [Figure 3-16 on
[page 3-15|and [Figure 3-17 on page 3-15):

» Control Unit Error Log showing tape drive entries (see |Figure 3-14)

+ Control Unit Tape Drive Status (see |Figure 3-15 on page 3-14)

Tape Drive Errorlog Details for ¥T52, 78 3 (3434B20) ) [=1 S
DATEATIME  LABEL TYPE RESOURCE  ERROR-INFORHATION
MaylS 07:49 SIM_MIM_RECORD_35 I rmtll SIH Mzglode-FID-FSC: G57-FF-CE59
MaylS 07:d4 TAPE_DRIVE_CLEAMI I rmtllalt Meed Cleaning FSC: 7036
MaylS 07:d4 SIM_MIM_RECORD_35 I rmtll SIH Mzglode—-FID-FSC: So-FF-703E
MaylS 06:39 RECOVERED_ERROR T rmth Fecovered FID-FSC-Tachi FF-3A31-38
MaylS 06:38 RECOVERED_ERROR T rmtGalt Fecovered FID-FSC-Tach: FF-3A31-3A
MaylS 06:38 RECOVERED_ERROR T rmtf Fecovered FID-FSC-Tach: FF-3A31-3A
MaylS 03:00 RECOVERED_ERROR T rmtf Fecovered FID-FSC-Tach: FF-3A31-38
MaylS 03:00 RECOVERED_ERROR T rmtf Fecovered FID-FSC-Tach: FF-3A31-3A
MaylS 03:00 RECOVERED_ERROR T rmth PREVIOUS ERROR REPEAT 1 TIMES
Mayld 21:23 TAPE_ERRZ P rmtlalt Hardware Err FID-FSC:  FE-3025
Mayld 20:39 TAPE_ERRZ P rotl Hardware Err FID-FSC:  FE-3025
Mayld 19:03 RECOVERED_ERROR T rmtGalt Fecovered FID-FSC-Tach: FF-3A31-38
Mayld 19:03 RECOVERED_ERROR T rmtf Fecovered FID-FSC-Tach: FF-3A31-3A
Mayld 19:03 RECOVERED_ERROR T rmtf PREVIOUS ERROR REPEAT 1 TIMES
Mayld 18:45 TAPE_ERRZ P rmtlalt Hardware Err FID-FSC:  FE-3025
Mayld 16:30 TAPE_ERRZ P rotl Hardware Err FID-FSC:  FE-3035
Mayld 16:30 RECOMERED_ERROR T rmtf Fecovered FIO-FSC-Tachi FF-3A31-36
Mayld 16:30 RECOVERED_ERROR T rmtfalt Fecovered FID-FSC-Tachi FF-3A31-38
Mayld 16:30 RECOMERED_ERROR T rmtf Fecovered FIO-FSC-Tachi FF-3A31-38
Mayld 15:52 TAPE_ERRZ P rotlalt Hardware Err FID-FSC:  FE-311A
Mayld 15:52 RECOVERED_ERROR T rmtGalt Fecovered FIO-FSC-Tachi FF-3A31-36 i
Mayld 15:52 RECOVERED_ERROR T rmtf Fecovered FIO-FSC-Tachi FF-3A31-38
Mayld 15:52 RECOVERED_ERROR T rmtGalt Fecovered FIO-FSC-Tachi FF-3A31-38
Mayld 14:27 TAPE_ERRZ P rotl Hardware Err FID-FSC:  FE-3035
Al
(<)
0K 5
I
©

Figure 3-14. Tape Drive Service Information — Tape Drive Error Log Details Screen
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Figure 3-15. Tape Drive Service Information — Tape Drive Status Screen

3-14

Tape Drive Status for Host: WTS1

2494B20 FAR2018 (172.31.1.2)

Device Type/Model Serial Code Lewel Status
ddevrmt( A090E1A O0DE29% F23c Available
ddevdrmtlalt A090E1A O0DE29% F23c Defined
ddevdrmtl Ah90E1A O0DEE24 F23c Available
Sdevdrmtlalt Zh90E1A O0DEE24 F23c Defined
Sdevdrmt? 3h90E1A O0DEE19 F23c Available
SdevdrmtZalt In90E1AR O0DE319 F23c Defined
Sdevsrmt3 INI0EIAR OODEEZRT F23c Available
ddevdrmt3alt SM90ELIA O0DEZRT F23c Defined
ddevdrmt4 3D90EIA O0DE320 F23c Available
ddevdrmtdalt 3D90ELA OODE320 F23c Defined
Adevdrnth A0O0ELA O0DE3EL F2ac Available
Adevdrmthalt Z0O0ELR O0DE32L F2ac Defined
Sdendrmtb Defined
ddewdrmtBalt Defined
Sdendrmt 7 Defined
Sdewdrmt7alt Defined
Sdendrmt8 Defined
SdewdrmtBalt lefined
Sdevrmt Defined
ddevdrmt9alt Defined
ddevdrmt 10 Defined
Adevdrmtloalt Defined
ddevdrmtll Defined
Adevdrmtllalt Defined

0K |

==
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Driwe Infa Files for rasaB0, TE00239 [(3590A60)  — 1 %
errparse, out I
ertpt,expanded, txt
ertpt,tops,srt, txt
etrtpt,tops, sum, txt
ertpt,.zzz, txt
oc_lwl,out

=l

al4or251

LABEL : RECOVERED_ERROR
Date/Times Morn Oct 18 15:04:43
Type? TEMP

Rezource Mame:  rmtd

Resource Class: tape

Resource Type: 3890

Location: 10-70-01-PRI

SENSE DATA

OBO0 QOO0 000 oo Qo0 Good G000 GO0 G102 G000 FA00 L0 Goon G058 G000 G000
2002 FFO2 3A7S 0000 0003 0150 0006 1040 0000 Q000 0230 5600 Q000 0000 Q000 Qo0
0000 QOO0 QA0 OO0 QZ00 Q000 G000 Q000 G000 Qaad QOBH G000 Q000 G000 3243 4420
2020 2010 0000 Q000 Q000 Qo000 0001 4000 Q000 Qa0 Q000 GO0 QOO0 OO0 QA0 GO0
Q000 Qoo (a0 QOO QoG oo GO GO0 OO (g OO G oo Gk

Device Type = 3590

Senze Key =1 Recovered Error

ASCAASCO = 3002  Cannot Read Medium, Incompatible Format
SC51 Cmd =00 Test Unit Ready

FID = FF

1=t CU Err = 3A75

1zt CU Flag = 0002

2nd  CU Err = 3CHE

Tach = 0B

al4or252

ok |

Figure 3-17. File Viewer Showing a File Generated by Tape Drive Service Information — Code Level V3.1.0 or Above
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7. Each report may be viewed by selecting one of the systems listed on the Main Screen
bpage 3-12), then clicking View Error Log or View Drive Status. Systems may be selected by pointing
to the system list entry, and clicking the left mouse button once. (Clicking the entry a second time
deselects the system.)

For code level V3.1.0 and above, you can use the additional action View All Files. This action allows
you to view all drive service information returned by a tape system. You also can find additional
formatted or unformatted error information in these files.

8. From the Main Screen in|Figure 3-13 on page 3-12, select Quit to quit.

Tape Drive Code Broadcast From Web Interface

Attention: Many procedures in this Ml are code specific. Before starting any procedure, go to [Chapter 1,
[‘Maintenance Starting Point,” on page 1-1|to determine the code level. The code level requirements are:

System Console
Code Version 5.3.x and above

IBM TS7700 Virtualization Engine
System Console must be a hardware model 8485 (x206m) or 8849 (x306m)

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.26.xx.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.xx.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational
1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39}

2. From the Main Menu, select System Console Actions > Console Configuration Utility. Type
service in the Username field, type service in the Password field, then click OK.

3. Select System Tools > Drive Code Broadcast. You see|Figure 3-18,

TS3000 System Console

Remote Code Broadeast Drive Code Broadcast Import Info Center T33C Exec M ksvsb Broadcast

Actions
Use this servlet to manage tape drive code on this console, broadeast drive code, or gather tape drive information from remote systems.

Ilake your selection below:

" Ilanage tape drive code on this consols
" Broadeast tape drive code

" Gather tape drive information

al4or510

Figure 3-18. Drive Code Broadcast Web Interface

4. Select the Manage tape drive code on this console option under Actions to view tape drive code
currently on the TSSC. From this screen you may add new code to the console or delete existing
code.

5. To add code, click on the Add new tape drive code to this console button. You will be prompted to
insert a CD-ROM containing tape drive code into the optical disc drive. Once the disc has been
inserted into the console, click OK to continue. If a valid drive code CD was inserted, you will see a
listing of the drive code on the disc, similar to |Figure 3-19 on page 3-17]. Check the box next to each
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entry you want to copy to the console and click Copy selected code to console. If you don't want to
copy any code from this disc to the console, click the Cancel button.

, 193000 System Console

Eemote Code Broadeast Drive Code Broadecast

—Actions
Use this servlet to manage tape drive code on this console, broadeast drive

Iake wour selection below

& Manage tape drive code on this console
" Broadcast tape drive code

" Gather tape drive information

—Ilanage Tape Drive Code
select the code images to copy to this console: _
|| Filename | Date [Size (bytes)
’F!DSIID_CSE.fmr |Thu Jun 12 2225116 UTC 2008 |359658£1

al4or507

Copy selected code to console | Cancel |

Figure 3-19. Drive code listing. You may copy selected drive code to the console

6. Similarly, to delete existing code, place a check mark next to the code images you wish to delete. Click
the Delete selected code button and you will be prompted to verify the delete operation. Click OK to
continue deleting the selected drive code or Cancel to return to the previous screen.

7. See [Figure 3-20 on page 3-18| To broadcast tape drive code to systems attached to this console,
select the Broadcast tape drive code option under Actions. The display will change to show the
existing code on this console and all valid broadcast targets attached to this TSSC. (Optionally, you will
also see other TSSCs connected over the Grid network.) Place a check mark next to each code image
to broadcast and each target system that should receive the broadcast. You must select at least one
image and one attached system. Once your selections have been made, click the Broadcast Selected
Code button. You will be prompted to verify the operation, so click OK to continue the broadcast or
Cancel to return to the previous screen. The broadcast may take several minutes to complete
depending on how many target systems were selected. Once the broadcast has finished, you will see
a message displaying the status of each individual broadcast.
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» 153000 System Console

Eemote Code Broadcast Drive Code Broadcast

—Actions

Uze this servlet to manage tape drive code on this console, broadeast dris

IMake yvour selection below

" Manage tape drive code on this console
® Broadcast tape drive code

" Gather tape drive information

— Broadeast Tape Drive Code
=elect the code images to broadcast:
|| Filename || Date [Size (bytes)
|F|D31|:}_CSE.fmrz Wed Jul 21 10:04:32 UTC 2010 3596584

=elect your broadeast targets:

|F|Max:hine type ISerial number |Hostna:me | IP address
(|| 3592c06 || 7eCsoz4  [3590cu2o [172.31.1.247
(|| 3s02c06 || 78Cs833  [3590cult [172.31.1.242

Broadcast Selected Code | Cancel |

al4or508

Figure 3-20. The broadcast screen will display all available code images and valid broadcast targets.

8. See |Figure 3-21 on page 3—1Ql You may gather tape drive information from attached systems by
selecting the Gather tape drive information option under Actions. The display will show all valid
attached systems. Place a check mark next to each system for which you would like to see tape drive
information. Once your selections have been made, click the Gather information from selected
systems button. You will be prompted before information is gathered. Click OK to continue or Cancel
to end this process. Clicking OK will proceed with the gathering process. It may take several minutes

depending on the number of systems selected. Once finished, the screen will display tape drive
information for the selected systems.
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. 133000 System Console

Remote Code Broadeast

Successfully gathered tape drive information from all selected svstems.

— Actions

Use this servlet to manage tape drive code on this console, broadcast drive code, or

Make vour selection below:

O Manage tape drive code on this console
O Broadcast tape drive code

® Gather tape drive information

— Gather Tape Drive Information

Tape drive information from selected svstems:

Hostname Images Device Tvpe | Serial |Code
D310_C90 finrz o |
- devirmtlpriA |3392-E06 1326806 | 268F
06 |D311_ESB finz S
T ID31_EAS fmez[ | “ x
D312_68F finrz devimmtlpriB 3592-E06|1326806 |268F
Gather information from selected systems ” Cancel

al4or509

Figure 3-21. Display showing tape drive information for a selected system

Remote Access Using NetTerm

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

When using a workstation or notebook (laptop) computer with a modem, it is first necessary to establish a
connection to the System Console modem. The following instructions apply for using the NetTerm tool.
(Other tools also may be used.)

Configure NetTerm for Accessing a System Console's Modem
From the Phone Directory window, click OK.

Start the NetTerm program.

From the NetTerm Start-up Window tool bar, select File.

From the File pop-up list, select Phone Directory.

From the Phone Directory window, select Modem Test.

From the Phone Directory window, modify the following fields to the values listed:

ook wd =
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11.

12.

13.

14.
15.

16.
17.
18.

19.
20.

21.

Field Entry

Name (select a name with which you are comfortable. An example would be Customer name.)
Phone Number of Modem (from Configuration Sheet-Select modem attached to COM1-ttySO)

Emulation IBM_3151

Keys IBM_3151

From the Phone Directory window, verify that the Connection field has Modem selected.

From the Phone Directory window, click Modem Settings. This will bring up a Communications Setup
window.

From the Communications Setup window, click Modems. This will bring up a Select Modem window.

From the Select Modem window, click Default. You can be returned to the Phone Directory window or
the Communications Setup window. To return to:

* Phone Directory window, go to Step
* Communications Setup window, go to Step .

From the Phone Directory window, click Modem Settings to bring up the Communications Setup
window.

From the Communications Setup window, modify the following fields to the values listed:

Field Entry

Port: xxxx (Select the port for your PC/Laptop modem)
Baud Rate: 56000

Data Bits: 8

Parity: None

Stop bits: 1

Modem Initialize command-Accept Default:AT E1 V1 M1 QO &B1 &C1 &D2 &H1 &R2 &NO &K1 S11=50 S7=60

Control Settings (click on box to change)

DTR/DSR box unchecked
RTS/CTS box checked
XON/OFF box unchecked

Tone Dialing box checked

Direct Line box unchecked
Ignore Carrier box unchecked
Use TAPI box unchecked

After making the changes to the Communications Setup window, click OK. You will be returned to the
Phone Directory window.

From the Phone Directory window, click Desktop.

From the Desktop window, change the following settings:

a. Click on the Autowrap box to place a check mark (+) in that box.

b. Click on the Exit NetTerm on disconnect box to remove the check mark from that box.
From the Desktop window, click OK. You will be returned back to the phone Directory window.
From the Phone Directory window, click Color.

From the Screen Colors window, click on the Allow Graphics rendition code of 0 to reset colors
to default to place a check mark (+) in that box.

From the Screen Colors window, click OK. You will be returned to the Phone Directory window.
From the Phone Directory window, click Add.

Note: The Phone Directory entry (the name for this activity that you selected in Step
may not be displayed in the phone directory list until you exit and restart the NetTerm
program.

From the Phone Directory window, click OK.
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Connecting to a System Console's Modem
1. From the NetTerm main menu, select File.
2. Select Phone Directory.
3. Select the Phone Directory Entry established for this console (entry previously created in Step
[page 3-19).
4. Select Connect.
Note: If the LAN network is down, have the service representative or the customer administrator

install the 30.5-m (100-ft) serial cable that was shipped with the IBM 3953. It attaches to the
SO0 port (S1 port on IBM 3953).

CONNECT 33600
IBM TS3000 System Console Version 4.0.0-121905 Level: gint-1021

raselmc.storage.tucson.ibm.com login: |

Figure 3-22. Enter Password Screen

5. Login to the System Console as user Service (this login is case-sensitive) Use the password
provided from IBM Support to begin the authentication process. Enter your Authentication ID when
prompted. This will be your unique userid also provided by IBM Support.

4 N
3.0.0
tssnetl Togin: Service
Password:
Last login: Tue Apr 2 15:32:20 on ttySO
Please enter your Authentication ID: jdoe
Group: Service
userdel: user jdoe does not exist
Creating user jdoe
Account expires on: 05/25/04
Changing password for user jdoe
New password:
Retype new password:
passwd: all authentication tokens updated successfully
Initiating broadcast to... vtsl
Initiating broadcast to... vts2
Initiating broadcast to... vts3
Initiating broadcast to... vts4
Waiting for completion...
vtsl: Ok
vts2: 0k
vts3: Could not execute remote command
vtsd: 0k
Continue with the following key code.
Key: en7260wv93Lzg577XXLR7A2X2UxBh155bv8fjylo5me?1
Press [c] to continue.
¢
Exiting
N J

Figure 3-23. Connect to System Console Modem Screen

Notes:

» This process attempts to copy your userid and password to attached VTS, VTC, or Tape
Controller systems. This process may not complete successfully on all attached systems.
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* Note the results after "Waiting for completion..." This indicates the success of copying
your password to systems attached to the console.

* Your userid and password will be valid for the time indicated on the console and for all
systems that indicate "Ok" after "Waiting for completion..."

* The "Waiting for completion..." process should not take longer than five minutes before
timing out.

* For systems which do not respond with "Ok", you will need to either perform a separate
authentication, or login using methods from previous code levels.

* See |“Login Options” on page 2-37| (Authenticated) for more information about systems that
do not respond "Ok".

6. Use the mouse to highlight the line containing the "Key ..." string. From the NetTerm main menu,
select Edit --> Copy to place the key on the clipboard. Enter ¢, and press Enter to continue and to
exit the session.

Note: Access to an IBM Authentication Server is required to perform the following step.

7. Using the key that was generated in Step@ login to the IBM Authentication Server to retrieve your
authentication password. When requested, use the NetTerm main menu commands Edit --> Paste to
provide the key to the authentication server.

UserId is jdoe, AccessLvl is Service
Please enter Key Code.

Key: en7260wv93Lzg577XXLR7A2X2UxBh155bv8fjylo5me?]
Key: en7260wv93Lzg577XXLR7A2X2UxBh155bv8fjylo5me?1

Hello jdoe Please login using password: abcd321

Figure 3-24. Userid Screen

8. Make a note of your password from the IBM Authentication Server. Continue logging in to the System
Console. Your password will be valid for as long as twenty-four hours.

Note: Do not use a Copy/Paste keyboard function to enter your password for System Console login.

9. Login to the System Console, by using your unique userid and the password that were provided by
the IBM Authentication server.

IBM TS3000 System Console Version 4.0.0-121905 Level: gint-1021

raselmc.storage.tucson.ibm.com Togin: jdoe
Password:

COLOR NETTERM

jdoe@raselmc:"> |

Figure 3-25. Enter Password Screen

10. From the command prompt, you may perform console tasks or you may alternatively communicate
with tape systems that are attached to the System Console.

Note: It is possible that the keyboard function keys (F1, F2, and so forth) and the Backspace/Delete
keys will not work as they should. When this happens, enter the following command at the
command prompt: export TERM=vt100. If the function keys still do not work as they should,
use the combination Esc+xx , where xx is the number of the function key.

11. To telnet to systems that are attached to the System Console, issue the 'tsys' command, and enter
the number of the system to which you would like to connect (see|Figure 3-26 on page 3-23[). You
can use the command tsys-? to view the choices for reordering the list.

3-22 1BM TS3000 System Console Maintenance Information — 29th Edition November 2012



4 N\
IBM TS3000 System Console
Telnet to Attached Tape System
# Make/Model  Serial Number IP Address Hostname
1 3494B20 78B2018 172.31.1.40 rasvts
2 3494122 1314501 172.31.1.5 "LMA"
3f: 3590A60 7000239 172.31.1.26 rasa60
4: 3592J70 100B89A 172.31.1.36 rasj70
5: 3953L05 1300004 172.31.1.11 "LMA"
6 3953L05 1300004 172.31.1.12 "LMB"
\Which system would you 1ike to connect to (or 'q' to quit)? | )

Figure 3-26. Choose System Prompt

You may login with your userid and password to any of the attached systems that responded with
"Waiting for completion..." —> "Ok" in Step[5 on page 3-21| above. See "Authenticated" in
|Options” on page 2-37| for information on how to login to systems that did not respond "Ok."

12. To logoff from the System Console, type exit at the command prompt, and press Enter.

[jdoe@tssnetl jdoe]# exit
Togout

Figure 3-27. Logout

13. From the NetTerm main screen, select File, then Exit to close the NetTerm tool.
Call Home Queue Management

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39

2. From the Main Menu, select System Console Actions —> Console Configuration Utility. You see
the [Figure 2-53 on page 2-40|

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application.

4. Click Call Home Queue. You see the |Figure 3-2§|. The various call home record types (in the "Type"
column) are described in[Table 3-3 on page 3-24]

TS3000 System Console

Call Home Queue Call Home Event Log Failed Queus

— Selection Functions

® | Delete Selected Entries

. [ Increase Selectad Entries Priority ]

. [ Show Selected Entries Details I

. [ Send Call Home Now I

. [ Offload Selected Entries to USB I [ Delete after successfil offload
. [ Offload Selectad Entries to CO ] [ Delete after successful offload

al4or470

Figure 3-28. Call Home Queue Management - Main Screen
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Table 3-3. Call Home Record Types. From the Type column in|Figure 3-28 on page 3-23

Type Description

DC Data Call Home (Binary)
DI Information - EC Install, Call Home Test
DT Dump/Trace (Binary)

EC EC Activation

HB Heartbeat MRPD

IS Install

PB Problem Record

PE PE Package (Binary)

PG Problem Page

PI Proactive / Warning

PT Pager Test

RI Close Problem

RL Remote Dial-In

SwW Software Problem Record

The Queue Management tool offers the following capabilities:

View current entries in Call Home queue on the System Console
Delete or Change priority of entries

View details of specific entries

Offload individual packages immediately

Offload Call Home Entries to Diskette

5. To Delete or Force Delete a Call Home Queue Entry, select the entry by clicking on the check box
next to the corresponding entry. Click Delete Selected Entries. To Show Details for a Call Home
Queue Entry, select the entry by clicking the checkbox next to the corresponding entry.

6. Click Show Selected Entry Details. [Figure 3-29 on page 3-25| displays.

Note: For DC and PE packages, the TSSC will provide the following features:

3-24

» To download a specific file from the call home package, click on the Data Package link.
This will allow you to extract the files from the package, but will not affect the contents of
the package when the call home file is offloaded.

» Below the package's header information you will see a listing of all of the packages in the
call home file.
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'S3000 System

Console

Close this window

Entry details on Apr 06 09:02:08 U

TC 2010.

Priority: 24

Queune Entry Type: PE package

Hostname: Newman

Machine Type: 3957
Machine Model: V06

Machine Serial Number: 7800CTA
Machine Cluster Number: System Console

Queue Entry Name: V24714
Queue Entry Status: Pending

Transfer

Queue Entry Size: 1003520
Time Last Modified: Apr 06 09:00:02 UTC 2010
Time Created- Apr 06 09:00-02 UTC 2010
Lk to Data Package: Data Package

Header File:

# Begin of call home record....vssssessss = BEGIN OF FILE ”~
# Product Manufacturer ID and Date...... = i
# Business/Company Name........cevcevenn = IBM TS7700_SLI Do Not Dispatch

4 Product Machine type and model number.= 3957V06

# Product serial DUmbET................. = 7800C7A 1
# Remnte service call back number.......=

# Call back user ID......... = support

# Call back pasaword........ =

# Customer voice phone numbe: ok .= 5207994730

4 Cuscomer offshift voice phone number..= 0O

# Reporting Cluster Number.............. s

FBepord bype. oo s = &5

# Report time/date Stamb.......eoevvaeens = 04/06/10 0B:59:57 UIC

# Machine LocatioD...sesrssrerrnnrcnrens = B9042 1500 Tucson AZ

# Level CPS5 AnfOrMATION.......evvecennn =

# Level MasterConsole informatioD....... = 5.7.5-032210 gint0.0

£ T Tobitad 2led o Tarah u b o Vs o R = END OF FILE

Files in /tmp/V24714/tardir/PE package

PE/

PE/var enc_log/ |l

Figure 3-29. Call Home Queue Management — Call Home Queue Entry Details

To refresh the Call Home Queue listing table, select Refresh Queue.
To offload a Call Home Queue Entry to Diskette, select the entry by clicking the check box next to the

corresponding entry.

Select Offload Selected Entries to Diskette. [Figure 3-3Q displays.

Insart 3 OE formatted diskette into the diskette drive
and click OF to continue.

Mote: This opsration will erass any previous data on the
diskette!

Figure 3-30. Call Home Queue Management — Offload Queue Entry to Diskette

10.
11.

Click OK.

a14or309

al4or479

To Offload an individual package immediately, select the check box next to the package you want
offloaded and click the Send Call Home Now button. The page will return with a message to confirm

the completed action.
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Failed Queue Management
You can use the System Console to view the Failed Queue Management screens.
1. Right click from anywhere in the Desktop.
2. From the Main Menu, select System Console Actions +Console Configuration Utility.

3. Type service in the Username field, type service in the Password field, then click OK to start the
Console Configuration application.

4. Click Call Home Queue.
5. Click Failed Queue at the top of the page. See screen shot below.

TS3000 System Console

Call Home Queue Call Home Event Log Failed Queue

— Selection Functions

. I Maove Selected Entries to Call Home Queue ]

. [ Delete Selected Entries ]

L] [ Increase Selected Entries Priarity ]

L] [ Show Selected Entries Details ]

L] [ Send Call Home Now ]

. [ Offload Selected Entries to USB ] [ Delete after successful offload
. l Offload Selected Entries to CD ] [ Delete after successfil offload

al4ord71

Figure 3-31. Call Home Queue Screen.
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This screen shows the new Failed Queue interface. The Failed Queue Management tool offers the
following capabilities:

View Call Home entries that have failed on the System Console.
Return a failed queue entry back to the active Call Home queue.
Delete failed queue entries.

Offload individual packages immediately

View the details and associated log files of failed queue entries.
Offload failed Call Home entries.

6. To Delete or Force Delete a Failed Call Home Queue Entry, select the entry by clicking on the check
box next to the corresponding entry. Click Delete Selected Entries.

7. To Show Details for a Failed Call Home Queue Entry, select the entry by clicking the checkbox next
to the corresponding entry. Click Show Selected Entry Details. See the following figure.

~®ooov

Note: For DC and PE packages, the TSSC will provide the following features:

« To download a specific file from the call home package, click on the Data Package link.
This will allow you to extract the files from the package, but will not affect the contents of
the package when the call home file is offloaded.

« Below the package's header information you will see a listing of all of the packages in the
call home file.

S3000 System Cansole | Close this window |

Entry details on Apr 06 09:02:08 UTC 2010.

Prionity: 24
Queue Entry Type: PE package
Hostname: Newman
Machine Type: 3957
Machine Model: V06
Machine Serial Number: 7R00CTA
Machine Cluster Number: System Console
Quene Entry Name: V24714
Queue Entry Status: Pending Transfer
Queue Entry Size: 1003520
Time Last Modified: Apr 06 09:00:02 UTC 2010
Time Created: Apr 06 09:00:02 UTC 2010
Link to Data Package: Data Package
Header File:
|# Begin of call home record.............
‘# Product Manufacturer ID and Date...

|# Business/Company Name
‘# Product Machine type and model number.

BEGTH OF FILE &

IBM_T57700_SLT Do Not_Dispatch
3957V06

|# Product serial number................. 7800CTA

|# Remote service call back number.......

|# Call back user ID.........ooounnnn..n support

‘# Calliback DASSWOrd. - e

|# Customer voice phone DUmDET........... 5207994730

o

3

65

04/06/10 08:59:57 UTC
B9042 1500 Tucson AZ

‘* Customer offshift voice phone number. .
|# Reporting Cluster Number..............
‘* RECOTH BV . . o cr cxcone oo o osom s
|# Report time/dace stamp..
|# Machine Location........
|# Level CPSS information..
‘* Level MasterConsole information....... 5.7.5-032210 gint0.0
|4 End of record Flag...-cc.eeeceeeacoenn END OF FILE

|Files in /top/V24714/tardic/PE package
BE/
PE/var enc log/ ¥

aldord79

Figure 3-32. Call Home Queue Management. Call Home Queue Entry Details

8. To refresh the Failed Call Home Queue listing table, select Refresh Queue.

9. To offload a Failed Call Home Queue Entry to Diskette, select the entry by clicking the check box
next to the corresponding entry.

Chapter 3. Procedures  3-27



10.

Select Offload Selected Entries to Diskette. The following figure is displayed.

Insart 3 [0S formatted disketts into the disketts drive
and click OK to continwe.

Mote: This opsration will erass any previous data on the
disketis!

a140r309

Figure 3-33. Call Home Queue Management. Offload Queue Entry to Diskette

11.
12.

13.

Click OK.

To view the log for a specific Failed Call Home entry, click view in the Log File column for the

corresponding entry. The following screen will be displayed at the bottom of the page.

To Offload an individual package immediately, select the check box next to the package you want
offloaded and click the Send Call Home Now button. The page will return with a message to confirm

the completed action.

—Failed Queue Log File

ECC ECC Call Home 2008/02/13-17:47:02:331 *I* 00000 00000 Entering (A
setLockProps 7l
3957 06 B00EBA
ECC ECC Call Home 2008/02/13-17:47:02:334 *I* 00000 00000 Executing
r3SetECCLockProps /var/enc/rsENHomeQ/38957V0678008BRAC0.DCEL18215
ECC ECC Call Home 2009/02/13-17:47:02:362 =I% Q0000 00000 Processing:
3957V06TE00E8BAcO.DCEL1B215
ECC ECC Call Home 2008/02/13-17:47:02:364 *I* 00000 00000 Entry
2957V06TE008BAc0.DCE1E215 found and readable
ECC ECC Call Home 2008/02/13-17:47:04:053 *I* 00000 00000 Report built for
3957V06TE008BAc0.DCE1S215S
ECC ECC Call Home 2008/02/13-17:47:05:717 *I* 00000 00000 Package currently

in-progress: null

Exception in thread "main" Gen.OperationFailed: Primary Svstem Properties File Not Found:
553957V06768008BAcO.properties

at

com,.ibm.mcp.tsmc . MCPPlatformExtension.retrieveSystemlidentityInfo (MCPPlatformExtension. java:126)
at com.ibm.ecc.common.Service.retrieveSystemIdentity(Service.java:2%4)

at com.ibm.ecc.common.Service.checkSystemIdentity (Service,java:13138)

at com.ibm.ecc.common.Service.retrieveDefaultCredentials (Sexrvice.java:930) N
at com.ibm.ecc.common.Service.sendWebServiceRequest (Service.java:347)

at

com.ibm.ecc.statusservice.StatusReportContext$StatusService. submit (StatusReportContext.java:125
at

com. ibm.ecc.statusservice.StatusReportContextésStatusService . access$100 (StatusReportContext . java (v
< | »

Figure 3-34. Failed Queue Log File.

3-28

Note: There are generally three cases to look for in the log file to determine why a particular call

a.

home failed.

IBM TS3000 System Console Maintenance Information — 29th Edition November 2012
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If you see a message stating the "Primary System Properties File Not Found," this means the
system attempting to call home is not attached to the TSSC. The system must be attached to the
TSSC before it can call home. When the machine is attached, this package can be moved back
to the Call Home Queue.



b. For logs containing "Failing Machine Type: [####] Serial: [#######] is NOT REGISTERED in the
[CCPF] system," the attached machine is no longer under warranty and cannot call home. The
next line of support should be contacted if further help is required.

c. The last case will say that a "Duplicate file is in testcase." This means this call home package has
already been called home, and this copy can be discarded.

Call Home Event Log

You can use the System Console to view the Call Home Event Log and see the history of Call Home
packages that have been sent by the System Console.

1. Right click from anywhere in the Desktop.
2. From the Main Menu, select System Console Actions -Console Configuration Utility.

3. Type service in the Username field, type service in the Password field, then click OK to start the
Console Configuration application.

4. Click Call Home Queue.
5. Click Call Home Event Log at the top of the page. See screen shot below.

$3000 System Console Close this window

Call Home Queue Call Home Event Log Failed Queue

Use this tool to view the log of call homes sent by this censole and to log activity at the completion of senvice.

Log Viewer Controls Left Master Consele. Type Serial Type  Gueue Entry PMR SIM LABEL Resource

Pas

20081090221 2818 2957V08 72082EC 0 oI Diwg7128 12120
Entries per page [2008i08/02 212257 2957V08 780825 0 ol Dis25122 13118
50 v [2002109/02-21 2209 2957v08 78082EC g ol DIQ11828 13115

[2008/08/0221:20:50 2957V08 780825 0 ol Dim24253 13113
Call Home Type |2008/08/02-21.02:18 3957V08 7B082EG Q ol DIDBEX589 12101
All ha
Subsystem Type
All &

Sort Order
Descending v

Refresh

Viewing entries 1-5

al4or431

Figure 3-35. Call Home Event Log.

6. You can use the Log Viewer Controls to sort the event log entries. Sort categories include the
following:

a. Number of entries per page
b. Type of Call Home package
c. Subsystem Type

7. Certain Call Home packages offer detailed information in addition to what is displayed in the event log.
When additional information is available, a Detail link will be displayed in the far right column. See the
following figure.

- - i — — ©
2009/02/02-12:48:11 3257V0S T8082EG a FB FBt-ipUa 13136 CORE_DUMP SYSFROC Detail g
2009v08/03-11:45:59 3857V06 T8083EG 0 FB FB123Bhz 12048 D=tail ;O_,
2008/02/02-00:18:11 2BETV0E TB082EG o rasmatazz PB PBQN2hMa 12787 OC_ENV_ERR_PERM Router Detail g

Figure 3-36. Call Home Event Log entries showing the Detail link
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8. Clicking the Detail link brings up another window with additional event information as shown in the
following figure.

Call Home Queue Entry PBt-ipUa

Hostname rasmatazz

Systemn Type 3957YV06

Serial Mumber T8083EG

Fack Fosition 0

FPME Mumber 13136

Cata Record Locatar er8-083EGp0030220092035402040050

SIN Details

RCIRQC Index 3

Message Modifier 2204

Message Data 00 0000

SN [dentifier 4

LInit Identifier GO0

Fefcodes e000 380382 0000

Label CORE_DUMP

[dentifier AQZ4ABFC 3
Resource Name SYSPROC %

Figure 3-37. Detailed Event Log Information

Offloading User Files

You can use the System Console to offload user files by various means. For example, for user service,
the directory would be /home/service/offload. If you are logging on remotely, you can use the browser to
download the files onto your system.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|
2. Select System Console Actions — Console Configuration Utility. Login, as required.

3. Select Offload User Files. You see|Figure 3-38 on page 3-31| The directory setting defaults to your
user's offload directory. For the user service, you will be prompted for the directory you wish to
download the data. The suggested directory is "/home/service/offload." You can change to a different
directory by adding another name in the "Specify a different offload directory" field, and clicking the
Refresh button next to that input area. You may also change directories by clicking a directory name in
the file list field.
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TS3000 System Console Close this window

—Offload User Files

[You are logged in as: service

Specify a different offload directory: [homelservice/offload Refresh

O

File Name | Size ‘ Last Modified

\r\ !;hwme-smice;DfﬂoacL20080519083533.)&1"d|1§73739 ‘Mnn May 19 08:35:33 UTC 2008

‘r\ |«home-'smme«nfﬂnad.-zuusus19083533,21,0 |-masu ‘Mnn May 19 08:35:33 UTC 2008

“_‘ !;hwme-s

mﬂce;ufﬂoad,EUUEUSEUUESSI1.xwd|1§73739 ‘Tue May 20 14:33:11 UTC 2008

‘r\ |«home-'smme«nfﬂnad.-zuususzunzﬁa11,zm |ﬁns:1 ‘Tue May 20 14:53:11 UTC 2008

\r\ !;hwme-smicesufﬂoad,20080520025322.)&1"d|1§73739 ‘Tue May 20 14:33:22 UTC 2008

‘r\ |«home-'smme«nfﬂnad.-zuususzunzﬁazz,zm |ﬁ[|533 ‘Tue May 20 14:53:22 UTC 2008

“_‘ |;th3-

service/offload/tssc fail rashorse.txt |418 "Méd May 21 08:52:08 UTC 2008

Refresh

Delete Selected Download Selected

‘ CopytoUSB | [T] Delete After Successful Copy

‘ Copyte CD [T Delete After Successful Copy

‘ Copy to CallHome [T Delete After Successful Copy

a140r362

Figure 3-38. Offload User Files Menu Example. This example does not include Copy to Diskette.

4. Left click the check boxes next to the file names to select individual files, or left click the box next to

the heading "File Name" to select all the files. You can press Refresh below the list to clear from the
check boxes all the choices you made.

Note: Your hardware platform will determine the options that are available on this menu. Only those
options that are available for your server type appear in the list.

5. Ensure that you have installed the media you are going to offload files to. Use|Table 3-4{ to determine
the media type or the method you are going to use to offload user files.

Table 3-4. "Offload User Files" Options

Menu Option

Purpose

Copy to Diskette

Copy to USB

Copy to CD

Copies files to the media type you select

Copy to Call Home

Packages files in a data call home and places them in a Call Home queue for transmission

Delete Selected

Deletes files from the directory
Warning: Do not delete files that are vital to System Console function.

Download Selected

Compresses files into a file called ServiceOffloadBundle.zip.

Notes:

* You also may save a single, raw file by clicking on the filename, or right-clicking the
filename and selecting "Save target as." You will be prompted with a download box. If you
rename this file, do not allow in any blank spaces in the title you give it.

» Download Selected compresses the files into a smaller package to lessen the
transmission time. This is used primarily by IBM Support.

Refresh

Refresh the screen (Figure 3-38)

Note: Select "Delete After Successful Copy" if you want to remove the files that you are copying from
the listing after you copy them.

the files.

You see a confirmation box. Ensure that you read all the text in the confirmation box. Click OK to copy

If you are logged in remotely, you may offload the files directly to your hard drive by clicking on the

filename in the table.
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Starting and Stopping ALC (Automated Log Collector)
This tool is used to gather log data associated with specific 3584 errors.
1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39|

2. Select System Console Actions —> Console Configuration Utility. You see the login prompt shown
in [Figure 2-53 on page 2-40|

3. Type service in the Username field, service in the Password field, then single click OK.
4. Select PE Packages > Subsystem Log Retrieval link. You will see the image below.

z, 193000 System Console Close this window |
Svstem Console PE Package Subsvstem Log Retrieval
— Select Logs - Action
First: Select machine tvpe of the svstem voun Dlease select a svstem to the left.
would like to retrieve logs from:

- Select a Maching Type - [+| Already refrieved logs? Click here to offload |3
the logs to call home or media. k)
s

Figure 3-39. Subsystem Log Retrieval

5. In the “Select Logs” section, use the drop down to select a 3584.

» 193000 System Console Close this window |
Svstem Console PE Package Subsvstem Log Retrieval
— Select Logs Action
First: Select machine type of the system vou Please select a system to the left.
would like to retrieve logs from:
3584132 [v Already retrieved logs? Click here to offload

the logs to call home or media.

Nexut: Select the individual machine. To match
hostname and IP addresses to a
specific machine, refer to the Attached
Svstems page. If vou do not see vour
svstem in the list, make sure it is attached and
can be queried successfully.

- Select an Attached System - |v

al4or481

Figure 3-40. Select Logs

6. From the new drop down that appeared, select an attached system.
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TS3000 System Console | Close this window |

Svstem Console PE Package Subsvstem Log Retrieval

—Select Logs — Action

First: Select machine type of the svstem vou would Retrieve Logs

lilke to retrieve logs from: - Once logs are retrieved, they will exist in
3584132 R4 wvar/enc/offload directory.

Next: Select the individual machine. To match Already retrieved logs? Click here to offload the
hostname and IP addresses to a
specific machine, refer to the Attached Svstems
page. If vou do not see vour —ALC
system in the list, make sure it is attached and can be
queried successfullv.

RAS3584 Serial Number: 13AAA15 'V|

logs to call home or media.

Error code identification strings:

(all, none, 2FXX (separate multiple entries with a
comma))

Turn on NVRAM log gathering? [

Library Logs 1‘0_ = Drive Logs: Turn on early termination? [

LIBLG_01_OP 0 DRIVE_01_01 Tiaeyon dobogiie? B

BIELG L D I DHAVE: B 00 How long do vou want ALC to run (in days):
LIBLG_01_ER [J DRIVE_02_01 = < " L
LIBLG_01_AC [0 DRIVE_02_02 : N
LIBLG_01_NV O DRIVE_02_03 3
LIBLG_01_SV [J DRIVE_02_04 ©

Figure 3-41. Select Attached System

7. In the error code identification strings text box type the error codes you want ALC to check for. You can
type all (which will include all error codes for log gathering), none (which will not gather logs for any
error code), or a list of comma-separated 4 digit hexadecimal numbers (an X may be used as a
wildcard and will match any number in its position).

If you want to turn on NVRAM log gathering, early termination, or debugging, simply check the check
box next to the options you want.

Then input how many days you want ALC to run. Don't try to run ALC forever, and run only under the
guidance and direction of a PFE.

8. Then click Start ALC.
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» 133000 System Console | Close this window |

System Console PE Package Subsvstem Log Retrieval

Successfully started ALC
— Select Logs — Action

First: Select machine tvpe of the svstem vou Retrieve Logs

would like to retrieve logs from: Once logs are retrieved, they will exist in

3584132 (i) var/enc/offload directory.
Next: Select the individual machine. To Already retrieved logs? Click here to
match hostname and IP addresses to a offload the logs to call home or media.

specific machine, refer to the Attached
Svstems page. If vou do not see vour —ALC
system in the list. make sure it is attached
and can be queried successfully.

al4or483

Figure 3-42. Successfully Started ALC

ALC has been successfully started on your selected 3584 library.
Every heartbeat error found by ALC will be called home.

Stop ALC from the Web Interface
1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39|

2. Select System Console Actions —> Console Configuration Utility. You see the login prompt shown
in [Figure 2-53 on page 2-40|

3. Type service in the Username field, service in the Password field, then single click OK.
4. Select PE Packages > Subsystem Log Retrieval link. You will see the image below.

= 153000 System Console ..
Svstem Console PE Package Subsvstem Log Retrieval
— Select Logs - Action
First: Select machine tvpe of the system vou Dlease select a system to the left.
would lilke to retrieve logs from:
- Select a Machine Type - lv Already retrieved logs? Click here to offload 3
the logs to call home or media. S
s

Figure 3-43. Subsystem Log Retrieval

5. In the “Select Logs” section, use the drop down to select a 3584.
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» 123000 System Console

Svstem Console PE Package

Close this window |

Subsvstem Log Retrieval

— Select Logs
First: Select machine type of the system you
would like to retrieve logs from:

3564132 [v]

Nezxt: Select the individual machine. To match
hostname and IP addresses to a
specific machine, refer to the Attached
Svstems page. If vou do not see your
system in the list, make sure it is attached and
can be queried successfully.

- Select an Attached System - |V

Action

Please select a system to the left.

Already retrieved logs? Click here to offload
the logs to call home or media.

Figure 3-44. Select Logs

6. From the new drop down that appeared, select an attached system.

al4or481

- 193000 System Console

Swstem Console PE Package

— Select Logs
First: Select machine type of the system vou
would likce to retrieve logs from:

3584132 ]

Next: Select the individual machine. To
match hostname and IP addresses to a
specific machine, refer to the Attached
Svstems page._ If vou do not see vour
system in the list. make sure it is attached
and can be queried successfilly.

T

Figure 3-45. Select Attached System

7. Click Stop ALC.

Subsvstem Log Retrieval

— Action

Once logs are retrieved, they will exist in
var/enc/offload directory.

Already retrieved logs? Click here to
offload the logs to call home or media.

—ALC
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TS3000 System Console | Close this window |

Svstem Console PE Package Subsvstem Log Retrieval

Successfully stopped ALC
— Select Logs — Action

First: Select machine type of the system vou would Retrieve Logs

likee to retrieve logs from: 5 Once logs are retrieved, they will exist in
3584L32 liss] var/enc/offload directory.

Next: Select the individual machine. To match Already retrieved logs? Click here to offload the
hostname and IP addresses to a

specific machine, refer to the Attached Svstems
page. If vou do not see vour —ALC
system in the list, make sure it is attached and can be
queried successfully.

RAS3584 Serial Number: 13AAA15 [v]

logs to call home or media.

Error code identification strings:

(all, none, 2FXX (separate multiple entries with a
comma))

Turn on NVRAM log gathering? [

Libﬂ}ﬁ_gé: Drive Logs: Turn on early termination? [

LIBLG_01_OP [J DRIVE_01_01 Tota oo dcdrugiie? B

TG 01,10 PITRIVE 61, 10 How long do vou want ALC to run (in days):

LIBLG 01_ER [0 DRIVE_02_01 = . R
LIBLG_01_AC [J DRIVE_02_02 ! 5
LIBLG_01_NV O DRIVE_02_03 )
LIBLG_01_8V [0 DRIVE_02_04 B

Figure 3-46. Successfully Stopped ALC
ALC has been stopped on the selected 3584 library.

Start ALC from the Command Line
1. Log into the TSSC. See [Figure 2-52 on page 2-39}

2. Click anywhere on the desktop, select Browser Functions -» Launch ALC Manager. You see the
figure shown below.

IBM TS3000 System Console
ALC Manager

Available options:
1. Start an ALC process

Which option would you like to perform (or 'g' to guic)? !

al4or488

Figure 3-47. Start an ALC Process
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Note: If there are 3584s to start ALC against, the option “Start an ALC process” will appear.

3. To start ALC press the corresponding number next to “Start an ALC process” then press Enter.

IBM TS3000 System Console

AL.C Manager

Available options:
1. Start an ALC process

Which option would you like to perform (or '"g' to guit)? 1
3584= with actiwve ALC processes

¥ Make /Model Serial Number IF Address
e sseansz 1saaa1s  172.31.1.170
Which system would you like to start ALC on ({or 'g' to quit)? l

Hostname

al14or489

Figure 3-48. Start an ALC Process

A list of attached 3584 libraries appear. Libraries that already have ALC running will not show up here.
4. Find the 3584 you want to start ALC against from the list. Press the corresponding number, then

press Enter.

IBM T33000 System Console

ALC Manager

Available options:
1. Start an ALC process

th a comma)): .

Which option would vou like to perform (or 'g' to quit)? 1
35843 with active ALC processes

3 Make/Model Serial Number IFPF Address
[ sssars2 1sama1s  172.51.1.170
Which system would you like to start ALC on (or 'q' to qguit)? 1

code identification strings (all, none, 2FXX (separate multiple entries wi

Hostname

a140r490

Figure 3-49. Start an ALC Process

The script will now ask for the error code identification strings to define which error codes to check for.

Type all (which will include all error codes for log gathering), none (which will not gather logs for any

error code), or a list of comma separated 4 digit hexadecimal numbers (an X may be used as a

wildcard and will match any number in its position), then press Enter.
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IBM T53000 Syatem Con=ole
ALC Manager

Available options:
1. Start an ALC process
Which option would you like to perform (or 'g' to quit)? 1

35848 with active ALC processes

£ Make/Model Serial Number IFP Address Hostname

1: 3584L32 13AAR1S 172.31.1.177¢ RAS3584

Which system would you like to start ALC on (or 'g' to quit)? 1

Error code identification strings (all, none, 2FX¥ (separate multiple entries wi
th a comma)): all

Turn on HVBRAM log gathering? .

al4or491

Figure 3-50. Start an ALC Process

You will now be asked if you want to turn on NVRAM log gathering.
6. Type Yes or No, then press Enter.

IBM T53000 System Console
ALC Manager

Available options:
1. Start an ALC process

Which option would you like to perform (or 'g' to quit)? 1

35848 with active ALC processes

% HMake/Model Serial Number Hostname
L 3584L32 13RARIS RAS53584
Which =system would you 1ike to =start ALC on (or 'g" to guit)? 1

or code identification strings (all, none, 2FXX (separate maltiple entries wi
th a comma)): all

urn on NVRAM log gathering? No

Turn on early termination? .

al4or492

Figure 3-51. Start an ALC Process

You now will be asked to turn on early termination.
7. Type Yes or No, then press Enter.
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IBM T53000 Swystem Console [2
ALC Manager

Available gptions:
1. Start an ALC process

Which option would you like to perform (or 'g' to quit)? 1

3584= with actiwve ALC processes

H Make,/Model Serial Number IP Address Hostname
1: 3584L32 13RRRIS 172.31. 170 RRA33584 =

Which system would vou like to start ALC on (or 'g' to quit)? 1

Error code identification strings (all, none, 2FXX (separate multiple entries wi
th a comma)): all

Turn on NVEAM log gathering? No

Turn on early termination? No

a140r493

Turn on debugging? .

<]

Figure 3-52. Start an ALC Process

Next, you will be asked to turn on debugging.
8. Type Yes or No, then press Enter.

Available options:
1. Start an ALC process

Which option would vou like to perform (or "g' to guit)? 1

35848 with active ALC processes

¥ Make/MHModel Serial Number IF Lddre=s= Hostname
g o5 3584L32 172031000170 RAES53584
Which system would you like to start ALC on (or 'g' to guit)? 1

Error code identification strings (all, none, 2FXX (separate multiple entries wi
th a comma)): all

Turn on NVRAM log gathering? No
Turn on early termination? HNo

Turn on debugging? No

T~

How long do you want ALC to run (in days) or press enter for default (7 days)? I L

al4o0r495

Figure 3-53. Start an ALC Process

Finally, you will be asked how long you want ALC to run.

9. Type a number greater than zero. Don't try to run ALC forever, and run only under the guidance and
direction of a PFE.
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Available options: k:
1. Start an ALC process

Which option would wvou like to perform (or 'g' to guit)? 1

3584= with actiwve ALC processes

E Make/Model Serial Number IP Address Hostname
1 3584132 13ARR15 1T72:81.010100 RAS3584

Which system would wvou like to start ALC on (or 'g' to guitc)? 1

Error code identification strings (all, none, 2FXX (separate multiple entries wWi|:=S
th a comma)): all

Turn on NVEAM log gathering? No
Turn on early termination? No
Turn on debugging? No

AT.C started successfully.
raselmc:~ # .

<]
al4ord94

Figure 3-54. Start an ALC Process

ALC will now start.
Every heartbeat error found by ALC will be called home.

Stop ALC from the Command Line
1. Log into the TSSC. See [Figure 2-52 on page 2-39|

2. Click anywhere on the desktop, select Browser Functions -» Launch ALC Manager. You see the
figure shown below.

IBM T53000 Syatem Conszole
ALC Manager

Available options:

1. Stop an actiwve ALC process

Which option would you like to perform (or 'g' to quit)? .

a140r496

Figure 3-55. Stop an ALC Process

Note: If there are ALC processes running, you will be given the option to stop them.

3. To continue, press the corresponding number next to "Stop an active ALC process", then press
Enter.
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IBM T53000 System Console
ALC Manager

Available options:

1. Stop an active ALC process
Which option would vou like to perform (or "g' ©to guit)? 1
Lttached 3584s
# Make/Model Serial Number IP Address Hostname

Which system would you like to stop ALC on (or 'g' to quit)? l

al4or497

Figure 3-56. Stop an ALC Process

A list of 3584s with ALC running against them appear.
4. To stop ALC on one of the 3584s press the corresponding number of the desired library and Enter.

000 System Conszole
Available options:
1. Stop an active ALC process
Which option would you like to perform [(or 'g' to quit)? 1
Attached 3584s
£ Make/Hodel Serial Number IP Address Hostname
Which system would vou like to stop ALC on (or 'g' to quit)? 1
The process was killed.

LLC =stopped.
raselmc:~ ¥ .

al4or498

Figure 3-57. Stop an ALC Process

ALC has now stopped collecting logs against that 3584 library.
Configuring Assist On-Site (AOS)

AOS is a tool that allows remote desktop connections over the External broadband ethernet adapter to the
TSSC. It utilizes the same network as broadband call home and will work on either HTTP or HTTPS. The
AOS daemon will allow outbound connections only. It will establish connections by periodically connecting
to the AOS servers to determine if remote access is needed. If so, the daemon will establish the
connection and the remote user will have desktop access to the TSSC. For information on AOS, check its
internal website: https://aos.us.ihost.com/AssistOnSiteAdmin/docs/AOS_User_Guide.pdf
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Note: A DNS is required for AOS to find the AOS servers. To establish connection to a DNS, see section
[‘Console Settings” on page 2-60) Outbound traffic needs to be enabled to the following ports:

If HTTPS traffic only is required, remove the 72.15.208.234 IP from the firewall rules.
Table 3-5. Assist On-Site Table

Hostname IP Ports

aos.us.ihost.com 72.15.208.234 80, 443
aosback.us.ihost.com 72.15.223.61 80, 443
aosrelay1.us.ihost.com 72.15.223.60 80, 443
aos.uk.ihost.com 195.171.173.165 80, 443

IBKM T33000 System Console 5.7.6

| System Console Actions - System Console Actions
;..Bm\l.fser Eunclions __| Console Configuration Wility
| TS3000 System Console Maintenance Information | Telnet to Tape System
| Terminal | Telnet to Grid TSSC

| Serial Port Tape Drive Service Infonmation
Hotepad Error/Defer Matrix Update

| PDF Viewer Offload User Files to Call Home
| Shutdown Console... | cD Copy to Console

Restart Console... Disk Rebuild and Restore Config

| Logout... Update Console Version
: Install Additional Packages

Apply Patch
Import InfoCenter ;
A0S Functions ~[a0s Manager Functions
| Start AOS :
Stop AOS
Enable Lights Out
Disable Lights Out
Query AQS Status

al4or499

Figure 3-58. AOS Manager Functions

To Enable AOS Lights Out:
Right click the desktop -» System Console Actions > AOS Functions > Enable Lights Out.

This will enable AOS to allow for remote access without the need to confirm the remote takeover of the
TSSC.

To Disable AOS Lights Out:
Right click the desktop -» System Console Actions > AOS Functions > Disable Lights Out.
This will set AOS to require local confirmation of the remote takeover TSSC.

To Start AOS:
Right click the desktop -» System Console Actions -» AOS Functions > Start AOS.

This will launch the AOS daemon and will enable AOS to run and establish connections based on the
AQOS settings on the TSSC.

To Stop AOS:
Right click the desktop > System Console Actions -» AOS Functions -» Stop AOS.
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This will stop the AOS daemon from making any new connections. Any sessions currently in progress
will not be stopped. The remote user or a local user will be required to stop any established
connections if there are any.

To Query AOS:
Right click the desktop -» System Console Actions -» AOS Functions -» Query AOS Status.

The function will show you the current AOS settings on the TSSC. The query command checks the
following settings:

- |f Lights out is enabled or disabled
- If AOS is running or not

- The customer name that will be presented by the AOS client for establishing a connection to this
TSSC. AOS currently reports the hostname of the TSSC.

Note: If your TSSC is set to the default tssnetl, it will be very difficult to find your TSSC in the AOS client.
We strongly suggest updating the hostname to a unique hostname.

-» The AOS customer number. All TSSC's customer number is 1010000, and this field is not
configurable.

- Tests connectivity to the AOS site, and if it is not successful, the script displays the reason for not
being able to connect to the URL.

Note: A DNS server is required for AOS to find the appropriate IP for establishing the connection with the
AOS server. To set a DNS server, see section: [‘Console Settings” on page 2-60.

= Query ADS Status F E =

Lights out enabled

A0S iz running

AS customer name iz set tod  IBM_RWSS_RAS_LAB_BO7_Do_Mot_Disp

A0S cuztomer number iz set tor 1010000

A0S server url iz set to: httpshislaos,usz,ihozt, comAzzistOnSitescal IlHome
thiz T55C has connectivity to the ADS servers

Press <enterr to guit:

a14or500

Figure 3-59. AOS Manager Functions
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To Configure a Proxy Server:

1. Right click the desktop -» System Console Actions -» AOS Functions -» Configure Proxy Server.
This function will allow you to configure a proxy server for use with AOS Lights Out.
You will be prompted for three pieces of information. This information is all provided by the customer.

— the proxy server hostname (or IP address)
— the proxy server port
— the (optional) authentication credentials.

Configure Proxy Server
Enter the proxy server URL {or leawe blank to dizablel: proxy,company.,con

Enter the port for the proxy server (or press Enter to leawe blank): 8080
Does this proxy require authentication? {usfnj: y

LUZErRame: proxyuser

pazzword: proxypass

Press <enter> to quit: []

al4or551

Figure 3-60. Manage Port Forwarding Interface

To Configure Port Forwarding:
1. Right click the desktop -» System Console Actions -» AOS Functions -» Manage Port Forwarding.
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Manage Port Forwarding

Manage Fort Forwarding

Mo Port Forwarding Targets Configured
[aldd, [Rlemove, [Clancel: []

Figure 3-61. Proxy Example

al4or549

You will see an interface like the image above. There are three possible actions to take:
1. To add a port forwarding target, press a and hit enter.

You will be prompted for a port forwarding hostname. This is the target to receive the forwarded traffic.
For example, if you want to forward traffic back to the TSSC itself, enter localhost, or if you want to
forward traffic to a machine at 172.31.1.10, enter that address.

Next, you will be prompted for the port to be forwarded. This port will depend on the traffic you wish to
forward. Some common choices can be found in the table below:

Port Service

22 SSH

23 Telnet

7080 TSSC Web GUI

Press Enter to save your new entry.

2. To remove a port forwarding target, press r and hit enter.
You will be asked to enter a number corresponding to the entry you wish to delete.
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Manage Port Forwarding
Mianage Port Forwarding

1) localhost, 22
[aldd, [Rlemove, [Clancel: [

al4or550

Figure 3-62. Port Forwarding Target List

For example, to delete the entry corresponding to localhost, 22 (in the picture above) choose 1.
Enter the entry to delete and press Enter.

3. To simply cancel without making any changes, press ¢ and hit Enter.

Offloading User Files to Call Home Database (For Remote Users)

In addition to offloading files to various media types, you can offload larger files, files for later use, and
files requested by your next level of support to be sent to the RMSS Call Home Database:
https://callhomedata.tucson.ibm.com. The files must reside in the user's offload directory. For example,
for the user "service" the directory would be /home/service/offload. Subdirectories will not be included.

Note: Files that you offload to the Call Home Database use the same call home path as normal call
homes. Call Home Setup must be complete in order to use this function. See r‘Configuring Cal|
|Home Settings Electronic Customer Care” on page 2-71|for more information on Call Home Setup.

1. From the main menu, select System Console Actions > Offload User Files to Call Home. If you are
using a dial-in session, issue the command offloadpkg. File offload begins. The window depicted in
[Figure 3-63 on page 3-47|appears.
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Offload Files to Call Home

Checking files . . .

Creating PE package . . .

Converting PE package to callhome . . .

Your files have been offloaded via Call Home. Write down or save the
following data ID to retrieve the files:
p78-B2018p02004102615040022999

The files can be accessed globally at https://callhomedata.tucson.iom.com/
(Authorized IBM Infranet users only)

Press Enter to finish

al4or253

Figure 3-63. Offload Files to Call Home

Notes:

» If the user's files exceed 10MB, a warning displays that includes a prompt to abort. Before
you offload files larger than 10MB, consider that this may delay other call home activity on
this System Console. Additionally, if subdirectories are found in the user's offload directory, a
warning displays reminding the user that subdirectories are not included. The user may
choose to abort at this warning and move the files if the files within subdirectories are
desired to be included.

* An attempt to offload user files will fail if there are no files to be found in the user's offload
directory.

2. See A data ID is assigned to the user's files. This data ID must be entered to retrieve the
files on the RMSS Call Home Database. Make note of this ID for future reference. If the ID is lost, the
user's files can still be found by locating call homes from the System Console's Primary System on the
Call Home Database. The Primary System is set in Call Home Setup (see |“Configuring Call Home|
|Settings Electronic Customer Care” on page 2-71b. To assist in recording the ID, note that the ID
always takes the form described in the following example.

Vs
Example Data ID: p78-B2018p02004102615040022999
p78-B2018p02004102615040022999
p - The first character in the data ID is always a p
p78-B2018p02004102615040022999
78-B2018 - The serial number of the Primary System, with a dash (-) in the 3rd position
p78-B2018p02004102615040022999
p0 - A p followed by position in frame (always O except for when a VTC is the primary system)
p78-B2018p02004102615040022999
20041026 - The date in the form YYYYMMDD
p78-B2018p02004102615040022999
150400 - The time (24-hr) in the form HHMMSS
p78-B2018p02004102615040022999
22999 - These digits, usually the process ID of the Offload Files program, uniquely identify this call home

Figure 3-64. Data ID Sample

You can use the above information to confirm that you have correctly noted (for later use) a data ID.
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The user's files are sent using a special call home package. Because this package must propagate
through the normal call home path it can take a few minutes to arrive at the Call Home Database.
Once it arrives, you can locate it by using the data ID given.

Once loaded on the Call Home Database, the user's files will appear as a reqular call home, arriving
from the System Console's Primary System, as set in Call Home Setup (see[‘Configuring Call Home|
[Settings Electronic Customer Care” on page 2-71).

To locate the offloaded data that is on the Call Home Database, use a web browser on the IBM
intranet to go to the address: https://callhomedata.tucson.ibm.com/

From the left-side of the menu, choose Single System.
At the Call Home ID prompt, enter the data ID that appeared while files were unloading.
Click Look Up Call Home Data ID.

After the call home has been loaded, scroll down to the Files section to find the file you offloaded from
the System Console. You can use a web browser to download these files by clicking on the filename.

Console PE Package

Note: For 3956 CC6 (DS6000) PE Package creation, refer to the TS7700 Information Center search

string "problem determination DS6000."

You can use the System Console to create a PE (Product Engineering) package, then send that package
to IBM RETAIN by using the call home path. You derive this PE Package from console events log files and
trace files which reside on the System Console. Use the console creation tool to tailor the PE Package to
specific requirements, and to investigate and diagnose System Console problems.

1.
2.

3.

4.

Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39).

From the Main Menu, select System Console Actions --> Console Configuration Utility. You see
[Figure 2-53 on page 2-40|

Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen shown in
[Figure 2-54 on page 2-40|

Click the PE Packages icon. You see [Figure 3-65 on page 3-49|

3-48 1BM TS3000 System Console Maintenance Information — 29th Edition November 2012



. TS3000 System Console

Svstem Console PE Package Subsvstem Log Retrieval

— Create Console PE Package

—File Selection

— Owerall PE Package Limits
@ All Files

O Package Limit By Number Of © By Categories
T (160 ~] System Console Communication
Elapsed Days | | User interface
KBytes [100 ~] Console Heartbeat Files

& No Package Size Limit System Console System Files

Offload user files via call home

#a140r269

Figure 3-65. Create Console PE Package Menu

5. Choose one of the selections in the Overall PE Package Limits box.
* Lines - Number of lines
* Elapsed Days - Number of days
* KBytes - Size of package

— —O0OR - -
* No Package Size Limit - Accepts any size
6. Choose one of the selections in the File Selection box.
e All files - Include all the files

- —OR - -
» By Category - Choose those which apply to your installation

Retrieving Subsystem Logs
Complete this task to retrieve subsystem logs.
1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 3-67 on page 3-50[).

2. From the Main Menu, select System Console Actions --> Console Configuration Utility. You see
[Figure 3-66 on page 3-50}

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen shown in
|Figure 3-67 on page 3-50}

4. Click the PE Packages icon. You see [Figure 3-66 on page 3-50.
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TS3000 System Console

Svstem Console PE Package Subsvstem Log Retrieval

— Create Console PE Package

—File Selection
r— Owerall PE Package Limits————

® All Files
O Package Limit By Number Of © By Categories
Lines | e System Console Communication
Elapsed Days | - | User interface
KBytes [100 ] Console Heartbeat Files
® No Package Size Limit Swstem Console System Files

Offload user files via call home

#a140r269

Figure 3-66. Create Console PE Package Menu

5. Click the Subsystem Log Retrieval tab at the top of the page. You see [Figure 3-67} Follow the

instructions in the Select Logs box to select an attached system from which you would like to retrieve
logs.

TS3000 System Console Close this window
System Console PE Package Subsvstem Log Retrieval
Select Logs Action
First: Select machine type of the system you would like to retrieve logs from: Please select a system to the left.

Already retrieved logs? Click here to offload the logs to call home or media.

| 3494122
3584132
3592C06
3592070
3953L05
3957V06
3957VEA

aldord64

Figure 3-67. Subsystem Log Retrieval Menu

Notes:
* The list you see will contain only those subsystems which are eligible for log retrieval
through the System Console.
* Some early levels of subsystem code do not support Subsystem Log Retrieval.
» If you do not see your system listed, verify that it is attached and can be queried
successfully from the attached systems page.
After you have selected your desired subsystem, you see one of the following options:
* 3957 - A getlogs options menu displays. All selections are optional. You may specify a start time,
including month, day, and hour for which to gather logs. All logs will be gathered from this time

forward. You also may specify one or more components to gather logs from as well as a specific file
you would like to gather.
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» 153000 System Console

System Console PE Package Subsystem Log Refrieval
— Select Logs Action
First Select machine type of the system you would like to retrieve
logs from: Once logs are retrieved, they will exist in /var/enc/offload
3957V06 A directory.
Next: Select the individual machine. To match hostname and [P Already retrieved logs? Click here to offload the logs to
addresses to a call home or media.
specific machine, refer to the Attached Systems page. If vou do not
see your
system in the list, make sure it is attached and can be queried
successfully.

rasmatazz Serial Number: 78083EG |+

Start Time: | Optional Month |

Day:

Hour [1-24]:
4
Component: égg%mponems [:l
cMa v

Specify a File:

al4or358

Figure 3-68. Retrieve Log - 3957 Menu

» 3592 - A minimal getlogs menu displays. All selections are optional. You may specify a start time,
including month, day, and hour for which to gather logs. All logs will be gathered from this time
forward. You also may specify a specific file you would like to gather.

TS3000 System Console Close this window |
System Console PE Package Subsystem Log Retrieval
—Select Logs — Action
First: Select machine type of the system you would like to retrieve Retrieve Logs
logs from Once logs are retrieved. they will exist in /var/enc/offload
3592C06 b directory.
Next: Select the individual machine. To match hostname and IP Already retrieved logs? Click here to offload the logs to call
addressesto a home or media.
specific machine, refer to the Attached Systems page. If you do not
see your
system in the list, make sure it is attached and can be queried
successfully.

rasc06 Serial Number: 78C5009 | v

Start Time: | Optional Maonth |+
Day:
Hour [1-24]:
Specify a File:

al4or359

Figure 3-69. Retrieve Log - 3592 Menu
« Library Manager - A savelogs options menu displays. All selections are REQUIRED. You must

specify a start time and an end time, including year, month, day, and hour. You must specify at least
one log type. You can specify multiple log types.
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, TS3000 System Console

System Console PE Package Subsystem Log Retrieval
— Select Logs Action
Furst: Select machine type of the system you would likee to retrieve logs Retrieve Logs
from: Once logs are retrieved, they will exist in /var/enc/offload directory.
3494122 ~

Already retrieved logs? Click here to offload the logs to call home
Next: Select the individual machine. To match hostname and IP addresses or media.
toa

specific machine, refer to the Attached Systems page. If you do not see

your

system in the list. make sure it is attached and can be queried successfully.
RASLMS Serial Number: 1314501 |+

Start Time (All fields are required
Year:
Month:  Month v
Day:
Hour [1-24]
End Time (All fields are required)

Year
Month: Month v

Day:

Hour [1-24]:

All Types C|
DB2

DMP v

Log Type:

a14or360

Figure 3-70. Retrieve Log - Library Manager

» 3584 - After you select an individual 3584, the TSSC will query the library for the list of logs that are
available for download. When the log query is successful, the available logs display for you to
select. Select the logs you would like to retrieve.

Note: The System Console uses HTTP sessions to gather the 3584 logs. If gathering the log takes

excessive time between queries, the session will expire. Refresh the page to open a new
session.
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TS3000 System Console

Close this window

System Console PE Package Subsystem Log Retrieval

—Select Logs

— Action
First: Select machine type of the system you would like to retrieve logs Retrieve Logs
from: Once logs are retrieved. they will exist in /var/enc/offload directory.
3584132 v

Already retrieved logs? Click here to offload the logs to call home

Next: Select the individual machine. To match hostname and IP or media.

addresses to a

specific machine, refer to the Attached Systems page. If you do not see
your
system in the list, make sure it is attached and can be queried
successfully.

RAS3584 Serial Number: 13AAATS | v

Library Logs: Drive Logs:

LIBLG 01 OP 1 DRIVE_01_01

LIBLG 01 _NO [] DRIVE_01_02

LIBLG 01_ER [ DRIVE_02_01 §
LIBLG 01 AC 1 DRIVE_02_02 S
LIBLG_01_NV [ DRIVE_02_03 %

Figure 3-71. Retrieve Log - 3584

* 3958 - You will be prompted for a start time and day, the components you want to retrieve, and the
package size. You must select either a component or you must specify a filename.

Note: The "Big" option is not available in TSSC v 5.8 and higher with ProtecTIER RAS levels 7121
and higher.

TS3000 System Console

Close this window

Svstem Console PE Package Subsvstem Log Retrieval

—Select Logs

—Action
First: Select machine type of the system vou would like to retrieve logs
Irom i Once logs are retrieved, they will exist in ~var/enc/offload directory.
| 3858DD1 |

Already retrieved logs? Click here to offload the logs to call home
or media.

Next: Select the individual machine. To match hostname and IP addresses
toa

specific machine, refer to the Attached Systems page. If you do not see
vour

system in the list, make sure it is attached and can be queried successfully.
| T$50_172.31.1.120 Serial Numbar 78C5011 1+

Start Time
Yeae
Month: 5_!.\-Iom-h ] v
P -
Hour [1-24]:[
Component Eég(;%;nopﬁnenls < I
(RIsK |

Specify a File: | ]
Package Size: O Small ® Big

a140r383

Figure 3-72. Retrieve Log - 3958

6. After you have selected a means of retrieving a log, click Retrieve Logs in the Action box. The
TS3000 System Console (TSSC) gathers your logs. You see a message when your request is fulfilled.
The logs are gathered and are placed in the /var/enc/offload directory.

7. Click on Click here to offload the logs you gathered.

Chapter 3. Procedures  3-53



Console Status

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Actions -—> Console Configuration Utility. You see
[Figure 2-53 on page 2-40}

3. To login from the System Console, enter service in the Username field, enter service in the Password
field, and select OK to start the Console Configuration utility. You see|Figure 2-54 on page 2-40|

- -OR - -

To login remotely (from another System Console), you must obtain an authentication ID (see
|Options” on page 2-37| for information on obtaining an ID). Launch your browser.

a. Enter the System Console location into the Address field.

b. Type your Authentication ID into the Username field, and your password into the Password field.
Click OK to start the Console Configuration utility. You see [Figure 2-54 on page 2-40

4. Click Console Status. You see [Figure 3-73

TS3000 System Conscle

Console Message File Test RETAIN Connection Console VPD Test ECC Connectivity

Console Message File

Click on the Display Message File button to display the contents of the communication message file. This file contains data entries from the communication processes
when the System Console communicates with the attached system(s) or RET AIN,

The display will refresh continuously while the window is open.

Display Message File

al4or472

Figure 3-73. Console Message File Screen

5. Use|Table 3-6 to determine the path which you wish to follow.

Table 3-6. Console Status Tool Function

Function Description
Console Message File » Displays the contents of the communication message
file

» Provides a "Find..." tool for searching the file for a
specific word or phrase

See[‘Console Message File.”|

Test RETAIN Connection Tests the telecommunication path between the System
Console and RETAIN (see [‘Test RETAIN Connection - As|
|a Service Procedure” on page 3-55)

Console VPD Displays Vital Product Data (VPD) information for the
System Console (see [‘Console VPD” on page 3-56)

Test ECC Connectivity Test communication path between the System Console
and Electronic Customer Care. This can also be used to
show ECC configuration info. (See fTest Electronid
|Customer Care (ECC) Connectivity” on page 2-88).

Console Message File
1. From the Console Message File screen shown in [Figure 3-73| select Console Message File.

2. Click Display Message File to view the message file. You see|Figure 3-74 on page 3-55.
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Figure 3-74. Message File Screen

Test RETAIN Connection - As a Service Procedure

1. From the Console Message File screen shown in [Figure 3-73 on page 3-54] select Test RETAIN
Connection. You see [Figure 3-75

TS3000 System Console

Console Message File Test RETAIN Connection Console VPD Test ECC Connectivity

—Test RETAIN Connection

Use this page to test the Call Home (RET AIN) connection. This tests the configuration done as part of the Call Home Seftings task, specifically it uses the phone
numbers or network configured, and the RET AIN registered primary system to do the test,

To test the connection do the following:

1. Review the callhome seftings for correctmess,
2. Click on the Test Prohlem Notification button or the Test Data Upload button to begin the desired test.

Use the Refresh button to update this page if you change settings in the Call Home task,

™ Phone number 1: W
[T Phone number2: IW Test Problem Notification
[T Phone number 3: IW Test Data Upload

[T Phone number 4: W m‘

¥ 1BM intranet

al4or478

Figure 3-75. Test RETAIN Connection Request Screen - As a Service Procedure

2. Select the test you want to run from the list on this menu. You see [Figure 3-76 on page 3-56,
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Exacution output Bllows:

=7 Startmg to test AGNS ¢ RETAIN connection
=> Starting to create problem record, type: 4
Looking up properties for type 4
Rea\:hng Type DI / 4
d: " *4*DT*Test notification
Checkmg primary subsystem
Creating problem record heada
Adding informational message: ESS Master Consale Problem Motification test
Cauld not apen  for appending its contents to problem recard (Mo such file ar di rectnr¥)
<= Return Code: 0 — Problem record /var.«‘enc/data/aaﬁ3ms13DDDD4ED DItestm successfu'l Yy (reated (3853—LDS 13000047
000 Ign_Dial 06/03/06 000 *** Program stal
000 Ian_Dialer EIEIEIEIEI Updatmg gateway mformatwn
000 Ign_Dialer Qo000 Preﬁ;armg for dialing the IBM netwurk
000 Ign_Dialer 00000 Dialing IBM network: 9,837-1
00000 Connected to the IBM netwurk trymg to reach remote host|
Qoooo ﬁdatmg routing tables

o
Sa

000 Ign_Dialer
000 Ian_Dialer

000 Ign_Dialer :45:00;: 0556 00000 Checking remote host

000 Ign_Dialer 45:04:0?48 00000 Connection to IBM entirely established, ready for communi
Dialing IBM network: fusr/binfenc/rsTCPIGHLink —1 *B0° —t “BO0” —m 107 —h “115200° -1 —v “fdew/ttyS0” *9,837—1005" "URUS” “DASDUS™ “d
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001 Send_Prh_To_Retain :45:04: 0802 *T* 00000 00000 Converting primfsec TP and P
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001 Send_Prmi Tn_Retam :45:04:0802 *I* 00000 00000 Prncessma product: 1300004-3953—

001 Send_Pmi To_Retam :45:04:0202 *I* 00000 00000 Start sendin data to prim IP

001 Send_Pmh_To_Retain 145:04:0802 *I* 00000 00000 Creating socket

001 Send_Pmh_To_Retain 145:04: *I* 00000 00000 Cunnectmg socket

001 Send_Pmh_To_Retajn 145 #*I* 00000 00000 Sending user data

001 Send_Pmh_To_Retain 145 #T* 00000 00000 Receiving response

001 Send_Pmh_To_Retain a4 *T* 00000 00000 Analyzing response o
001 Send_Pmh_To_Retain *T* 00000 00000 Using 1u?un record fur IEM product =
001 Send Pmh_To_Retain *T* 00000 00000 Sending Togon record ©
001 Send_Pmh_To_Retain 8 #T* 00000 00000 Receiwing first response o
001 Send_Pmh_To_Retain Gr45: #T* 00000 00000 Analyzing first response <
001 Send_Pmh_To_Retain 200B/03/06-16:45: *I* 00000 00000 Receiving second response o

Figure 3-76. Test RETAIN Connection Results Screen - As a Service Procedure
3. Select Close This Window after you have performed your choice of tests.

Console VPD
From the Console Message File screen shown in|[Figure 3-73 on page 3-54|, select Console VPD. You see
Figure 3-77| The VPD information is listed for you in the System Console Product Information box.

T3S3000 System Console

Conscle Message File Test RETAIN Connection Console VPD Test ECC Connectivity

— System Console Product Information
BIOS Level PAET45AU
Machine Serial Mumber [KGHEXE
System Board Serial Number [
Wachine Type - Model [485-120
HosmmaW
IP &ddress [1723115
Default Gateway l—
DNS l—

Installed RAM (MBytes) [2026
Hard Drive Size (MBytes) [74234
Hard Drive Usage (MBytes) 11569

LIC Levels [3.74-022510

al4ord73

Figure 3-77. Console VPD Screen

RAS Menus

The RAS Menu system is a comprehensive tool used to enhance remote support capabilities from the
command line. It is an interactive, menu-driven tool that provides the same service functionality as the web
interface.
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TSSC Menus

E Temminal E

Attached Systemsz ..,

Log Collection Tools ...
Call Home Functions ...
Metwork Settings ...
External GUI Optionsz ...
A0S Settings ...

Mount Optionz ...

2034 Optionz ...

SHMP Options ...
Shutdown Options ...,
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+

=
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E. Exit
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hoice: []

Figure 3-78. The top-level menu as displayed in a terminal window

Local access
To access the RAS menu system locally:

Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39}

1.
2.
3.

al4or514

From the main menu, select the Terminal entry.

Enter the command rsRasMenu to open the RAS menus. The interactive menu system will display in

the terminal as seen in[‘BAS Menus” on page 3-56.|

The main menu is broken down into categories. Make a selection by entering the number next to any
top-level menu entry. You will be taken to submenus that correspond to your selection.

You may exit the menus at any time by pressing E. To navigate back to the previous menu, enter B

when prompted.

Remote access
To access the RAS menu system remotely:

1.
2.
3.

Connect to the target TSSC via an SSH session or modem.
Authenticate as a Service or Enhanced RMSS user and log in to the TSSC.

Once logged in at the command line, enter the rsRasMenu command. The interactive menu system will

be displayed as seen in[‘RAS Menus” on page 3-56.|

The main menu is broken down into categories. Make a selection by entering the number next to any
top-level menu entry. You will be taken to submenus that correspond to your selection.

You may exit the menus at any time by pressing E. To navigate back to the previous menu, enter B

when prompted.

Taking Console Screenshots

1.

To take a screen shot of the System Console, press the Print Screen button on the console keyboard.

- It is sometimes useful to delay the screen shot command. If you would like to initiate a delayed
screen shot press Shift + PrintScreen on the console keyboard. This will capture the screen five

seconds later.
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2. Screen shots will be placed in the offload directory of the currently logged in user. For example, if the
service user is logged in, this would be /home/service/offload.

3. To offload these screenshots, see[‘Offloading User Files” on page 3-30.
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Console Code Update

Use this procedure to upgrade the System Console microcode version to a newer level. This procedure
cannot be used for all code levels. If upgrades are not supported, the update console process will prompt
you for[‘Code Load/Hard Drive Rebuild” on page 3-6Q| if you are updating from 5.7.8 and higher.

Please refer to the following matrix to determine whether or not a code update will work.

Table 3-7. Code Upgrade Table

Release Levels

Upgrading to: From: Update Available?
5.0-5.2.11 <5.0 No
5.0-5.2.11 5.0-5.211 Yes
53.7-54.11 <537 No
5.3.7-54.11 5.3.7-5.4.11 Yes
5.5.12 <5.5.12 No
5.5.22 -55.28 <5.5.22 No
5.5.28 - 5.6.5 5.5.22 Yes
5.7.X <5.7X No
5.8.X <5.8.X No
5.9.X <5.9.X No
5.10.X <5.10.X No
5.11.5 <5.11.5 No
5.11.23 <5.11.5 No
5.11.23 5.11.5 Yes
5.12.x <5.12.x No
7.0.x < 7.0.x No

1. Right click from anywhere in the Desktop to view the Main Menu, shown in|Figure 2-52 on page 2-39|.

2. From the Main Menu, select System Console Actions > Update Console Version. A Terminal screen
appears and requests you to insert the TSSC Product Recovery CD.

3. Insert the CD labeled "IBM TS3000 System Console Product Recovery CD." Press Enter.

Note: You can use this procedure only to upgrade to a newer version of microcode. To reload this
level of microcode or to load an older version of microcode, use the procedure in
lLoad/Hard Drive Rebuild” on page 3-60

The tool will compare the code version on the CD with the code version on the System Console. The

tool will inform you that the versions are compatible for upgrade, and that the upgrade will begin. If the

levels are not compatible for upgrade, the tool will prompt you to perform a[‘Code Load/Hard Drivel

[Rebuild” on page 3-60.| The update process can take as long as fifteen minutes.

4. After a successful upgrade, right click on the desktop of the main menu to logout.

5. Select Logout. You are returned to the login screen seen in|Figure 1-1 on page 1-1| This screen
displays the new code level.

6. Click on the Restart button to restart the System Console. After the System Console has restarted,
you are returned to this same login screen. The microcode upgrade is complete.

Chapter 3. Procedures  3-59



Code Load/Hard Drive Rebuild

Attention:

* Many procedures in this book are specific to the level of code on the System Console. Before starting
any procedure, go to |Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

* Rebuilding the hard disk drive will permanently destroy any local data present on the drive. Using the
Product Recovery CD-ROM will return the console to its "as shipped" state.

* Do not load or attempt to use the Product Recovery CD-ROM on any machine type other than 6579,
6792, 7978, 7946, 8480, 8482, 8485, 8836, or 8849. If you use the Product Recovery CD-ROM on any
other machine type, the installation will fail and that machine will be unusable.

Notes:

» Backup the Console configuration files before you re-image the hard drive. See |“Baoking U5|
[Configuration Data” on page 2-80| and [‘Restoring Configuration Data” on page 2-83).

* Do not attempt to restore configuration settings from a V1.x.x console onto a V3.x.x or higher
console. The files are incompatible. V2.x.x files are compatible with V3.x.x or higher.

« After you use this procedure, you will need to reload some software packages if you have
TS7700s in the Attached Systems list. Some examples of affected packages might include:
— [Installing DS6000 Graphical User Interface (GUI)” on page 2-52|
— [Importing InfoCenter From CD-ROM” on page 3-76|

1. Place the System Console Product Recovery CD-ROM in the CD Drive.
2. Log out of the System Console by right-clicking the desktop area and choosing Logout. Click OK.

3. After returning to the login screen, click Restart in the lower left area of the screen, and click Ok when
prompted to restart.

4. The prompt in[Figure 3-79 appears after the System Console reboots (with the CD-ROM in place in the
CD drive).

TSSC Not Installed. Proceed. . .

This will install the Console onto /dev/sda which will erase everything on that device
Continue? ('yes' or 'no')
Abort

Figure 3-79. Pre-Installation Menu

5. Typey (or yes) and press Enter to start the hard drive re-image process.

6. You can monitor the progress of the installation from the screen. After the re-image is complete, the
System Console will reboot automatically. Remove the CD-ROM from the CD drive.

Notes:
* This procedure can take as long as 15 minutes to complete.
* You must be present at the completion of a reboot or the re-image will restart automatically.
If you are not present to remove the CD-ROM from the CD drive tray, the tray will retract
into the CD drive and the installation will start again. At the confirmation screen, type no,
and press Enter. Remove the CD-ROM from the CD drive, and allow the reboot to occur.

7. After initial reboot, the software will discover the machine type and model number of the computer,
automatically configure the appropriate drivers and settings, and automatically reboot the System
Console. During the second boot-up, the start up background and text may look slightly different. The
second boot will produce the login screen shown in|Figure 2-50 on page 2—37|. If the software
determines that the machine type is not 6579, 6792, 7978, 7946, 8480, 8482, 8485, 8836, or 8349, a
warning message will display on the screen and the System Console will halt. This will continue each
time the System Console is powered on. Similar symptoms occur after software installation if the
System Console is unable to determine its machine type and model.
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Note: If a product with a machine type of 6579, 6792, 7978, 7946, 8480, 8482, 8485, 8836, or 8849
reports a different machine type during an installation, the BIOS may have been corrupted.
Reboot the server, and make the appropriate selection during the reboot to enter BIOS setup. In
the BIOS, check the machine type that is configured. If the machine type does not match the
specific server, you should reinstall the system BIOS. Refer to the server documentation to
reinstall the BIOS and to set the correct machine type.

8. If you backed up the configuration, restore it now. See f‘Restoring Configuration Data” on page 2-83.|

Disk Rebuild and Configuration Restore

Attention:

» Many procedures in this book are code specific. Before starting any procedure, go to|Chapter 1,
|“Maintenance Starting Point,” on page 1-1| to determine the code level.

* Rebuilding the hard disk drive will permanently destroy any local data present on the drive. Using this
feature will re-install the System Console while preserving all existing settings.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Actions -» Disk Rebuild and Config Restore. You will
see [Figure 3-80,

e s e ————— e T TR Tt |
I Archived Console Reinstallation r E

Pleaze inzert TSSC Product Recowery CD and hit <Enter> or type "quit": []

=
al4or416

Figure 3-80. Prompt for TSSC Product Recovery CD.

3. Insert your TSSC Product Recovery CD and press Enter.

Note: Your configuration will be backed up and the system will restart. Leave the Product Recovery
CD in the drive to launch the installation.

4. Once the system reboots, you will be prompted to install the System Console. Type "yes" to begin
installation.

5. After several minutes the installation will complete and you will be brought back to the login screen
seen in [Figure 1-1]. After the re-image is complete, the System Console will reboot automatically.
Remove the CD-ROM from the CD drive.
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System Console Specialist

IBM service personnel and the customer (usually an administrator) can use the System Console Specialist
for the following purposes:

* Change the System Console display language

» Perform tape drive code updates

* Launch library manager and Peer-to-Peer VTS specialists
* Administer users

Online help is available from the System Console Specialist by clicking the (?) Help icon located in the
upper, right of each screen. Online help is provided using Eclipse technology. For further information,
access the website at:

http://www.eclipse.org

Customer Access to System Console via Specialist

The customer user (usually an administrator) can login to the System Console by using a userid (use
“customer”) and a password (use “customer” again). After logging in, the customer user sees the System
Console Specialist screen.

Notes:

* A customer user may add users, delete users, or change passwords for any users in the
customer group who use the Administer Users tools.

e The 'customer' userid may not be deleted.

* Anytime a customer user exits the System Console Specialist, the customer user will be logged
out of the System Console.

* A customer user cannot make changes to the user ids for service users, but service users can
make changes to customer group users.

Tape Drive Code Update via Specialist

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level. The code level
requirements are:

System Console
Code Version 2.5.0 and above

IBM 3494 Virtual Tape Server
Code Version 2.30.xx.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.7.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.4.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

1. Ensure that the tape drives that are attached to 3590 A60 and 3592 tape controllers are varied offline
at the host before attempting a microcode update.

2. Launch the System Console Specialist by selecting Main Menu --> Browser Functions --> System
Console Specialist. A Welcome Page displays, with links (in the left navigation area) to functions.

3. Click Update Drive Code. A screen appears which allows you to filter which drives are displayed and
are available for updating.
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Select the drive types you wish to display, and select the sorting preference. Click Submit. A page
displays which presents the controllers that meet the selected criteria and that are currently available
for a code update.

Select drives to update by clicking the small plus sign next to the Controller Type column of the
controller that contains the drives to update. This will expand the entry in the table for that controller,
listing the available drives. The current code level will be displayed in the Current Code Level column.
Select a new code level from the Available Code Levels column.

Once all desired code level updates are selected, proceed with the update by clicking Update Code.

Verify that the microcode level update is complete by viewing the History table. This table will show
when each code update has started and when it has completed. It also will indicate if the process has
failed. It will be necessary to refresh the page periodically to view the status of the operation. Clicking
an entry in the History table displays details for the entry. Seefor control unit error codes
and see [Table 3-9 on page 3-64] for single tape drive error codes.

Click Refresh to refresh the status. You can click on an entry in the History table to obtain more
information about it.

Vary online all drives that are attached to 3590 A60 and 3592 control units which were previously
varied offline.

Note: Consult with your next level of support for questions and/or direction on code levels to apply to tape

drives.

Table 3-8. Control Unit Error Codes

This error code... | ...informs you that...

0 Code update process is completed and all code updates are complete

22 Code update process is completed with some incomplete code updates

23 Code update process is completed with errors

24 Could not receive codeloadstatus file from subsystem. Code update process completed
1 Code activation is currently in progress on the specified subsystem

2 Subsystem code activation function did not receive the code update request file

3 rsENDriveCodeLoad.pl -L already running on System Console

4 Could not retrieve configuration for the subsystem with specified IP address

5 Specified subsystem does not support code updates through the System Console
6 No requested images are available on System Console

7 Error creating drive code package

8 Error creating drive code update request file

9 Subsystem does not have enough storage space available for code transfer

10 Communications error prevented a command from being sent to the subsystem
11 Incorrect arguments sent to subsystem drivecodecheck program

12 Warning: the subsystem could not remove the temporary archive file

13 Code image extraction failed on subsystem

14 Code image permissions change failed on subsystem.

15 Code image archive not received on subsystem

16 Subsystem command execution failed for an unknown reason

17 Lost process synchronization between System Console and subsystem

18 Status of code update is unknown. fork() call to launch drive code update command failed
19 Multiple status update failures while waiting for drive code update process
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Table 3-8. Control Unit Error Codes (continued)

20 Code update process did not return, status of code update unknown
21 Code update process returned with unexpected failure code

Table 3-9. Single Drive Error Codes

This error ...informs you that...

code...

25 Unable to communicate with drive

26 Device is open and in use (for example, not offline)

27 Device has no more internal memory

28 Device rejected command, incompatible or corrupted microcode file
29 Non-tape drive error when loading drive code

30 Code update process has been started
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Launching Specialists
1. Launch the System Console Specialist by selecting Main Menu --> Browser Functions --> System
Console Specialist. A Welcome Page displays, with links (in the left navigation area) to functions.

2. Click the Launch Specialists link in the left navigation area of the System Console specialist user
interface. A screen appears, which displays links to Specialist user interfaces for library managers and
peer-to-peer Virtual Tape Server controllers that are attached to the System Console.

3. Click the link of the Specialist user interface that you wish to launch.

Notes:

* If unique hostname aliases have not been assigned to library managers, all of the displayed
names will be the same for the library manager specialists. The IP address displays in the
bottom status bar of the browser.

* Web specialists for tape systems are optimized for certain Microsoft Windows-based web
browsers. You may receive a warning message that states this when you attempt to display the
tape system specialist. The tape system specialists display and operate by using the System
Console's browser. However, it is possible that some functions may not display or operate
correctly. Discontinue using the System Console's browser for tape system specialists if this
occurs.

* The specialists must be operational on the tape systems in order to view them on the System
Console. Refer to the Maintenance Information manual for the appropriate tape system for
activating and configuring its web specialist.

Administer Users

Launch the System Console Specialist by selecting Main Menu --> Browser Functions --> System
Console Specialist. A Welcome Page displays, with links (in the left navigation area) to functions. Click
the Administer Users link in the left navigation area of the System Console user interface. A screen will
load with options to add users, delete users, or change user passwords.

Adding a User

To add a user to the customer group, under the Add User heading:
1. Enter a new user id in the User ID field (8-character maximum).

2. Enter a password in the New Password field and repeat the password in the Confirm Password field.
(8-character maximum).

3. Click Add.
Deleting a User

To delete a user from the customer group, under the Delete User heading:
1. Select a user ID from the User ID drop-down list.
2. Click Delete.

Changing a User Password

To change a user's password, under the Change User Password heading:

1. Select a user ID from the User ID drop-down list.

2. Enter a password in the New Password field and repeat the password in the Confirm Password field.
3. Click Change.

Chapter 3. Procedures  3-65



Error or Defer Matrix Updates

Occasionally, updates become available for the Error Call Home and Deferred Call Home capabilities of
attached subsystems. You can use the System Console to broadcast and activate these updates to
attached subsystems or to remove previously-applied updates. Do not manually download the updates.
The System Console will automatically download these updates as they become available.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level. The code level
requirements are:

System Console
Code Version 3.2.0 and above

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.32.xx.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.19.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

Broadcast and Activate Updates
1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39}

2. Select System Console Actions --> Error/Defer Matrix Updates to start the Error and Defer Matrix
updates tool. The dialog window in|Figure 3-81| displays. This tool enables copying error/defer matrix
updates at the System Console to attached VTS, VTC, or tape controller systems over the local
network.

- 1
B i

IEM TS3000 System Conzoleltm)
MTS5/Tape Controller Errarslefer Matrix Update Henu

1, Browse and Apply available errorddefer matrix updates
2, Undo a previously applied error/defer matrix update
3, View Log

4, Quit

Enter the mumber of your selection and press [Enterl: |

a14o0r265

Figure 3-81. VTS, VTC, or Tape Controller Error or Defer Matrix Update Menu

3. Type 1 to select 'Browse and Apply available error/defer matrix updates,' and press Enter to display
[Figure 3-82 on page 3-67|
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s
IBM TS3000 System Console(tm)
VTS/Tape Controller Error/Defer Matrix Update Menu

1. Browse and Apply available error/defer matrix updates
2. Undo a previously applied error/defer matrix update
3. View Log

4. Quit

Enter the number of your selection and press [Enter]: 1
Reading files...

# Update name Date Compatibility
[1] FID80B9 3/18/2005 3494-B20
3494-B10

Select error/defer matrix update to activate
Enter selection or just press [Enter] when complete:

Figure 3-82. Error or Defer Matrix Update Menu

4. Enter the number of the update you wish to apply or remove, and press Enter. A description of the
update displays (Figure 3-83). Read the description of the update. To apply the update, type y at the

prompt, and press Enter.

Enter selection or just press [Enter] when complete:
1

Selection:

FID80B9

# Filename: FID80B9

Compatibility: 3494-B20 3494-B10

Created: 3/18/2005

Defer call home for SIMs with refcodel of

#
#
#
#
# 60B9.
#

Please read the update description above.
Are you sure you want to use this update? [y/N]

N

Figure 3-83. Error or Defer Matrix Menu - Apply Update

5. A list of compatible subsystems appears (Figure 3-84). Only subsystems that are compatible with the
selected update are shown. Select any subsystems for which you want to activate this update by
typing their numbers into the input area of the screen ('1' in this example). Press Enter.

Select compatible systems to activate matrix update.
Only compatible systems are shown.
NO MODEL  SERIAL HOSTNAME IP ADDRESS SELECT

1 3494B10 78B1510 raselvts 172.31.1.150 No

Enter selections (or de-selections) separated by spaces (ex: 1 3 5 7)
or press [Enter] when complete:

1
-

Figure 3-84. Error or Defer Matrix Menu - Compatible Systems

6. When you have finished selecting systems, with your cursor in an inactive area on the screen (on a
blank line), press Enter. The update will be broadcast to each system, 'Yes' will replace 'No,' and the
status of the update will be shown as ‘complete.' See [Figure 3-85 on page 3-68
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Select compatible systems to activate matrix update.
Only compatible systems are shown.
NO MODEL  SERIAL HOSTNAME IP ADDRESS SELECT

1 3494B10 78B1510 raselvts 172.31.1.150 Yes

Enter selections (or de-selections) separated by spaces (ex: 1 3 5 7)
or press [Enter] when complete:

Applying changes to raselvts...complete
o J

Figure 3-85. Error or Defer Matrix Menu - Systems Selection Broadcast

Remove Previously-Applied Updates
This utility also can remove previously applied error and defer matrix updates. Removing or attempting
to remove an update from a system that did not have the update has no effect.

7. To remove an update, select 2 from the main menu. A list of available updates appears, as shown in
__Figure 3-86,

s
IBM TS3000 System Console(tm)
VTS/Tape Controller Error/Defer Matrix Update Menu

Browse and Apply available error/defer matrix updates
Undo a previously applied error/defer matrix update
View Log

Quit

BN =

Enter the number of your selection and press [Enter]: 2

PLEASE NOTE: You are deactivating an error matrix update. This action will
have no effect on systems that never had the update applied.

Reading files...

# Update name Date Compatibility

[1] FID80BI 3/18/2005 3494-B20
3494-B10

Select error/defer matrix update to DEACTIVATE
Enter selection or just press [Enter] when complete: )

Figure 3-86. Error or Defer Matrix Menu - Available Updates

8. Repeat Step through Step |6 on page 3-67|to remove an update.

Launching DS6000 Graphic User Interface (GUI)

Use this procedure to launch the DS6000 graphic user interface (GUI). To read about installing the GUI,
see [‘Installing DS6000 Graphical User Interface (GUI)” on page 2-52.|

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39|

2. From the Main Menu, select Browser Functions > DS6000 Functions > Launch GUI. You see the
browser window in [Figure 3-87 on page 3-69|
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IBM System Storage™ DS6000 Storage Manager

al14or0314

Figure 3-87. DS6000 GUI Login Username and Password Screen

3. At the login screen, enter the username 'admin' and the password ‘ibm2serv'.

Note: If an excess quantity of failed user-authentication attempts occurred, the GUI will lock out users
who attempt to login. If this occurs, return to the System Console desktop screen. Right click to
bring up the main menu. Select Browser Functions > DS6000 Functions > Reset GUI
Password. You will see , which provides status on the password reset.

-
I Reset DS6000 GUI Password
Rezetting the D5 GUI Password
Changing the 15 GUI Pazsword
The DS GUI pazzword haz been successfully unlocked
Press <enter> to exit,..

al4or312

Figure 3-88. Reset DS6000 GUI Password Screen

When the reset has completed, press Enter. Return to Step |2 on page 3-68|to continue.
4. Once the DS6000 GUI is launched, [Figure 3-89 on page 3-70| displays.
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IBM System Storage™ Storage Manager

= Welcome

Welcome
Welcome

b Real-time manager DS6000 Storage Manager
b Simulated manager

Version 5.2.0.1942

Getting started

& Setting up the DS Storage Manager
3 Creating a custom logical storage configuration

Learning and tutorials

a140r320

£ _DSENNN Ovarviow

Figure 3-89. Storage Manager Welcome Screen

5. To set up communication with a TS7700 cache subsystem, from the Welcome column in the left frame,

click on Real-time manager.

6. From the resulting list (not shown), select Manage hardware, then select Storage complexes from
that resulting list. |Figure 3-90| displays.

Storage complexes: Real-time

Refresh | Last refresh: Monday, July 24, 2006 8:56:52 AM GMT

s 2§ | 2] | | — Select Action — |\_'] Go | Print report | Download sprea
| Select ~ | Nickname ~ :‘-é‘;f'orage-Uh'i"ts ~ :'M'anagemeﬁ-t'bdnsoié 1 ~ |Status ~ EManagem
[] tssnet11.storage.tucson.ibm.com - a 9_11_2”2.1.163 Connected“ -

Page 1 of 1

Total: 1 Filtered: 1 Displayed: 1 Selected: 0

al4or321

Figure 3-90. Storage Complexes : Real-time Screen

7. Click on Select Action, and from the resulting drop-down menu select Add Storage Complex. Click
on Go. [Figure 3-91 on page 3-71| displays.
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Add Storage Complex: Real-time

Add a storage complex by specifying the correct field values and then clicking OK
Define Management console 1 [ Define a second Management console

#Management console 1 1P address  Management console 2 IP address

OK || Cancel

al4or319

Figure 3-91. Add Storage Complex Screen

8. Enter into the "Management console 1 IP address" field the TS7700 IP Address that was used for
TSSC attachment. This address should be in the form '172.31.1.x". Select OK. This returns you to
[Figure 3-90 on page 3-70] Your storage complex should now be listed. For all further DS6000 service
information including firmware upgrade, refer to the DS6000 InfoCenter.

Launching Storage Manager (SM) Graphic User Interface (GUI)

Use this procedure to launch the Storage Manager graphic user interface (GUI). To read about installing
the GUI, see [‘Installing Storage Manager (SM) Graphical User Interface (GUI)” on page 2-53

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. If you are not already logged into the TSSC, login. In the field for Username, type service, and in the
field for Password, type service.

2. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39
From the TSSC desktop, right click to invoke the menu for IBM TS3000 System Console.

4. From the Main Menu, select Browser Functions > Storage Manager GUI Functions > Launch
GUI. You see the browser window in [Figure 3-92 on page 3-72|

w
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Figure 3-92. Storage Manager GUI Initial Screen

5.

10.
1.

From the Enterprise Management Window Tape Assistant screen, select Add Storage Subsystems
to add a storage subsystem.
If you just installed this GUI for the first time, or want to add another subsystem, perform the
following. If not, go to Step [g} From the Select Addition Method screen, choose one of these options:
» Automatic - to interrogate for storage subsystems and to add storage subsystems that are with in
the local subnetwork. Go to Stepf7]
--OR- -
* Manual - to add a storage subsystem that is outside the local subnetwork. Go to Step
From the Automatic Discovery screen, select OK to begin an automatic discovery of storage
subsystems on the local sub-network, or select Cancel to discontinue. When this is completed, go to
Step |9
Select Additional Method > Manual and press OK.
a. From the dialog box for Add Storage Subsystem - Manual, select the radio button for In-band
management, then type the TCP/IP address for the TS7700 in the field for Host (DNS/Network
name, IPv4 address, or IPv6 address).

Note: The address you type should be 172.31.1.xxx that is listed in [Table 3-10 on page 3-73
Click Add.

If you add a storage subsystem successfully, you will see a dialog box that says: The specified
host was added successfully.

d. If you have more than one storage subsystem to add, click Yes, otherwise click No.
From the navigation for IBM System Storage Manager, select Devices.

Verify that the status is optimal. If so, exit. If not, contact the next level of support.
Return to the procedure that sent you here.
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Table 3-10. TSSC IP Addresses

Field Value Notes
Master Console IP address 172.31.1.1 IP address of the Master Console.
Master Console Hostname This is the recommended hostname
tssneti
for the Master Console.
3957-VEA / VEB IP address on the This is the recommended IP address
Master Console Network for the first TS7720 attached to a

master console. The last octet of this
IP address must be in an increment
of 10 between 10 and 240 (that is.
172.31.1.xx 10, 20 ... 230, 240). The TS7720
router configuration will utilize this
and the following 9 IP addresses
(example: .150 - .159) so no other
device should be set to an IP address
in this range.

Subnet Mask on the Master Console |255.255.255.0
Network

Launching ProtecTIER Manager Graphical User Interface (GUI)

Use this information to launch the ProtecTIER Manager graphic user interface (GUI). To read about
installing the GUI, see |“Insta||ing ProtecTIER Manager Graphical User Interface (GUI)” on page 2-56.|

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39I
2. From the Main Menu, select Browser Functions > ProtecTIER Functions > Launch GUI.
3. Refer to the TS7650 User's Guide (3958 family) for additional launching instructions.

Accessing Subsystem Interfaces

Use this procedure to access available subsystem web interfaces including Specialists and the IBM
TS7700 Management Interface.
1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Actions -—> Console Configuration Utility. You see
the Main Configuration screen shown in [Figure 3-93 on page 3-74|
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TS3000 System Console

Comments? Send User Feedback
Attached Svstems Fix Acquisition
Baclamp Restore Modem Transmission
Call Home Quene

Call Home Settings

Network Information
Offload User Files
Console Settings PE Packages

Console Status Svystem Interfaces

ol & 1 (b 8
I gt e

Console Time System Tools

aldord62

Figure 3-93. Main Configuration Screen

3. Click on System Interfaces. You see [Figure 3-94]

S3000 System Console

Please select the system whose interface you would like to access: NOTE: If accessing this page remotely, you will need have a local rounte
on your system which points to the local TS3000 System Console subnet in order to access these interfaces.

Device-Model[Host Name||Serial Number | TP address ||SSH Tunmel Commands
3957V06 || rasts7740 | 78C69AG |172.31.1.160| [ Create Tunnel
3957V06 | rashydra | 78008BA 172311190 [ Create Tunnel
3957V06 || rasmatazz | 78083EG ||172.31.1.150| [ Create Tunnel |
3957V06 || lirascal | 7800DOA |172.31.1220| [ Create Tunnel
3953105 | RASELB | 1300005 ||17231.112 | [(Create Tunnel ]
3953005 | RASELA | 1300005 (17231111 [(Create Tunnel ]
3494122 |RASLMS || 1314501 | 1723115 Create Tunnel
3584132 |RAS3584 | 13AAA15 [17231.1.170) [ Create Tunnel |

aldor344

Figure 3-94. System Selection Screen

4. Click on the system you would like to connect to. This opens a browser tab that is connected to the
system you selected. The tab contains either the Specialist or the TS7700 Management Interface for
the system you selected. Refer to the documentation that applies to your selected system for more
help.

Managing InfoCenter From Web Interface

Use this web interface as an alternate way to add the Information Center (InfoCenter), or to launch the
Information Center from or to delete an InfoCenter level from the TSSC.

1. Right click from anywhere in the Desktop to view the Main Menu shown in[Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Action -—> Console Configuration Utility. You see the
login prompt shown in[Figure 2-53 on page 2-40}

3. Type service in the Username field, service in the Password field, then single click OK to start the
Console Configuration application. You see the menu shown in [Figure 2-54 on page 2-40}

4. Select System Tools > Manage InfoCenter. You see |Figure 3-95 on page 3-75|
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—Manage InfoCenter

To import the InfoCenter, insert the InfoCenter CD-ROM and click on the button to
begin.
Please wait for the page to displav the results after clicking Import InfoCenter.

If the InfoCenter has already been imported, launch it with Launch InfoCenter.

Import InfoCenter H Launch InfoCenter H Delete InfoCenter

al4or515

Figure 3-95. Manage InfoCenter from Web Interface

5. To import the InfoCenter from a CD-ROM, insert the CD-ROM into the CD drive of the System
Console, and click on Import InfoCenter.

6. After the import completes, the CD ejects. The page displays at the top if it was a success or if an
error occurred.

7. To launch the InfoCenter, from [Figure 3-95| click on Launch InfoCenter. A new window opens in your
browser which points to the InfoCenter.

8. To delete a level of InfoCenter, from [Figure 3-95] click on Delete InfoCenter. If there is at least one
level of InfoCenter installed it will be displayed in a box similar to the one shown in |[Figure 3-96

_TS3000 System Console
Remote Code Drive Code Manage TSSC Mksysb
Broadcast Broadcast InfoCenter Exec Broadcast
—Manage InfoCenter

To import the InfoCenter, insert the InfoCenter CD-ROM and click on the button to begin.
Please wait for the page to display the results after clicking Import InfoCenter.

If the InfoCenter has already been imported, launch it with Launch InfoCenter.

[ Import InfoCenter ][ Launch InfoCenter ][ Delete InfoCenter
— Infocenters installed:

Select the infocenter levels to delete:

IE‘ Infocenter version

E |com_fbm_storage_ts?740.5mﬂce_d0c_] 9275
F |com.fbm.storage.ts??40.5&11&:&.(:10:_] 978
IE |com.ibm.storage.ts??40.5&11&:&.(:10:_1 979

l Delete Selections H Cancel ]

al4or516

Figure 3-96. Different InfoCenter levels installed

9. From this box select the InfoCenter Level(s) you want to be deleted and click on Delete Selections to
confirm.
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Importing InfoCenter From CD-ROM

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39}

2. From the Main Menu, select System Console Actions —> Import InfoCenter. The Terminal screen
shown in [Figure 3-97|appears, and asks you to insert the InfoCenter CD.

|
il

Pleaze inzert Infolenter CO-ROM and hit enter:

Importing pluging hydra,com, ibm, ibmcom, doc_1,0,0,
Importing pluging hydra,com, ibm,storage,t=7740,doc_3,0,1,
Imparting feature: hydra,com, ibm,storage, t=7740_3,0,1,
Shutting down Eclipze Framework Manager: Success
Starting Eclipse Framework Manager: Success

InfoCenter impaorted SUCCESSFULLY

Press <enter’ to exit

L

Figure 3-97. Insert InfoCenter CD Screen

3. Insert the InfoCenter CD-ROM for the desired product, and press Enter. You will see the imported
Eclipse plugins and features. Eclipse restarts.

4. You may now Launch the InfoCenter. The imported information appears. Go to[‘Launching InfoCenter.”|

Launching InfoCenter

Use this procedure to launch the InfoCenter. To read about installing the InfoCenter, see
[InfoCenter From CD-ROM.]
1. Right click from anywhere in the Desktop to view the Main Menu shown in[Figure 2-52 on page 2-39|

2. From the Main Menu, select Browser Functions > Launch InfoCenter. A browser window appears,
as seen in|Figure 3-98 on page 3-77} This can take as long as 15 seconds to open.
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Search: Search scope: Al topics
Contents % 0 C oo d
© TotalStorage Master Console Help &

Using the Eclipse help system

Browse topics in the Contents frame (&) on the left. Click an a topic to have it displayed
Use the Back and Forward butfons fo navigate within the history of viewed topics.

Searching

To quickly locate topics on a particular subject in the documentation, enter & query in the
Search field. Use the Search frame (%) to display the Search view. You can narrow the
scope of your search by selecting only the sections you are interested in

Synchronizing

After you run a search and find & topic you were looking for, click either the Refresh /
Show Current Topic button (") or Show in Table of Contents button (k%) to match the
navigation tree with the current topic. You might also find it useful to synchronize after

@ % e e i .

al4or365

Figure 3-98. Launching InfoCenter Window. Though not shown here, your selection will appear below "TotalStorage
Master Console Help."

3. You should see the TSSC InfoCenter topics, as well as any imported InfoCenter in the column to the
left. You may select your appropriate topic or use the search box to navigate through the help
information.

Delete InfoCenter

Use this procedure to delete an InfoCenter level.
1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|

2. From the Main Menu, select Browser Functions > Delete InfoCenter. A Terminal screen appears
displaying the different InfoCenter levels that are installed. (If there are no InfoCenter installed, a
message indicating this will be displayed). The user can select the Infocenter to delete by entering the
number of InfoCenter displayed on screen.

Updating TS7700 Cache Controller Microcode

Note: Before you begin this procedure, you must obtain the CD-ROM that includes the latest level of the
DS6000 microcode and the SEA.jar file. You should receive a CD-ROM whenever there is an
update to the DS6000 microcode.

Use this procedure to update the TS7700 Cache Controller microcode.
1. Ensure that you close all TSSC browser sessions. From the TSSC menu, click File > Close.
2. Insert the microcode CD-ROM into the CD drive of the TSSC.

3. Right click from anywhere in the Desktop, and select System Console Actions > CD Copy to
Console. You see [Figure 3-99

Select Save Location:

1. /var/enc/cdrom/
/home/root/offload/
/home/service/cffload/
Exit Program

W L R

al4or345

Your Selection: I
Figure 3-99. Select Save Location Screen

4. At the command prompt (Your Selection ), type 1 to select /var/enc/cdrom. Press Enter. Expect a
delay as the CD drive copies information from the CD-ROM. This can take as long as 15 minutes to
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complete. You will see|Figure 3-100| when the copy is complete.

S5UCCESS: Disk contents can now be found in
/var/enc/cdrom

al4or346

Fress <Enter> to exitl

Figure 3-100. TS7700 Cache Microcode Copy Complete Screen

Note: If the directory has an existing microcode image installed, you will be prompted to overwrite
that existing image with the new image. Select Yes to continue.

5. Right click the desktop of the TSSC, and select Browser Functions > DS6000 Functions > Launch
GUI. This action invokes the TS7700 Cache Controller graphical user interface.

6. Login by typing the username admin and the password ibm2serv.

7. From the left hand navigation menu, select Real Time Manager > Manage Hardware > Storage
Units. You must wait for several minutes while the system builds the list of storage devices.

8. If you found in the list, the TS7700 Cache Controller onto which you want to install the DS6000
microcode, go to Step[10}

- -OR - -

If you did not find the TS7700 Cache Controller onto which you want to install the DS6000
microcode, go to |“Launching DS6000 Graphic User Interface (GUI)” on page 3-68| to add the TS7700
Cache Controller to the TS7700 Virtualization Engine. Return here to Step [9]

9. Click Refresh to highlight the TS7700 Cache Controller in the list.

10. Click the check box to select the TS7700 Cache Controller on which you want to upgrade the
microcode.

11. In the drop-down menu for Select Action, select Apply Firmware Update.
12. Ensure that the drop-down box for Apply Firmware Update Real Time is set to Concurrent.
13. Click Select a file.

14. Select the file directory, or type the file directory path to where you downloaded the SEA jar file in
Step |2 on page 3-77|through Step E As shown in this example, you would scroll to (or type) the
directory name /var/enc/cdrom.

15. Click Open, then click OK. This action copies the SEA jar file to the TS7700 Cache Controller.

16. Scroll to and click Transfer File. The microcode is copied to the TS7700 Cache Controller. This task
can take as long as fifteen minutes to complete.

17. Click Activate after the Transfer File task completes. This Activate task can take as long as 1.5 hours
to complete.

Resetting Modem

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

If your modem is hung after you dial in, you can use this information to use the Reset Modem button.

Note: Some modems have internal locks which prevent a software reset. If you are unsuccessful using
the procedure, you might need to power cycle the modem. Consult the modem documentation for
procedures.

1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39|
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2. From the Main Menu, select System Console Actions > Console Configuration Utility > Call Home

Settings. You see the screen shown in|Figure 3-101|.

— Call Home

Enable Call Home
Select Call Home Interface:
C Modem
(O IBM Infranet
@ Autoselect

Call Home Communication Setup:

Ethernet Commumnication:
® Direct Connection
O Connect Through HTTP Proxy

Proxy Address: |

Proxy Port: |:|

al14or355

Figure 3-101. Modem Reset Settings

3. Under Call Home Communication Setup on this screen, select the Modem Port from the list. Click
Reset Modem.

Opening SSH Tunnel

Notes:
* Use this only when directed by your next level of support.
» This function may not be available for all levels of TS7700 code.
» To use this function to remotely access any of the interfaces that are listed, you need a local
route on your system that points to the local TSSC.

Your Support contact might ask you to open a tunnel so that they can gain access. Use this procedure to
open a Secure SHell (SSH) tunnel to access one of the attached subsystems from a remote location.

1. Right click from anywhere in the Desktop to view the Main Menu shown in |Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Actions > Console Configuration Utility > System
Interfaces. You see the screen shown in [Figure 3-102 on page 3-80
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Tunnel opento 172.31.1.12
[Device-Model [Host Name Serial Number | IP address |SSH Tunnel Commands

| 3957V06 | rasts7740 | 78C69AG |172.31.1.160
| 3957V06 | rashydra | 7800SBA 172311190
| 3957V06 | rasmatazz | 78083EG |172.31.1.150|
| 3957V06 | frascal | 7800D0A |172.31.1220|
| 3953L05 | RASELB | 1300005 | 17231112 |
|
|
|

3953L05 | RASELA | 1300005 | 17231111 |
3494122 |RASLMS | 1314501 | 1723115 |
3584132 |RAS3584 | 13AAA15 (172311170

al4or354

Figure 3-102. SSH Tunnel Settings

3.

4.

Click Create Tunnel next to the system to which you want to open a tunnel. You are granting system
access to a Support person.

After you and Support are satisfied with your activity, click on Close Tunnel to release the connection.

Note: If you do not close this tunnel, it will close automatically after four hours regardless of any
current operating status. You will need to reopen the tunnel to continue your activity.

Sending User Feedback

Use this information to send a comment to an IBM support group about the System Console. for
comments about this MI, see "Send Us Your Feedback" in the "Read This First" section of this MI.

1.
2.

Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39}

From the Main Menu, select System Console Actions > Console Configuration Utility > User
Feedback. Enter information into the User Name, User email address, and Comments fields.

Note: Do not add or allow spaces in the username.

Click Send Comments. This will create and send a PE package. You can review your comments in a
file entitled "userFeedback(firsthnamelastname).(timestamp).txt" that is located in the
/var/enc/log/feedback directory.

Adding PFE Execs From Web Interface

You can add PFE Exec patches to the TSSC from the web interface. This web interface allows an
alternate way to add a PFE Exec patch to the TSSC, other than using menu options from the desktop
menu.

1.
2.

Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39

From the Main Menu, select System Console Actions > Console Configuration Utility. Type
service in the Username field, type service in the Password field, then click OK.

Select the System Tools link.
Select the option at the top for TSSC Exec. You see [Figure 3-103 on page 3-81

3-80 1BM TS3000 System Console Maintenance Information — 29th Edition November 2012



—Add PFE EXEC to TSSC

This page allows vou to add a PFE EXEC patch to the TSSC.

Select the location of the PFE EXEC and click Add PFE EXEC when ready.

Please wait for the page to display the results after clicking Add PFE EXEC.

Note: When using the Home Directory option, make sure that all img files in vour directory belong to vou

® CD-ROM
O USE Device
© Home Directory

Add PFE EXEC

a14or380

Figure 3-103. Adding PFE Exec from Web Interface

5. If you wish to use a CD-ROM that has the patch:
a. Insert the CD-ROM that has the patch on it.
b. Select CD-ROM > Add PFE EXEC.

- —-—OR - -

6. If you wish to use a USB Device that has the patch on it:
a. Plug in a USB device that has the patch on it.
b. Select USB Device > Add PFE EXEC.

- —-—OR - -
7. You also can add the patch if it is in your Home Directory.
a. If you know the patch is in your Home Directory, select Home Directory > Add PFE EXEC.

8. You see the window in|Figure 3-104{ which prompts you to verify that the PFE EXEC patch is on the
selected media. Select OK.

f = =}

The page at http://rasberry.storage.tucson.ibm.com: 7080 says:

9 Flease make sure the PFE EXEC is on the selected media and dlick OK to continue.,

oK | [ Cancel

1
a14br381

Figure 3-104. PFE Exec Patch
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9. A box showing the available PFE EXEC patches on the selected media is displayed:

— Patch Files found:
Select the patch file to install:
[ @ [home/service ECC-SP.IMG
| © [home/service ECC-SP2.IMG
[ @ [home/service ECC-SP3 IMG

I Install Patch H Cancel

al4or548

Figure 3-105. Multiple patch options

10. Select the desired patch and click on Install Patch.

11. The process proceeds, then the page reloads. A message appears above the text depicted in
[Figure 3-103 on page 3-81} noting the success or providing an error message.

Mksysb Broadcast from the Web Interface

Note: This process will keep only one version of the mksysb images. If you have a previous level on the
3957 and TSSC, this process will remove it before it downloads the new version.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
|Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level. The code level
requirements are:

System Console:

Code Version 5.5.20 and higher. DVD drive is required for this process. TSSCs with DVD drives are: 4362,
8485, 8849, 7978, 7946.

3957 - 8.6.x and higher
1. Right click from anywhere in the Desktop to view the Main Menu shown in [Figure 2-52 on page 2-39

2. From the Main Menu, select System Console Action -» Console Configuration Utility. You see the
login prompt shown in [Figure 2-53 on page 2-40

3. Type service in the Username field, service in the Password field, then single click OK.
4. Select System Tools -»Mksysb Broadcast link. You will see the image below.
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TS3000 System Console

Femote Code Broadcast Drive Code Broadcast Import Info Center TSSC Exec Alksvsh Broadcast
—Mksysb Broadcast Options

This servlet provides the ability to broadeast mksysb code to connected hydras and/or TSSCs in vour grid. Select "Copy Mksysb
DVDs And Broadcast” ff vou want to broadcast a Mksysb image from DVDs. Select "Broadcast Existing Mksysb Image" f vou
want to broadcast a Misvsb image that is already on the hard drive.

Note: For large code images copyving and broadcasting can take time. Please wait for the page to reload.

Miksvsb Broadeast Menmu

1. [ Caopy Mksysb DVDs And Broadcast

)

(Ho existing image)
s
s

aldord41

Figure 3-106. Mksysb Broadcast Screen

If you have already downloaded an image that you want to broadcast, skip to step|8 on page 3-84}
otherwise, continue to the next step.

5. Select the Copy Mksysb DVDs And Broadcast button. This will prompt you to enter the first DVD
and select OK. Once you have inserted the first DVD, select OK to continue. The process of
downloading the first disk may take up to 20 minutes.

6. When the download has completed, you are prompted to insert the second DVD and continue:

TS3000 System Console

DVD copied successfully.
Please msert next DVD and press continue.

Femote Code Broadcast Drive Code Broadcast Import Info Center TSSC Exec Alksvsh Broadcast
— Mksyshb Broadcast Options
This servlet provides the ability to broadcast mksysb code to connected hydras and'or TSSCs in vour grid. Select "Copy
Mksysb DVDs And Broadeast” f you want to broadcast a Mksvsb image from DVDs. Select "Broadcast Existing Mksysb
Image" if vou want to broadcast a Misysb image that is already on the hard drive.
Note: For large code images copyving and broadcasting can take time. Please wait for the page to reload.

Mksysb Broadcast Memu

AR t (No existing image)

aldord40

Figure 3-107. Mksysb Broadcast Screen - DVD Copy OK
The continue button is located above the log output. Remove the first DVD, insert the second DVD

and press the Continue button as shown below. If you wish to cancel this process, press the Cancel
Copy button, and you will return to the initial screen.
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— Copy next DVD for Mksvysb Broadcast

Please put the next DVD in the drive
Wait for the light to go out -- THEN
Please press continue

Cantinue ][ Cancel Copy

al4or439

Figure 3-108. DVD Copy for Mksysb Broadcast

7. When the download of the second DVD has completed, a success message, “Broadcast list created
successfully. Please select machines to broadcast to" will display.

8. Below the logs, you will be able to select which machines you can broadcast this new mksysb image
to.

r—Choose Systems for Code Broadcast

Select systems for broadcast by typing in the box below the numbers you wish to broadcast to
geparated by spaces, or leawve it empty. (e.g. 0 1 2 3)

If you wish to broadcast to all systems, type "all™ and hit submit

If you wish to control the order of the broadcasts, just specify them in the order you would
like them to be broadcasted in. (e.g. 2.3 01 wi broadcast to 2 first, 3 second, and so on)
If you wish to broadcast to some systems in para y instead of using a space to Separate the
systems use a tilde (~). (e.g. 8~1~2 3 will broadcast 0, 1, and 2 at the same time, then 3 once
8,1, and 2 are finished)

Systems to choose from:

NC MODEL SERIAL HOSTNAME CODE LEVEL EXISTING IMAGE

a 3957 V06 7E800DOA B.6.0.86 copied on Sep 03 21:46
1 3957 V06 TE00A&A 3.6.0.86 copied on Sep 03 23:50

z 3957 V06 TE00EBA B.6.0.82 copied on Aug 21 22:39
3 7946 PAR EKQMHIVP Copied on Sep 4 08:10

Systems for Code Broadcast: H Submit Choices ] [ Cancel Broadcast

al4or438

Figure 3-109. Choose Systems for Code Broadcast

9. When submitting your systems for broadcasting you can send to an attached 3957-V06/V07 and
3957-VEA/VEBS, as well as other TSSCs with 5.5.20 or higher code levels in the same AOTM
network. The list of available systems will be presented as shown in the screen above. The screen
presents the Machine Type, Model, Manufacturing Code and Serial number, Local IP address,
Hostname, Code Level, and if the system has a copy of a mksysb image already present as well as
the date and time the file was sent.

Note: The 3957 will only keep one level of mksysb on the machine at a time.

Select systems for broadcast by typing the numbers in the box you wish to broadcast to (separated
by spaces) or leave it empty (for example 0 1 2 3).

* If you wish to broadcast to all systems, type "all* and hit submit

 If you wish to control the order of the broadcasts, specify them in the order you would like them to
be broadcast. (for example 2 3 0 1 will broadcast to 2 first, 3 second, 0 third, and 1 fourth)

« If you wish to broadcast to some systems in parallel, then instead of using a space to separate the
systems use a tilde (~). For example 0~1~2 3 will broadcast 0, 1, and 2 at the same time. Then 3
will broadcast as soon as 0, 1, and 2 have finished.

When the image broadcasting is complete, the screen will return and will present logs of the
transactions.
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10. Select System Tools ->Mksysb Broadcast link. See|Figure 3-106 on page 3-83, Make the
appropriate selection(s) as follows:

» Select 3. View the Log File
« Select 4. Clear the Log File
* Select 5. Eject the DVD

Setting 3958 and 3592 SNMP Trap Forwarding

Note: To use this to forward SNMP traps to the customer's network, you must obtain the IP address from
the customer.

1. Right click from anywhere in the Desktop to view the Main Menu shown in|Figure 2-52 on page 2-39|

2. From the Main Menu, select System Console Actions > Console Configuration Utility > Call Home
Settings > SNMP Settings.

3. You will see a box for ProtecTIER SNMP Trap Forwarding if a 3958 is attached, and a box for Control
Unit SNMP Trap Forwarding if a 3592 is attached. You will see one of the following screens:

—ProtecTIEE. SHIMP Trap Forwarding
' Enable to IP Addresses:
DS4000 Forward IP: E i [2s ) [2sE
RS A Forward IP: EZ N T
® Disable %
Figure 3-110. Enabling ProtecTIER SNMP Trap Forwarding
— Control Thut SHMFE Trap Forwarding
' Enable to TP Address:
Forward IP: |285 |285 . [2B5 . [25S
& Disable %

Figure 3-111. Enabling Control Unit SNMP Trap Forwarding

4. Select the Enable to IP Address button. This allows you to enter the IP address into the fields on this
screen.

5. Enter the IP address to which you want to forward SNMP traps. Select Apply.

Note: Select Disable to stop sending traps to the customer's network.

Tape System Reporter (TSR)

Note: The Tape System Reporter is a tool developed by the 3584 team that gathers statistical information
about the usage of the 3584 libraries attached to the TSSC. TSR data will be sent to the Call Home
Database when the TSSC performs a Heartbeat call home. See [Figure 2-102 on page 2-71|

Starting Tape System Reporter (TSR)
1. Log into the TSSC. [Figure 2-52 on page 2-39|
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2. Click anywhere on the desktop, select Browser Functions -»TSR Functions -» Start TSR.

Note: If TSR is running when a backup and restore is issued, TSR will restart. Also when the TSSC
reboots, TSR will restart.

Stopping Tape System Reporter (TSR)
1. Log into the TSSC.
2. Click anywhere on the desktop, select Browser Functions -»TSR Functions -» Stop TSR.

Fix Acquisition

Use this feature to find and download system and microcode updates for IBM Tape Storage devices.
1. Right click anywhere in the Desktop to view the Main Menu as shown in |Figure 2-52 on page 2-39|.

2. From the Main Menu, select System Console Action --> Console Configuration Utility. You see the
login prompt shown in|Figure 2-53 on page 2-40l

3. Type service in the Username field, service in the Password field, then single click OK.
4. Select the Fix Acquisition link. You will see the following image:

TS3000 System Console

Available Updates General Settings Fix Acquisition Report

All updates downloaded successfully. They can be found in /var/enc/ecc/downloads/. Each update is contained in a named subfolder. Click here to
offload these packages.

—Find Updates

This page allows you to find and download fixes that have been released for all IBM tape storage devices. To find all fixes currently available,
click the Find Updates button below.

Updates were last found on: Mon Sep 17 09:47:06 UTC 2012
\ Find Updates H Clear Downloaded Updates \

—VTD Downloads
Download and broadcast VTD_EXECS to attached TS7700 systems.

| Download VTD_EXECS |

—Attached Systems

| Device-Model | Serial Number [ Host Name | IP address ‘ Subnet Mask

[ 3592C07 [ 78D0006 \ rasc07lma [ 172.31.1.10 \ 255.255.0.0 8

[ 3957VEB [ 78H5474 \ ceviche [ 172.31.1.80 \ 255.255.255.0 S
©

|
| Figure 3-112. Fix Acquisition Main Menu

5. To find all available updates, click the Find Updates button. Once the updates have been found, they
will be displayed on a screen similar to the image shown below:
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| Close this window

Available Updates General Settings Fix Acquisition Report

—Find Updates

This page allows you to find and download fixes that have been released for all IBM tape storage devices. To find all fixes currently available,
click the Find Updates button below.

Updates were last found on: Tue Sep 18 09:07:55 UTC 2012

—VTD Downloads
Download and broadcast VTD_EXECS to attached TS7700 systems.

| Download VID_EXECS |

—Attached Systems

[ Device-Model [ Serial Number ‘ Host Name ‘ IP address [ Subnet Mask
[ 3592C07 [ 78D0006 \ rasc07lma \ 172.31.1.10 [ 255.255.0.0
[ 3957VEB [ 78H5474 \ ceviche \ 172.31.1.80 [ 255.255.255.0

—Available Updates

Here is a list of all fixes currently available to you. Check the box next to each update you want to download. When all updates have been selected,
click the Download Updates button to download them to the System Console. Click Cancel if you do not want to download any updates.

,E‘ Update Description
| 3592-J70+3592-C06/C07
o 3592TapeCntl_1.25.1.x_SNMP_MIB_20111209
3592TapeCntl_1.25.1.x_SNMP_MIB_20111209: IBM System Storage 3592-C07 Controller SNMP MIB for use with 3592-C07 code
\ Download Selected Updates \ ‘ Schedule Download ‘ | cancel \

al4or584

|
| Figure 3-113. Fix Acquisition Updates

6. Place a check in the box next to each update you wish to download. When the download selections
have been made, click the Download Selected Updates button to continue. If you want to exit without
downloading any updates, click the Cancel button instead.

7. Once all updates have been downloaded, you will see a success message.

» All downloaded updates can be found in the /var/enc/ecc/downloads folder. Each update is placed in
its own unique subdirectory.

« The TSSC can be used to offload these packages, see [‘Offloading User Files” on page 3-30|

[ Close this window

Available Updates General Settings Fix Acquisition Report

—Find Updates

This page allows you to find and download fixes that have been released for all IBM tape storage devices. To find all fixes currently available,
click the Find Updates button below.

\ Find Updates \ \ Clear Downloaded Updates

—VTD Downloads
Download and broadcast VTD_EXECS to attached TS7700 systems.

| Download VID_EXECS |

—Attached Systems

[ Device-Model [ Serial Number ‘ Host Name ‘ IP address [ Subnet Mask
[
[ 3592C07 [ 78D0006 \ rasc07lma \ 172.31.1.10 [ 255.255.0.0 @
[ 3957VEB [ 78H5474 \ ceviche \ 172.31.1.80 [ 255.255.255.0 g
©

I
| Figure 3-114. Fix Acquisition Success

8. To delete previously downloaded updates from the TSSC, click the Clear Downloaded Updates
button as shown on [Figure 3-112 on page 3-86|
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VTD Downloads

This section is available only if a TS7700 system is attached. The TSSC will query Fix Central for any
applicable VTD_EXECs, and they will be downloaded and broadcasted to all appropriate machines.

1. Right click anywhere in the Desktop to view the Main Menu as shown in |Figure 2-52 on page 2-39|.

2. From the Main Menu, select System Console Action --> Console Configuration Utility. You see the
login prompt shown in|Figure 2-53 on page 2-40I

Type service in the Username field, service in the Password field, then single click OK.

Click on Fix Acquisition.

Click the Download VTD_EXECS button

Once the process has completed, you will see a success message.

ook w

VTD Downloads
Download and broadcast VTD_EXECS to attached TS7700 systems.
| Download VTD_EXECS |

a14or586

Figure 3-115. Fix Acquisition VTD Downloads

Fix Acquisitions General Settings

Use this settings page to enable and set the interval of the auto VTD_EXEC downloads. The interval is the
number of days between checks for VTD_EXEC packages on Fix Central.

1. Right click anywhere in the Desktop to view the Main Menu as shown in |Figure 2-52 on page 2-39|.

2. From the Main Menu, select System Console Action --> Console Configuration Utility. You see the
login prompt shown in|Figure 2-53 on page 2-40}

3. Type service in the Username field, service in the Password field, then single click OK.

4. Select Fix Acquisition, then click on the General Settings header. You will see the following screen:

, TS3000 System Console

Available Updates General Settings Fix Acquisition Report

Schedule download

¥ Enable System Schedule Downloads
Schedule interval: |1 |2 | Day(s)

\ Apply H Cancel \

al4or587

Figure 3-116. Fix Acquisition General Settings

5. Select Enable System Schedule Downloads to activate the auto VTD_EXEC downloads feature.
6. Set the Schedule Interval and click Apply for changes to take effect.

Fix Acquisition Report

You can see the results of manual and scheduled VTD_EXEC downloads in this section.

1. Right click anywhere in the Desktop to view the Main Menu as shown in |Figure 2-52 on page 2-39|.

2. From the Main Menu, select System Console Action --> Console Configuration Utility. You see the
login prompt shown in|Figure 2-53 on page 2-40I

3. Type service in the Username field, service in the Password field, then single click OK.

4. Click on Fix Acquisition, then click on the Fix Acquisition Report header.

5. You will see the following screen:
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TS3000 System Console

Available Updates General Settings Fix Acquisition Report

—Fix Acquisition Report

2012/09/05-08:17:15  Auto VTD_EXECS download: Execution started. -]
2012/09/05-08:34:24  Auto VTD_EXECS download: Execution started.

2012/09/05-08:35:20  No changes found in XML Master file, exiting.

2012/09/05-08:37:26  Auto VTD_EXECS download: Execution started.

2012/09/05-08:37:48  VTD_EXEC_103 file: Download complete.
2012/09/05-08:37:57  VTD_EXEC_109 file: Download complete.
2012/09/05-08:38:08  VTD_EXEC_118 file: Download complete.
2012/09/05-08:38:18  VTD_EXEC_126 file: Download complete.
2012/09/05-08:38:27  VTD_EXEC_127 file: Download complete.
2012/09/05-08:38:40  VTD_EXEC_132 file: Download complete.
2012/09/05-08:38:50  VTD_EXEC_133 file: Download complete.
2012/09/05-08:39:01  VTD_EXEC_136 file: Download complete.
2012/09/05-08:39:10  VTD_EXEC_137 file: Download complete.
2012/09/05-08:39:20  VTD_EXEC_138 file: Download complete.
2012/09/05-08:39:31 VTD_EXEC_140 file: Download complete.
2012/09/05-08:40:03  VTD_EXEC_142 file: Download complete.|
2012/09/05-08:40:03  Sending and unpacking files in 172.31.1.80
2012/09/05-08:40:18  Sending and unpacking files in 172.31.1.260
2012/09/05-08:46:56  Auto VTD_EXECS download: Execution started.
2012/09/05-08:47:15  VTD_EXEC_103 file: Download complete.
2012/09/05-08:47:25  VTD EXEC 109 file: Download complete.
2012/09/05-08:49:38  VTD_EXEC_142 file: Download complete.

c3

al140r588

Figure 3-117. Fix Acquisition Report

Mount/Unmount USB or CD-ROM

Note: This task mounts and unmounts a USB or CD-ROM drive.

1.

w

Ensure the desired USB drive is connected to the TSSC, or a usable disk is inserted in the CD-ROM
drive.

Right click on the desktop and go to System Console Actions.
Under System Console Actions go to Mount Functions.

If a USB device has been connected and needs to be mounted, select Mount USB. If a disk was
inserted and needs to be accessed, select Mount CD-ROM. Select Unmount USB or Unmount
CD-ROM if the USB or CD-ROM device is no longer in use.

Mount/Unmount USB or CD-ROM Remotely

Note: A user can mount and unmount USB devices and CD-ROMs remotely through the command line.

1.

2.
3.
4

To mount a USB device remotely type rsMount.sh usb and press Enter.

To unmount a USB device remotely type sudo rsUnmount.sh usb and press Enter.
To mount a CD-ROM remotely type rsMount.sh cd and press Enter.

To unmount a CD-ROM remotely type sudo rsUnmount.sh cd and press Enter.
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Chapter 4. Repair/Troubleshooting

System Console Repair

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

In most cases, the standard procedures for PC repair apply for the System Console. The Product
Recovery CD-ROM contains the file XXXXSVC.PDF (the XXXX represents the PC Type, that is, 6579,
6792, 8480, or 8482) which is the Hardware Maintenance Information for the IBM PC.

This System Console MI details repair and replacement procedures for the System Console, and does not
address PC repair.

There are two procedures which will require additional attention:

« Hard Disk Drive Replacement: When replacing the hard disk drive, replace it with at least a (30GB)
drive. After replacing the hard disk drive, follow the procedure outlined in 'Code Load/Hard Drive]
|Rebui|d” on page 3-60|to install the System Console for Service software (Model 8482 requires (80GB)
serial ATA HDD; see [‘Parts List” on page 4-2[).

* Planar Replacement: When replacing the system planar, transfer the microprocessor and memory
modules from the removed system planar to the new system planar [at least 268MB (256MiB) of RAM

is required]. It also is important to reset the BIOS settings for Console Date/Time and Drive Selection
Startup Sequence, as outlined in|Table 4-1

It may be necessary to download the BIOS for a new planar upon installation. For downloadable files for
your machine type and model, see

http://www.ibm.com/support/us

Troubleshooting the TS3000 System Console

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
[Chapter 1, “Maintenance Starting Point,” on page 1-1|to determine the code level.

Table 4-1. Troubleshooting

You are here for this reason Perform this action
User interface "Lock Up" (mouse/menu items Simultaneously press the Alt, Ctrl, and Backspace keys to
inoperative) end the session and return to the login screen.

cannot be detected, and call home does not function |the firmware settings for external modems. See [‘Configurin
[Call Home Settings Electronic Customer Care” on page 2-71
for instructions.

External modems connected and powered ON but Use the reset modem function in call home settings to reset

Simultaneously pressing the Alt + Ctrl + Backspace | (Only to be done as a last resort; can result in loss of data)
keys does not properly end session Disconnect the power cord, wait 10 seconds, reconnect the
power cord, and power ON the System Console.

Review hardware maintenance manual for IBM PC Insert the Product Recovery CD-ROM into a computer with
Adobe Acrobat Reader (version 4.0 or later). Open the file on
the CD-ROM entitled XXXXSVC.PDF (the XXXX represents
the PC Type, such as 6579, 6792, 8480, or 8482).

Attention: Do not attempt to install the Product Recovery
CD-ROM into any machine other than a System Console. You
will cause permanent and unrecoverable damage to that other
machine.
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Table 4-1. Troubleshooting (continued)

You are here for this reason Perform this action

Perform procedure to set console date and time.
(See also [‘'Setting Console Date and Time” on page|
2-85)

—_

Power OFF the System Console for at least 10 seconds.

2. During power-up initialization, press F1 to enter the BIOS
Configuration/Setup Utility. Power ON the System
Console.

3. Use the Up/Down keyboard arrow keys to navigate to
Date/Time, then press Enter.

4. Enter the correct time of day HH:MM:SS (HH is 00 to 24;
use the arrow keys to navigate).

5. Enter the correct date MM:DD:YYYY.
6. Press ESC when finished.

7. Use the down arrow to select Save Settings. Press Enter
to continue.

8. Use the down arrow to select Exit Setup. Select Yes to
exit the Setup Utility.

Normal reboot should now occur.

Perform procedure to reset the proper drive selection | 1. pyring power-up initialization, press F1 to enter the BIOS

startup sequence. In the event of a planar Configuration/Setup Utility. Power ON the System
replacement, it will be necessary to reset the boot-up Console.

sequence to Floppy Drive -> CD-ROM -> Hard Disk
Drive in order for the System Console to boot the
CD-ROM, if present.

2. Use the Up/Down keyboard arrow keys to navigate to
Start Options, then press Enter.

3. Press Enter again to set the Startup Sequence.

4. Use the arrow keys to navigate and to set the following:
» [Diskette Drive 0]
+ [CD-ROM]
* [Hard Disk 0]
» [Disabled] Automatic Power On Startup Sequence

5. Press the Esc key twice when finished.

6. Use the Down arrow key to select Save Settings. Press
Enter to continue.

7. Use the Down arrow key to select to Exit Setup. Select
Yes to exit the Setup Utility.

Normal reboot should now occur.

Parts List

This topic provides information for locating the parts list.

For part numbers that are related specifically to the PC, insert the IBM TS3000 System Console
Documentation CD-ROM in a Windows PC or notebook with Adobe Acrobat Reader (version 4.0 or later).
From the CD-ROM, open the file entitled IBM xSeries XXXX.PDF (the XXXX represents the PC Type; that
is, 6579, 6792, 8480, 8482, 8836, or 8849). Also open 'TSSC_Parts_Master_List.PDF' which lists specific
field replacable units (FRUs) for each model type.
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Notices

References in this publication to IBM programs or services do not imply that IBM intends to make these
available in all countries in which IBM operates. Any reference to an IBM product, program, or service is
not intended to state or imply that only IBM's product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any of IBM's intellectual property rights may
be used instead of the IBM product, program, or service. Evaluation and verification of operation in
conjunction with other products, except those expressly designed by IBM, is the user's responsibility.

This publication could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the products and/or programs described in this publication at
any time.

This document contains general information, as well as requirements, for use on IBM and third-party
products. IBM makes no warranty, express or implied, as to its completeness or accuracy, and the data
contained herein is current only as of the date of publication. It assumes that the user understands the
relationship among any affected systems, machines, programs, and media.

IBM or third parties may have patents or pending patent applications covering subject matter described in
this document, including appearance design patents or applications. The furnishing of this document does
not constitute or imply a grant of any license under any patents, patent applications, trademarks, copyright,
or other rights of IBM or of any third party, or any right to refer to IBM in any advertising or other
promotional or marketing activities. IBM assumes no responsibility for any infringement of patents or other
rights that may result from use of this document or from the manufacture, use, lease, or sale of apparatus
described herein.

Licenses under IBM's utility patents are available on reasonable and non-discriminatory terms and
conditions. IBM does not grant licenses under its appearance design patents. You can send license
inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood
NY 10594, U.S.A.

For on-line versions of this book, we authorize you to:

« Copy, modify, and print the documentation contained on the media, for use within your enterprise,
provided you reproduce the copyright notice, all warning statements, and other required statements on
each copy or partial copy.

» Transfer the original unaltered copy of the documentation when you transfer the related IBM product
(which may be either machines you own, or programs, if the program's license terms permit a transfer).
You must, at the same time, destroy all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes, resulting from this
authorization.

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply
to you.

Your failure to comply with the terms above terminates this authorization. Upon termination, you must
destroy your machine readable documentation.
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Trademarks

The following terms are trademarks of the IBM Corporation in the United States of America, other
countries, or both:

9076 SP2 AIX® AIX 6000

Application System/400°® AS/400° Enterprise System/9000
ES/9000 ESCON® IBM

IntelliStation Netfinity(R) 1000 and 3000 NetVista

PC 300 and PC 700 POWERparallel RETAIN

RS/6000° Scalable POWERparallel Systems®  SP2

System/390° System Storage TotalStorage
TotalStorage Master Console TS3000 Virtual Tape Controller
Virtual Tape Server xSeries

The following terms are trademarks of other companies:

Eclipse is a service mark of the Eclipse Foundation

Windows™ is a trademark of Microsoft, Inc.

PC Doctor™ is a trademark of PC Doctor, Inc.

UNIX is a registered trademark, licensed exclusively through X/Open Company Limited.
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Compliance Statements

Federal Communications Commission (FCC) Class A Statement

This equipment has been tested and complies with the limits for a Class A digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference, in which case the user will be required to
correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Class A Emission Compliance Statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité a la réglementation d'Industrie Canada
Cet appareil numérique de la classe A est conform a la norme NMB-003 du Canada.

Taiwan Class A Electronic Emission Statement
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Taiwan Contact Information

IBM Taiwan Product Service Contact Info:
IBM Taiwan Corporation

3F, No 7, Song Ren Rd., Taipei Taiwan
Tel: 0800-016-888

T EIBM ZE i il s s 5 =
OB R R A R R IR ]
B AL AT % 7573

FEqG - 0800-016-888

f2c00790

Notices A-3



Japan VCCI Council Class A Statement

CDEE}. /5 A BBRRINEETY, CORKEZRERE THERATS
CEBRITEZFIERCTEDHYET . COBEICIERAENBEARXNE
ZBITDLIOIEREINDEDHYET, VCCI-A

Translation: This is a Class A product based on the standard of the VCCI Council. If this equipment is
used in a domestic environment, radio interference may occur, in which case, the user may be required to
take corrective actions.

European Union EMC Directive Conformance Statement

This product is in conformity with the protection requirements of EU Council Directive 2004/108/EC on the
approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM option cards.

Attention: This is an EN55022 Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

Responsible manufacturer:
International Business Machines Corp.
New Orchard Road

Armonk, New York 10504

Tel: 919-499-1900

European community contact:

IBM Technical Regulations, Department M456
IBM-Allee 1, 71137 Ehningen, Germany

Tel: +49 7032 15-2937

E-mail: iahn@de.ibm.com
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Glossary

This glossary defines the special terms,
abbreviations, and acronyms that are used in this
publication. If you do not find the term you are
looking for, see the fIndex” on page X-1,or refer
to the IBM Glossary of Computing Terms, which is
located at the website:

www. ibm.com/ibm/termnology

ltalicized text indicates terms found elsewhere in
this glossary.

A

AIX. (1) Advanced Interactive Executive. (2) IBM's
implementation of the UNIX operating system. The
RS/6000 system, among others, runs the AIX operating
system

AOTM. autonomic ownership takeover manager
ATL. Automated Tape Library

attention (notice). A word for calling attention to the
possibility of danger to a program, device, or system, or
to data. Contrast with caution and danger

B

baud. (1) A unit of signaling speed equal to the
number of discrete conditions or signal events per
second. (2) In asynchronous transmission, the unit of
modulation rate corresponding to one unit interval per
second; that is, if the duration of that unit interval is 20
milliseconds, the modulation rate is 50 baud. Also see
baud rate.

baud rate. (1) In remote communications, the

transmission rate that is synonymous with signal events.

The baud rate, or signal change rate, is usually
expressed in bits per second. Stated another way, the
baud rate is a measure of how many times per second
a signal changes or could change. (2) The default rate
of the IBM 3592 drive is 9600 baud. Also see baud.

BIOS. basic input/output system

C

caution (notice). A word to call attention to possible
personal harm to people. Contrast with attention and
compact disk-read only memory

CD-ROM. compact disk-read only memory

CE. (1) IBM customer engineer (2) Synonym for
service representative

© Copyright IBM Corp. 2002, 2012

code. A shortened term for microcode, which is used
throughout this M/

command. A control signal that initiates an action or
the start of a sequence of actions

controller. Deprecated term for control unit

control unit. (1) A device that provides the interface
between a system and one or more tape drives. (2)
Synonym forcontroller

CU. control unit

customer engineer (CE). Synonym for IBM service
representative

D

danger (notice). A word to call attention to possible
lethal harm to people. Contrast with attention and
caution

data. Any representations such as characters or
analog quantities to which meaning is or might be
assigned

deprecated. Not favored or not fully approved

E

EBTERM. Terminal emulator for OS/2
ELC. Enterprise Library Controller
EMT. electronic master transfer

error log. A dataset or file in a product or system
where error information is stored for later access

ESCON. Enterprise Systems Connection

F

FCC. Federal Communications Commission

FE. (1) field engineer (2) Though the term is not used
in this MI, it may be used in other documentation as a
synonym for customer engineer. (3) Synonymous with
service representative

Federal Information Processing Standards. See
FIPS

field replaceable unit (FRU). An assembly that is

replaced in its entirety when any one of its components
fails

B-1



FIPS. (1) Federal Information Processing Standards
(2) Standards and guidelines developed and issued by
the National Institute of Standards and Technology
(NIST) and approved for Federal computer systems by
the Secretary of Commerce. When no acceptable
industry standards or solutions exist, NIST develops
FIPS to satisfy compelling Federal government
requirements, such as for interoperability and for
security measures like encryption. The pertinent
standard for this publication is FIPS PUB 140-2,
Security Requirements for Cryptographic Modules

format. The arrangement or layout of data on a data
medium

FP. file protect

FRU. field replaceable unit

G

GUI. graphical user interface

IBM. International Business Machines Corporation

identifier (ID). (1) In programming languages, a lexical
unit that names a language object. For example, the
names of variables, arrays, records, labels, or
procedures. An identifier usually consists of a letter
optionally followed by letters, digits, or other characters
(2) One or more characters used to identify or name a
data element and possibly to indicate certain properties
of that data element (3) A sequence of bits or
characters that identifies a program, device, or system
to another program, device, or system

intervention required. Manual action is needed
1/0. input/output
IOP. input/output processor

IPL. initial program load

L

LAN. (1) local area network (2) In a comparison of
geographic breadth, a LAN is a computer network that
is smaller than a MAN or a WAN

LED. light-emitting diode

LM. library manager

M

MAN. (1) metropolitan area network (2) Data network
designed for a town or a city. In a comparison of

geographic breadth, a MAN is a computer network that
is larger than a LAN but smaller than a WAN

MB. (1) megabyte (2) one million bytes
MI. Maintenance Information

microcode. (1) One or more micro-instructions (also
called ‘microprogram’). Resides in a part of storage that
is not program-addressable (2) Also called code in this
Mi

MRPD. machine reportable product data

N

N/A. not applicable

NVS. (1) nonvolatile storage (2) A storage device
whose contents are not lost when power is cut off

O

offline. Pertaining to the operation of a functional unit
without the continual control of a computer, a server, or
other peripheral device. Contrast with online

online. Pertaining to the operation of a functional unit
that is under the continual control of a computer, a
server, or other peripheral device. Contrast with offline

P

PE. Product Engineering
PMH. problem management hardware

PMR. (1) problem management record (2) A PMR
number is assigned by RETAIN. This number is
returned to the system console when a problem is
successfully opened in RETAIN. In conjunction with a
Branch Office number, this uniquely identifies a problem
event for tracking through the RETAIN process

PMS. problem management software

R

RAM. random access memory

RAS. (1) reliability, availability, and serviceability (2)
Abbreviated term for product design characteristics, and
the Development team that manages those
characteristics

RETAIN. (1) IBM Remote Technical Assistance
Information Network (2) IBM Employees use this online
system to help resolve customer problems with IBM
products. The system contains records about reported
problems and the solutions (or fixes) that are developed
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for those problems. RETAIN also holds records of the
hardware and software owned by each IBM customer.

RMSS. Removable Media Storage Solutions sector of
IBM

S

SBC. system controller board
SCSI. small computer system interface

service representative. (1) Person who services your
equipment. (2) Synonymous with CE and customer
engineer

SIM. service information message

small computer system interface (SCSI). An input
and output bus that provides a standard interface
between the host system and the drive

SNMP. simple network management protocol

subsystem. A secondary or subordinate system,
usually capable of operating independently of, or
asynchronously with, a controlling system

System i. Term for IBM AS/400 products formerly
known as iSeries

System p. Term for IBM AlX-type products formerly
known as pSeries

System x. Term for IBM personal
computer/server-type products formerly known as
xSeries

System z. Term for IBM S/390-type processor
products formerly known as zSeries

T

TCP/IP. Transmission Control Protocol/Internet
Protocol. When in a tape library, the LAN
communication path between the host and the Library
Manager. This communication path is used for tape
library commands that do not require the tape drive,
while the SCSI bus is used for commands, data, and
responses that require the tape drive. All SCSI-attached
processors require an RS-232 or a LAN attachment for
library control

TSMC. (1) TotalStorage Master Console (2) Original
name of the TS3000 System Console (TSSC)

TSSC. TS3000 System Console

U

utility. utility program

utility program. A computer program in general
support of the processes of a computer. For instance, a
diagnostic program

\'

VPD. (1) Vital Product Data. (2) The information
contained within the tape drive that requires nonvolatile
storage used by functional areas of the drive, and
information required for Manufacturing, RAS, and
Engineering

VTC. Virtual Tape Controller

VTS. Virtual Tape Server

w

WAN. (1) wide area network (2) In a comparison of
geographic breadth, a WAN is a computer network that
is larger than a LAN or a MAN

WEEE. European Union's Waste Electrical and
Electronic Equipment standards directive

Glossary B-3
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Index

Special characters

(Automated Log Collector), Starting and Stopping 3-32
(ECC) Connectivity, Test Electronic Customer 2-88
(TSR), Tape System Reporter 3-85

Numerics
3494
ATL
remote data monitoring 2-96
set up (LM) 2-26
test call home notification 2-91
web specialist 2-30
publications  xvii
3584 publications  xvii
3953
ATL remote data monitoring 2-96
feature code 2-5
frame serial number
modem 2-8
publications  xvii
setup 2-26
specialist settings 2-29
3956 CC6
creating PE package (also refer to the TS7700
Information Center) 3-48
feature code 2-1
3958
enabling SNMP trap forwarding 3-85

2-28

A

abbreviations B-1
about this document
sending comments  Y-1
access
for customer or CE to specialist 3-62
management interfaces 3-73
remote using NetTerm 3-19
tape drive code for update 3-62
via specialist to
system console 3-62
tape drive code update 3-62
acronyms B-1
add
attached system information 2-39
PFE exec from web interface 3-80
users to customer group 3-65
Adding a 3584 Model SC1 Complex System 2-43
Adding a Complex System 2-41
administer users  3-65
ALC (Automated Log Collector), Starting and
Stopping 3-32
AOTM
settingup 2-16
testing 2-19

© Copyright IBM Corp. 2002, 2012

ATL web specialist (3494)
tape system setup 2-26
using to change system console settings 2-30
authenticate server userid 2-37
autonomic ownership takeover manager
settingup 2-16
testing 2-19

B

backing up configuration data 2-80
baud rate, set for system console from
remote connection 2-80
system console 2-78
BIOS
definition B-1
enter 4-1
reload corrupted 3-60
broadcast
drive code from web interface 3-16
remote code from
web interface 3-8
Broadcast from the Web Interface, Mksysb 3-82

C

call home
configuring 2-71
notification test for
3494 ATL or 3953 Enterprise 2-91
VTS, VTC, A60, J70, and C06 2-90
offload contents to database (for remote
users) 3-46
queue management
record types 3-24
setting up 2-71
test notification for
3494 ATL or 3953 Enterprise 2-91
VTS, VTC, A60, and J70 2-90
TS7700 setup 2-13
VTS setup 2-21
Call Home Event Log 3-29
catalog, parts 4-2
CD-ROM
drive rebuild 3-60
feature code for drive rebuild 2-5
offloading user files to  3-26, 3-30
product recovery 3-60
CD-ROM, Mount/Unmount USB 3-89
CD-ROM, Mount/Unmount USB Remotely 3-89
change
configuration 2-36
language 3-62
password 3-65
system console settings 2-30

3-23
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code
broadcast
from web interface 3-16
remote from web interface 3-8
load 3-60
rebuild 3-60
update console 3-59
update drive 3-62
code level V3.0.0 and above
access for tape drive code update 3-62
adding attached system information 2-39
backing up configuration data 2-80
call home queue management 3-23
call home record types 3-24
code load/hard drive rebuild 3-60
configuration 2-36
configure call home settings 2-71
console configuration sheet
sample 2-9
usable 2-9
console date and time, setting 2-85
console settings 2-60
console status 3-54
electronic customer care 2-71
error or defer matrix updates 3-66
feature codes 2-2
installing system console
about 2-1
performing 2-7
introduction 2-1
maintenance starting point quick reference table
offload
user files 3-30
user files to call home database (for remote
users) 3-46
procedures 3-1
restoring configuration data 2-83
service tools 3-1
set up for 3494 ATL (LM) 2-26

set up for 3953 Enterprise Library Controller 2-26

set up VTS, VTC, tape controllers 2-21
setting console date and time 2-85
setup for remote data monitoring 2-92
system overview 2-1
tape system service information 3-4
telnet to attached tape system 3-1
user login  2-36

code level V3.1.0

control unit tape drive service information files 3-13

view all files 3-16
code level V5.3.0 and above

remote code broadcast from web interface 3-8

schedule configuration backups 2-82
code load status

from web interface 3-11
code load/hard drive rebuild 3-60
comments

sending Y-1
comments about this MI i
communication statements A-3
compliance statements A-3

components, system console 2-2
configuration

adding attached system information 2-39

backing up configuration data 2-80

call home settings 2-71

console date and time 2-85

data, backing up 2-80

electronic customer care 2-71

interface parameters 2-33

login options
authenticated 2-37
non-authenticated 2-37

prerequisites 2-36

restoring configuration data 2-83

router 2-25

schedule backups (code level V5.3.0 and

above) 2-82

setting baud rate for system console serial port
from remote connection 2-80
from system console 2-78

settings 2-31

sheet
sample 2-9
usable 2-9

test call home notification 2-90
test call home notification for 3494 ATL 2-91
user login  2-36
web specialist settings 2-31
configuring
Assist-on Site Session 3-41
Configuring Assist On-Site (AOS) 3-41
connect
to modem 3-21
to RETAIN 2-87
console
code update 3-59
configuration sheet
sample 2-9
usable 2-9
logout 2-90
microcode update 3-59
PE package, creating 3-48
setting date and time 2-85
settings 2-60
specialist (system) 3-62
status 3-54
VPD, display 3-56
Console Screenshots, how to take 3-57
create
attached subsystems list 3-6
MI user feedback iii
SSH tunnel 3-79
system console user feedback 3-80
custom firewall settings 2-69
customer
access for tape drive code update 3-62
access to system console specialist 3-62
group, add users to or delete users from 3-65
publications and information
3494 xvii
3584  xvii
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customer (continued)
publications and information (continued)
3953  xvii
7133 xviii
AIX (RS/6000) xviii
device drivers  xviii
userid 3-62

D

date and time, setting console 2-85
defer or error matrix updates 3-66
definitions B-1
delete
infocenter (CD-ROM) 3-77
delete users from the customer group 3-65
device drivers publications  xviii
disable 3958 SNMP trap forwarding 3-85
disk rebuild 3-61
disk rebuild and configuration restore 3-61
diskette
backing up configuration data to 2-80
offloading user files to  3-26, 3-30
display
console VPD 3-56
tape drive service information 3-12
tape system service information 3-4
DO NOT USE - USB port on keyboard 1-1
documentation
improvement  Y-1
drive
code broadcast from web interface 3-16
feature code for rebuilding from CD-ROM 2-5
rebuild from CD-ROM  3-60
service information
tape drive 3-12
tape system 3-4
DS4000
recording the IP and RSA forwarding
addresses 2-80
DS6000
creating PE package (also refer to the TS7700
Information Center) 3-48
GUI
installing 2-52
launching 3-68
resetting password 3-68

E

ECC (electronic customer care) 2-71
edition

changes

this 29th edition iii

notice i
electronic customer care (ECC) 2-71
Electronic Customer Care (ECC) Connectivity,

Test 2-88

enable

3958 SNMP trap forwarding 3-85

console heartbeat 2-73

error or defer matrix updates 3-66

F

Failed Queue Management 3-26
feature codes 2-2

feature codes withdrawn 2-4
feedback sending, user 3-80
feedback to IBM i

FIPS
definition B-2
website  xviii

firewall settings, customize 2-69
Fix Acquisition 3-86
Fix Acquisition Report 3-88
Fix Acquisitions General Settings 3-88
floppy diskette
backing up configuration data to 2-80
offloading user files to  3-26, 3-30
forwarding, enabling 3958 SNMP trap 3-85

G

glossary B-1
GUI
DS6000
installing 2-52
launching 3-68
resetting password 3-68
ProtecTIER Manager
installing 2-56
launching 3-73
upgrading 2-58
Storage Manager
installing 2-53
launching 3-71
resetting password  3-71

H

hard drive rebuild 3-60
heartbeat, set 2-33
help
system console specialist online 3-62
helpful URLs  xviii

importing
InfoCenter
from CD-ROM 3-76
infocenter
delete 3-77
importing
from CD-ROM 3-76
launching (CD-ROM) 3-76
install
DS6000 GUI 2-52
prerequisites to  2-7
ProtecTIER Manager GUI 2-56

Index
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install (continued)
Storage Manager GUI 2-53
system console
about 2-1
performing 2-7
interface
access management 3-73
test 2-31
Interface, Mksysb Broadcast from the Web  3-82
introduction 2-1
IP address
HTTP proxy 2-71
HTTP proxy IP address 2-71
IP address, setting 2-33

K

keyboard USB port - DO NOT USE  1-1

L

language
for online help 3-62
select system console specialist 3-62
launch
DS6000 GUI 3-68
InfoCenter
from web interface 3-74
infocenter (CD-ROM) 3-76
ProtecTIER Manager GUI 3-73
specialists  3-65
Storage Manager GUI  3-71
list
create attached subsystems 3-6
parts 4-2
login options
authenticated 2-37
non-authenticated 2-37
logout 2-90
logs, retrieving subsystem 3-49

M

management interfaces, access 3-73
managing
InfoCenter
from web interface 3-74
master menu (system console screen) 2-39
matrix updates, error or defer 3-66
media, offloading user files (for non-remote users)
to 3-26, 3-30
menu tree  1-2
microcode
broadcast
remote from web interface 3-8
load 3-60
update
console 3-59
drive (via Specialist) 3-62
TS7700 cache controller 3-77
Mksysb Broadcast from the Web Interface 3-82

modem
connecting to  3-21
reset 3-78
modem reset 3-78
Mount/Unmount USB or CD-ROM 3-89
Mount/Unmount USB or CD-ROM Remotely 3-89

N

NetTerm
configure for accessing modem 3-19
remote access using 3-19
notice
edition i
general A-1

o)

offload
PE package 3-48
user files
to call home database (for remote users) 3-46
to media (for non-remote users) 3-26, 3-30
online help
system console specialist 3-62
open SSH tunnel 3-79
overview of product 2-1

P

parameters, configure interface 2-33

parts list 4-2
password
change 3-65

resetting DS6000 GUI  3-68

resetting Storage Manager GUI  3-71
PE package, creating console (also refer to the TS7700

Information Center) 3-48

PFE exec from web interface, add 3-80
port on keyboard (USB) - DO NOT USE  1-1
preface xvii
problem report to RETAIN, send 2-71
procedures 3-1
product

overview 2-1

recovery 3-60
ProtecTIER Manager GUI

installing 2-56

launching 3-73

upgrading 2-58
publications

3494 xvii

3584  xvii

3953  xvii

7133 xviii

AIX  xviii

device drivers  xviii

RS/6000  xviii
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Q

queue
flush 2-32
management (call home) 3-23

quick reference table, maintenance starting point

R

RAS menu
local access 3-57
remote access 3-57
RAS Menu 3-56
read this first iii
reader feedback
sending Y-1
rebuild disk 3-61
rebuild hard drive 3-60
related information and publications  xvii
remote
access using NetTerm 3-19
code broadcast
from web interface 3-8
code broadcast from
web interface 3-8
data monitoring (3494 ATL)
support  2-1
remote data monitoring
set up for 3494 ATL or 3953 ELC 2-96
set up for VTS, VTC, A60, J70 2-92
repair of system console 4-1
report to RETAIN, send problem 2-71
reset
DS6000 GUI password 3-68
modem 3-78
Storage Manager GUI password 3-71
restoring configuration data 2-83
RETAIN
about 2-1
information sent to 2-71
send problem report to  2-71
test connection
during installation 2-87
during service 3-55
retrieving subsystem logs 3-49
router 2-25
RSA forwarding addresses 2-80

2-96

S

scheduling configuration backups 2-82
secure shell tunnel, 3-79
sending
comments Y-1
sending user feedback about
the system console 3-80
this M1 i
serial port
connecting to
x306 2-2
x306m 2-2

serial port (continued)
initializing for connection to local devices 2-78
setting baud rate
from remote connection 2-80
from system console 2-78
service
information
tape drive 3-12
tape system 3-4
marks A-2
publications
3494  xvii
3584  xvii
3953  xvii
7133 xviii
AIX  xviii
device drivers  xviii
RS/6000  xviii
tools 3-1
service information
tape drive 3-12
tape system 3-4
set up
3494 ATL LM 2-26
3953 ELC 2-26
autonomic ownership takeover manager
(AOTM) 2-16
remote data monitoring
3494 ATL or 3953 ELC 2-96
VTS, VTC, A60, J70 2-92
TS7700 virtual engine 2-13
VTS, VTC, tape controllers
call home 2-21
for remote data monitoring 2-92
setting
3958 SNMP trap forwarding 3-85
autonomic ownership takeover manager
(AOTM) 2-16
baud rate for system console from
remote connection 2-80
system console 2-78
call home configuration 2-71
configuration 2-31
configure web specialist
console 2-60
console date and time 2-85

1-1

2-31

customize firewall 2-69

ECC (electronic customer care) 2-71
electronic customer care (ECC) 2-71
heartbeat 2-33

IP address 2-33

modem 3-78

signal speed for system console from
remote connection 2-80
system console 2-78

SSH tunneling 3-79

user feedback 3-80

web specialist 2-30

settings, configuring
call home 2-71
console heartbeat 2-73

Index
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settings, configuring (continued)
disposition 2-76
entry point 2-31
machine 2-75
phone 2-74
site location 2-73
sheet, configuration
sample 2-9
usable 2-9
signal speed - setting from
remote connection 2-80
system console 2-78
specialist
about 3-62
access to
system console 3-62
tape drive code 3-62
administer users 3-65
configure interface parameters 2-33
configure settings 2-31
flush queue 2-32
launch 3-65
online help  3-62
set heartbeat 2-33
system console 3-62
update tape drive code 3-62
using to
change language 3-62

change or configure system console settings

(web) 2-30
using web  2-30
welcome page 2-30
SSH tunneling 3-79
Starting and Stopping ALC (Automated Log
Collector) 3-32
statements
communication A-3
compliance A-3
status, console 3-54
Stopping ALC (Automated Log Collector) 3-32
Storage Manager
GUI
installing 2-53
launching 3-71
resetting password 3-71
subsystem
list, create attached 3-6
logs, retrieving 3-49
system console
main menu 2-39
overview 2-1
repair 4-1
specialist
about 3-62
access to tape drive code 3-62
administer users 3-65
changing language using 3-62
launch 3-65
using for customer access 3-62
System Reporter (TSR), Tape 3-85

T

tables
call home record types 3-24
code load status
from web interface 3-11
console configuration sheet
actual 2-9
sample 2-9
console status tool function 3-54
control unit error codes 3-63
installation prerequisites 2-7
maintenance starting point  1-1
parts list 4-2
quick reference for maintenance starting point
single drive error codes 3-64
system console components  2-2
troubleshooting 4-1
Taking Console Screenshots 3-57
tape drive
service information 3-12
tape system
call home 2-21
service information 3-4
Tape System Reporter (TSR) 3-85
telephone information for modems 2-36
telnet to attached tape system 3-1
telnet to Grid TSSC 3-2

terms B-1

test
autonomic ownership takeover manager
(AOTM) 2-19

call home notification for
3494 ATL 2-91
VTS, VTC, A60, J70, and C06 2-90
connection to RETAIN
during installation 2-87
during service 3-55
interface  2-31
RETAIN connection
during installation 2-87
during service 3-55
Test Electronic Customer Care (ECC)
Connectivity 2-88
time and date, setting console 2-85
tools, service 3-1
trademarks A-2
transmission rate, setting from
remote connection 2-80
system console 2-78
transmission speed - setting from
remote connection 2-80
system console 2-78
trap forwarding, enabling 3958 SNMP  3-85
tree, menu 1-2
troubleshooting  4-1
TS7700

1-1

autonomic ownership takeover manager (AOTM)

setup 2-16
test 2-19
call home 2-13
virtual engine set up 2-13
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tunneling, SSH 3-79

U

update

console code 3-59

error or defer matrix 3-66

ProtecTIER Manager GUI 2-58

tape drive code via specialist 3-62

TS7700 cache controller microcode 3-77
URLs for information and help  xviii
USB device

add PFE execs 3-80

backing up configuration data by using 2-80

DO NOT plug into port on keyboard 1-1

offloading user files by using 3-26, 3-30
USB or CD-ROM, Mount/Unmount 3-89
USB port on keyboard - DO NOT USE  1-1
user feedback about

system console 3-80
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